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Preface
TheGeoExpress User Manual is written for geographic information system (GIS) professionals that want to
compress andmanipulate geospatial data with GeoExpress. This guide assumes that you have basic knowledge
of GIS, includingmosaics, coordinate reference systems, multispectral imagery, and LiDAR point clouds.

This guide describes how to install and operate the graphical version of GeoExpress. To install GeoExpress on
Linux, youmust install the command line version of GeoExpress. For installation instructions and other
information about the command line version of GeoExpress, see the GeoExpress Command Line User
Manual.
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Chapter 1: Before You Begin
GeoExpress overview
GeoExpress is a software solution for compressing andmanipulating geospatial data. GeoExpress supports a
broad range of file formats, including the industry standardMrSID format and the ISO standard JPEG 2000 format.

Some of the tasks that you can perform with GeoExpress include:
l Compress raster and LiDAR data;
l Create seamless mosaics;
l Specify separate compression ratios for individual bands in amultispectral image;
l Reproject raster images to another coordinate reference system;
l Perform color balancing;
l Crop and demosaick raster images;
l Despeckle raster images;
l Edit imagemetadata.

You can save images that you create with GeoExpress to your computer or a LizardTech Express Server. Then,
view the images in the geographic information system (GIS) software of your choice, including Esri®, Bentley®,
Autodesk®, andmore.

What’s new
NOTE: To see a list of fixes and other information for the current version of GeoExpress, see the GeoExpress
Read Me.pdf file included in the installation.

Version 10.0
New features
GeoExpress 10 has a greatly improved user interface that can help streamline your workflow. Among the
improvements are:

l Reworked Job Properties panel: The new organization reinforces workflow from the top down, showing
the same types of information about each job and allowing you to easily identify, review, and edit
modifications made to each job.

l Reduced number of dialogs
l Improved mosaic creation
l New crop options
l Simplified reprojection: Improved CRS selection and editing, new CRS source, simplifiedWKT viewing
and editing, and improved error checking

l Jobs: You can now pause or cancel jobs individually or enmasse, and canmanually re-order running jobs.

GeoExpress 10 also includes these new and enhanced capabilities:

l You can now crop and reproject LiDAR point clouds
l You can now createmosaics frommultiple sources, including:

n Create anMG2mosaic fromMrSID sources
n Create a TIFF mosaic
n Create amultiresolutionMG2mosaic

l Encoding NITF imagery no longer requires a separate license. Note that encoding NITF imagery will incur a
charge against the data cartridge.

l The Crop window always displays an image preview. You can cancel the preview if it is taking too long to
render, at which point you can enter crop coordinates manually.
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Version 9.5.x
New feature highlights

l Enhanced multi-core support: GeoExpress no longer limits the number of concurrent jobs and threads to
eight.

l LiDAR Compression: GeoExpress supports compressing LiDAR point clouds in plain-text or LAS or LAZ
formats.

l Multipolygon Shapefile Cropping: Define the area that you want to crop with a shapefile that can contain
multiple polygons.

l Command line tools: We improved themethod used to createMrSID mosaics from the command line.
l BPF support: GeoExpress supports input and output of Binary Point Files often used in Geiger Mode
LiDAR imagery.

l NAD83 2011 support: GeoExpress now supports EPSGCoordinate Reference Systems and Coordinate
Transformations related to NOAA’s National Adjustment of 2011.

l PIX support: GeoExpress supports PCIDSK (PIX) files as input files.
l Improved transparency conversion: GeoExpress uses the nodata value of the input image as the
transparency for the alpha band when converting toMG4 format.

l Color balancing improvements
l Simplified licensing

Version 9.0 and 9.1
New feature highlights

l Floating Point Support for MrSID Generation 4: GeoExpress uses quantization to create 32-bit floating
point images in theMrSID Generation 4 format.

l Dynamic Range Metadata Generation: UseGeoExpress to write dynamic rangemetadata for images.
l Improved Metadata for Auxiliary Files
l Command Line Image Statistics
l Simple Job List: Any images that you add to the GeoExpress graphical user interface appear in a single
simplified job list.

l Intelligent Encoding: GeoExpress automatically performs a subset of image compression and
manipulation operations without re-encoding images.

l Image Rotation: For images that include rotationmetadata, GeoExpress creates rotated output images.
l CustomWatermarks: GeoExpress supports watermark images in BMP, PNG, and JPEG formats.
l Mosaic Enhancements for the Command Line: Createmosaics usingmultiple coordinate reference
systems from the command line.

l PNG Support
l NITF RPC Support: GeoExpress can now interpret NITF files with RPC metadata.
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System requirements
Before you install GeoExpress, verify that your systemmeets theminimum system requirements.

Hardware requirements
For optimal performance, verify that your systemmeets the following recommended hardware requirements:

l 2.5GHz quad core processor
l 4GB RAM
l 300MB of disk space for installation (additional space required for images)

However, it is still possible to run GeoExpress on systems with the followingminimum hardware requirements:
l 1.5GHz processor
l 1GB RAM
l 300MB of disk space for installation, and additional space for images

Operating system requirements
IMPORTANT: GeoExpress 10 is a 64-bit application and requires a 64-bit operating system.

Windows
l Windows 10
l Windows 8
l Windows 7
l Windows Server 2016
l Windows Server 2012 R2Update
l Windows Server 2012
l Windows Server 2008 R2 SP1

Linux

NOTE: On Linux, GeoExpress runs as a command line-only program.

l RedHat Enterprise Linux 7.0
l RedHat Enterprise Linux 6.1
l CentOS 7

Software requirements
OnWindows, GeoExpress requires the following software to run:

l Microsoft .NET Framework 4.6.1
l Visual Studio C++ 2017 Redistributable
l SlimDX Runtime .NET 4.0 (used to display LiDAR point clouds in 3D)

If this software is not already on your computer, the GeoExpress installer will install it for you.

Getting GeoExpress
When you purchaseGeoExpress, you can choose to download an installer for theWindows GeoExpress
graphical and command line applications, an installer for the Linux command line application, or an ISO including
all versions of GeoExpress as well as other applications, utilities, and sample images.

Download the software from the LizardTech website (https://www.lizardtech.com/support/geoexpress/installers).

https://www.lizardtech.com/support/geoexpress/installers
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Chapter 2: Installation and Licensing
Installing GeoExpress
Overview
To set upGeoExpress, complete the following steps:

l Run theGeoExpress installer to install the GeoExpress application.
l Enter a license code or connect to a License Server.
l If you have a copy of GeoExpress Standard Edition, install a data cartridge.

Installing
If you are upgrading from GeoExpress 9.5 or later, you can install GeoExpress 10 without any special preparation.

If you are running GeoExpress 9.1 or earlier, youmust uninstall the older version before installing GeoExpress 10.
See Instructions for GeoExpress 9.1 and earlier on the GeoExpress Installers
(https://www.lizardtech.com/support/geoexpress/installers) page.

GeoExpress 10 requires a new serial number.

1. Log on to the computer where you want to install GeoExpress.
You don’t need to log on as an administrator but you do need to be able to perform admin overrides.

2. Navigate to the directory containing the GeoExpress installer and double-click SETUP.EXE to start the
GeoExpress Installation Wizard.

3. The installation wizard prompts you to complete the following tasks:

n Install theMicrosoft .NET Framework, Visual Studio C++ Redistributable, and any other required
libraries.

n Accept the License Agreement.
n Decide whether to share anonymous usage information.

To change this option within the application, choose Help > Anonymous Application Usage.
n Enter your serial number or choose to run GeoExpress in Trial mode.

Serial numbers are specific to a version of GeoExpress, and determine the functionality available to
you. For example, there are different serial numbers for GeoExpress Standard andGeoExpress
Unlimited.

n Select the directory where you want to install GeoExpress.
n Follow the steps to complete the installation.

Installing data cartridges
The Standard edition of GeoExpress requires a data cartridge to create new compressed images. The data
cartridge represents a specific purchased amount of data that you can use to create these images.

Data cartridges are generated by LizardTech and emailed to you as an attached file. You add data cartridges in the
License and Cartridge Management dialog.

You can either install a data cartridge on your computer or you can use a data cartridge from an Express Cartridge
Manager Server.

For more information on configuring the Express CartridgeManager and how to calculate data usage, see Data
cartridges on page 133.

https://www.lizardtech.com/support/geoexpress/installers
https://www.lizardtech.com/support/geoexpress/installers
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Requesting a data cartridge
1. Visit https://www.lizardtech.com/sales/purchase/ to submit a data cartridge request.
2. Your sales representative will work with you to place your order.
3. LizardTech Customer Support will send your data cartridge file through email.

If LizardTech Sales or Customer Support needs additional information to process your order, they will contact you.

Installing a data cartridge
Method 1
1. Save the email attachment that you received from LizardTech Customer Support.
2. Double-click the saved data cartridge file.

This installs the data cartridge.

Method 2
1. Save the data cartridge that you received in an email from LizardTech Customer Support to your computer.
2. Start GeoExpress.
3. ChooseOptions > Licensing.
4. In the Cartridges section, click Import.
5. Navigate to the directory where you saved the email attachment.
6. Select the email attachment and click Open.

GeoExpress installs the data cartridge. The bottom of the dialog shows how much data remains on your
cartridge.

Connecting to an Express Cartridge Manager Server
1. Start GeoExpress.
2. ChooseOptions > Licensing.
3. In the Cartridges section, enter the name or IP address of the computer hosting the Express Cartridge

Manager Server, followed by the port number, then click OK.
The default port number is 9002.

Licensing GeoExpress
The first time that you runGeoExpress, youmust enter a serial number (if you did not enter one during installation)
and a license code, or connect to a license server. Otherwise, GeoExpress will run in Trial mode, which expires
after 30 days.

License codes are specific to your computer system. You can request a permanent license code from LizardTech
Customer Support. If you activate a temporary license code, you can switch to a permanent license code in the
License and Cartridge Management dialog.

If you connect to a license server, you use a floating license that can be shared by multiple computers.

https://www.lizardtech.com/sales/purchase/
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Requesting a license
1. Start GeoExpress.
2. ChooseOptions > Licensing.

This opens the License and Cartridge Management dialog.
If your temporary license code has expired, the License and Cartridge Management dialog opens when
you start GeoExpress.

3. In the Licensing section, click Copy to copy the locking code.
4. Click Send Activation Request. This will open your default web browser at the LizardTech Product

Activation (https://www.lizardtech.com/support/product-activation/) page.
5. Fill out the form and paste your locking code in the Locking Code field.

LizardTech Customer Support will send you a license code within one business day.

NOTE: If you useGeoExpress with a license server, you do not need to submit your computer’s locking code.

Entering a serial number and license code
1. Start GeoExpress.
2. ChooseOptions > Licensing.
3. In the Serial Number section, enter the serial number that you received from LizardTech Customer Support

if you have not done so previously.
The Serial Number section will show whether the serial number is valid.

4. In the Licensing section, enter the license that you received from LizardTech Customer Support.
You can also import the license file that you received from LizardTech; click Import in the Licensing
section and select the .lic file.

5. Click OK.
The title bar of themain GeoExpress window displays the type of license in use.

Connecting to a license server
1. RunGeoExpress.
2. In the Licensing section, enter the name of the License Server.
3. Click OK.

For more information on floating licenses and the LizardTech License Server, see Floating licenses on page 134.

https://www.lizardtech.com/support/product-activation/
https://www.lizardtech.com/support/product-activation/
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Chapter 3: Getting Around in GeoExpress
Main screen
You can use theGeoExpress graphical user interface to complete all compression andmanipulation tasks. To
start GeoExpress, double-click the desktop icon or onWindows 8 through 10, go to the Apps screen and click
GeoExpress 10 under LizardTech; onWindows 7, choose Start > All Programs > LizardTech >
GeoExpress > GeoExpress 10.

A. Menu bar: Access most functions within GeoExpress. Learnmore
B. Toolbar: Access common imagemanipulation functions. Learnmore
C. Job Properties tab: details about selected job(s). Learnmore
D. Job Progress tab: Details of running jobs. Learnmore
E. Output Preview tab: Scalable preview of output for selected job. Learnmore
F. Job List: Files to be process. Learnmore
G. Run Job button: Start encoding selected jobs. Learnmore
H. Data cartridge details: Shows how much data is available and the requirements for the selected job. Learn

more
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Menus and toolbar
GeoExpress menus
Themenu bar is a central place where you can view most of the tasks that you can perform in GeoExpress and the
options that you can set.

The following table describes some of the options unique to themenu bar:

OPTION DESCRIPTION

File > Save project Saves changes to the current project. If it has not been saved, you’ll be prompted for a
filename.
A project consists of the current contents of the Job List and global settings.

Options > Preferences Set or restore default preferences for output files, including output directory, compression
ratio, and more.
For raster images, you can set the default output directory and file format, set a default
compression ration for each file format, and more. See General and Appearance
preferences on page 106, MrSID preferences on page 111, and JPEG 2000 preferences
on page 113.
For LiDAR images, you can set the default compression ratio, specify the default number
of points to display in the point cloud preview, and more. See LiDAR preferences on
page 115.

Options > Licensing Enter or import license information or a data cartridge license or connect to a License
Server.

For a full description of all menu options, see File menu on page 145.
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Toolbar
Access the GeoExpress toolbar to add images andmosaics to the Job List and to perform imagemanipulation
tasks. The tools that you can access in the toolbar vary depending on the image that you select in the Job List.

The toolbar contains the following tools:

ICON NAME DESCRIPTION

Add Image Add one or more images to the Job List.

Create New Mosaic Adds a mosaic to the Job List. First you’ll be prompted to select the files that
make up the mosaic, then you can set the output file name, location, and
format, change the projection and edit details of the mosaic.

Edit Metadata Edit the metadata of an image. For raster and LiDAR files, you can change
the projection information stored in the metadata. For raster images, you can
also include custom information in the image.

Despeckle Remove speckling from MrSID and JPEG 2000 raster images.

Image Crop Crop a raster image or LiDAR point cloud.

Area of Interest Specify part of a raster image as an “Area of Interest,” and change the
compression ratio of that area to preserve more detail or blur that part of the
image.

Color Balance Change the brightness, contrast, and gamma values for a raster image, or for
individual bands in the image.

Reproject Change the projection used by a raster image. You can select a standard
coordinate reference system (CRS) or specify a custom well known text
(WKT) string.

Job List
The Job List is the pane on the left side of the GeoExpress user interface that displays the raster and LiDAR files
with which you want to work.

The Job List is where you add or remove images for compression andmanipulation operations, work with project
files, select images to view information about them, and run your jobs.

The Job List is divided into a section for raster files and a section for LiDAR files. GeoExpress treats each image,
point cloud, andmosaic in the Job List as a discrete job. The name displayed in the Job List is a user-specified
job name that has no effect on the resulting output file.

l To add images and point clouds to the Job List, click the Add Image button in the toolbar. You can also
drag images into the job list from another application.

l To create a mosaic, click the Create New Mosaic button. The Job List displays the tiles that you add to a
mosaic in an indented list.

l To view information about a job, select it in the list then click one of the Job Properties, Job Progress,
or Output Preview tabs.

l To edit a job’s basic options, double-click the job in the list.
l To move a job in the list, click it once then drag it up or down in the list.
l To remove a job, select it and press the Delete key.
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Run Job button
Click the Run Job button immediately below the Job List to run one or more jobs. The jobs that you run depend on
which jobs you have selected in the Job List. If no jobs are selected, then the Run Job button runs all jobs.

For more information on running jobs, see Run a job on page 28.

Shortcut menu
GeoExpress provides a shortcut menu when you right-click on a selected job in the Job List.

MENU ITEM FUNCTION

Edit > Cut Removes the selected elements from the list. You can then paste the elements at another
location in the Job List.

Edit > Copy Copies the selected elements. You can then use Paste to duplicate the items in the list.

Edit > Paste Places copied or cut elements at the selected position in the Job List.

Edit > Select All Selects all the items in the Job List.

Run Run selected jobs.

Cancel Stop one or more running jobs.

Resume Resumes a selected job if it has been paused.

Pause Pauses a selected job if it was running.

Remove Remove selected jobs from the Job List.

Job Options Set format, compression, dimensions, resolution, and tiling options for the selected job.

Advanced Options Set advanced input, output, and other options for the selected job.

Metadata Options View and edit image metadata.

Edit mosaic Add, remove, crop, change order, and set a coordinate reference system for tiles. This
option is only available if the selection is a mosaic job.

NITF Image Segments Displays the image segments in the selected file and allows you to select the segments
that you want to include in the output file.

Export Job Settings Export a text file containing information about the selected job and the version of
GeoExpress. Use this to remember job settings or when contacting LizardTech support.

Job Properties panel
The Job Properties panel displays information about the selected jobs, in four sections: Input File,
Modifications from Original, Image Dimensions, andOutput Settings.

NOTES
n If you havemultiple files selected, any non-identical properties will be listed as Multiple.
n If you have selected a single tile in amosaic, the properties displayed are for the entire mosaic.

For example, the file size displayed will be the total disk space consumed by all tiles in themosaic.
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Input File
This section shows properties of the selected file:

l File size on disk in appropriate units (MB, GB, KB)
If you select a single mosaic tile or the entire mosaic, the file size shown is always the total size of all the
mosaic tiles on disk

l File type (TIFF, MrSID, etc.)
l Projection (if any)

Raster files will also include:

l Data type (FLOAT32, UINT16, etc.)
l Number of bands

Modifications from Original
This section will list any manipulations you havemade on the selected job, in the order they will be performed.
These include AOI (Area of Interest), Color Balance, Crop, Despeckle, Metadata, Mosaicked, and
Reprojection.

Each listedmanipulation is a link that you can click to review or edit the changes before you run the job.

Image Dimensions
This section shows the dimensions and projection for the output image. Thesemay differ from the input image,
especially if you have cropped or reprojected the image.

For raster jobs, the dimensions displayed are:

l Top, Left, Right, Bottom: the coordinates of the four edges of the image, in the CRS of the output
projection

l Projection: The CRS of the output job. Unless you have reprojected the image, this will be the same as the
source image.

l Width, Height: Size of the output file, in pixels
l Resolution: Scale of the image per pixel, in the units of the projection. If the projection is None (i.e., there is
no CRS for the image), the resolution of 1 corresponds to 1 pixel (in the output) per pixel (of the input).

l Tile Extents: If you have selected a single tile in amosaic, the Tile Extents link will be displayed; click it to
view the top, left, bottom, right, and resolution of the selected tile.

For LiDAR jobs, the dimensions shown are:

l X min, X max: The lowest and highest coordinates of the point cloud on the X axis (East/West)
l Y min, Y max: The lowest and highest coordinates on the Y axis (North/South)
l Zmin, Z max: The lowest and highest coordinates on the Z axis (elevation)
l Projection: The CRS of the output job.
l Points: The number of data points in the output point cloud. (This is typically an estimate if the job includes
cropping or reprojection.)
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Output Settings
In this section, you can specify the type of file to be generated when the job is run, set basic compression options,
and select a destination and filename for the output.

l File Type: Choose the desired output type from the pop-upmenu.
If you have selectedmultiple jobs that have different default outputs, this will be blank; you can set the
same output for all selected jobs.

l Ratio: Identifies the level of compression applied to the output job.
For some types of images you won’t be able to change this (for example, floating-point images always use
Quantization compression).
Otherwise, you can choose between using lossless compression, or setting a target compression ratio.

l Basic Options: Click the Basic link to open the Basic Options dialog, which allows you to change location,
format, compression, dimensions, resolution, and tiling options.

l Advanced Options: This link is only present for raster jobs. Click the Advanced link to open the
Advanced Job Options dialog, where you can changemany more job options.

l Save Output to: This field indicates the destination for the selected job. If you have selected one job, this
field shows the destination path and filename.
If you have selectedmultiple jobs with the same destination folder, this field will show the path to that folder;
otherwise, it displays the word “Browse.”
Click the Browse button to choose a destination for the selected jobs.

l File Data: This shows the approximate size of the output file, the amount of systemmemory needed to run
the job (for MG2, MG3, or MG4 raster images), the amount of data remaining on your data cartridge (for
GeoExpress Standard users), and the approximate amount of data the job will consume from your cartridge.
Click the Buy link to replenish your cartridge when it is low.
For more information on how thememory usage is calculated, see Calculatingmemory usage on page 130.

Job Progress panel
In the Job Progress panel, you canmonitor the progress of running jobs.

Use the controls at the top of the Job Progress panel to pause, resume, or cancel all jobs in the queue. Click the
exposure arrow next to the progress bar at the right of the queue controls to show the status of jobs in the queue.

You can also review and control individual jobs in the queue.

Job control
Running jobs appear in a list, showing the job name and progress.

When a job is running, the progress bar is blue. Click the Pause button at the right end of a job progress bar to

pause that job; click the Cancel button to cancel the job.
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When a job is paused, the progress bar is orange. Click the Resume button at the end of the progress bar to

resume the job.

NOTE: It may take considerable time for a job to pause, especially if it is a largemosaic.

When a job finishes, the progress bar shows green, then the job is removed from the Job Progress list.

GeoExpress processes each job in a separate thread. The number of threads that can run simultaneously depends
on the number of processor cores available on your system. If you runmore jobs than can be processed
simultaneously, some jobs will be listed as “Queued.” You can cancel a queued job even before GeoExpress
starts to encode it.

You can drag jobs up or down in the Job Progress list to change the order in which they are processed. Click and
drag the dotted “handle” at the left end of the progress bar.

You can also right-click a job in the queue and choose Run job next from the shortcut menu tomove the job to the
top of the queue.

If a job cannot be completed, it will be displayed in the list as a failed job. You can click the Start button at the

right end of the failed job’s progress bar to haveGeoExpress try again.

To see the log for a failed job, click it in the Job List. The relevant portion of the job log is displayed at the bottom
of the Job Progress panel; there will usually be enough information to determine why the job failed.

Before you canmake corrections to the job, youmust cancel it; click the Cancel button at the right end of the
progress bar, then return to the Job Properties panel to make changes to the job.

For more information about log files, see Viewing and using log information on page 116.
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Output Preview panel
You can preview raster images and LiDAR point clouds. For raster images, you can preview images to see the
expected output of a compression or manipulation operation. To cancel the rendering of a preview image, click on
the Job Properties or Job Progress tab.

A. Home: Center and scale the preview to fit the window
B. Pan: Click and drag the image within the window
C. Zoom In: Click within the image to zoom in on a point
D. ZoomOut: Click within the image to zoom out from a point
E. Smooth Zoom: Use themouse wheel (or equivalent) to zoom the image
F. Band Selector: Show or hide the Band Selector window
G. Scale: Drag the slider to scale the preview up or down
H. Band Selector window: Determine which bands are shown in the preview

X and Y coordinates for the position of the cursor are given below the image pane.

For more information on how to preview an image or mosaic, see Preview job output on page 27 and Previewing a
mosaic on page 102.
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Previewing raster images
TheOutput Preview panel includes a toolbar to help navigate the preview image.

For raster images, you canmove the Scale slider to change the scale of the preview image. Setting the scale to
1:1 enables the option to Preview output image with target encoding options at 1:1. When you select this
option, GeoExpress runs the image compression or manipulation operations on the visible portion of the image.

For multispectral imagery, click the Band Selector button tomanually select the bands that you want to
preview. You can select Default View, RGB, or Grayscale. The Default View uses the first three bands of the
multispectral image as the RGB bands. Tomanually select the RGB bands that you want to use, choose RGB.
UseGrayscale to view a single band of the source image as a grayscale image.

NOTE: The Band Selector only affects the image preview. To change the RGB bands used in the encoding
process, click Advanced in the Job Properties panel, then select the RGB bands that you want to use in the
Bands tab of the Advanced Job Options window.
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Previewing LiDAR point clouds

A. Orbit focal point: Click and drag within the image to rotate around the point clicked.
B. Refresh points: Clears the preview and re-renders your current view
C. Viewer options: Open the Viewer Options window

LiDAR point clouds are displayed in 3D. Click the Orbit focal point button to rotate the image. Click the
Refresh points button to clear the preview pane and render the points in the current view again. To render your
points quickly, GeoExpress draws a representative sample of your points rather than drawing every single point. If
you pan or zoom in, youmay want to refresh points to draw more points in the area that you are viewing. To
increase or decrease the default number of points that GeoExpress draws, see Viewing on page 116.

NOTE: To preview a LiDAR point cloud stored as a text file, ensure that you select the option to Read the
whole file when the Text Parsing dialog appears.
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LiDAR Viewer options
Click Viewer options to adjust several options that can affect the LiDAR preview. These settings only affect
the preview, and not the output file.

l Use RGB colors in file: Check this box to display the image preview with RGB color. If the LiDAR file does
not include color information, this option will be disabled.
If Use RGB colors is turned off or unavailable, the preview will default to using a gradient ranging from blue
for the lowest elevation to red for the highest, based on data points in the file.

l Use custom gradient range: Check this box and enter theminimum andmaximum elevations to use for
the gradient range. All points below theminimum value will be blue, and all points above themaximum will
be red.
Elevation units are defined by the vertical projection; the elevation range in NAVD 88-based projections is
expressed inmeters.
Use this option if the default gradient does not display properly. (This can occur if one or more points in the
point cloud has an incorrect Z value.)
You need to uncheck Use RGB colors for this option to take effect.

l Z Exaggeration: Change this value to exaggerate or de-emphasize the effect of differences in elevation. 1
is the true scale; enter a larger value to stretch the height, or a value between 0 and 1 to flatten the preview’s
elevation.

l Number of points: This is the number of points that GeoExpress will use to preview the image. Lower
values will speed up the preview but provide less detail; increase the point count to get better detail (at the
expense of rendering speed).

l Point size: This is the number of screen pixels used to display a single point in the point cloud. Youmay
want to increase this if you dramatically reduce the Number of points used in the preview; usingmore
pixels per point will smooth out a preview that has a low point count.

l Alpha channel: Specify the property of the point cloud that will be represented in the Alpha channel of the
preview image. (The Alpha channel is rendered as transparency.)



Chapter 3: Getting Around in GeoExpress

– 23 –

l Keep points where: Use this feature to identify a threshold for what points in the point cloud to display.
Choose a property from the first pop-upmenu (such as Intensity), a relationship from the second (such as !
for NOT), and enter a relevant value in the text field.For example, specify Z > 1000 to restrict the preview to
points whose elevation is over 1000.

l Click Apply to apply changes to the preview image and keep the Viewer Options window open.
l Click OK to apply your changes and close the Viewer Options window.
l Click Cancel to revert the preview and close the Viewer Options window.
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Chapter 4: Working with GeoExpress
Typical workflow overview
This is a typical process for most compression andmanipulation operations in GeoExpress.

1. Add images, LiDAR point clouds, or mosaics to the Job List. Learnmore
The images, point clouds, andmosaics that you want to compress or manipulate in GeoExpress are called
jobs.

2. Select the jobs that you want to manipulate or compress.
3. Select an output format. Learnmore
4. Select an output destination.
5. Specify compression for the job. Learnmore
6. Optionally, for images andmosaics, perform imagemanipulation operations. For example, youmight

despeckle or reproject an image. Learnmore
7. Optionally, specify additional job options. For example, for raster images, youmight change the resolution

or create image tiles. Learnmore
8. Optionally, preview the image or point cloud before running the job. Learnmore
9. Optionally, for raster images, create a test image. Learnmore
10. Run the job. Learnmore

Adding and removing jobs
Adding a job
Before you can compress or manipulate images and point clouds, youmust add them to the Job List.

A job can consist of a single image to bemanipulated, or a group of images to bemerged together as amosaic.

To add a single image job, you can:

l Drag one or more image files fromWindows Explorer into the Job List;
l Click Add Image on the toolbar and select image files to add as jobs;
l Choose File > Add image(s) and select image files;
l Choose File > Recent files then select an image file that you worked with recently.

NOTE: If you add a LiDAR text file to the Job List youmust set text parsing options so that GeoExpress can
match the columns in the text file to standard fields. For more information, see LiDAR text parsing options on
page 67.

To add amosaic job, click Create New Mosaic on the toolbar or choose File > New Mosaic.

NOTE: If you dragmultiple image files into the Job List, GeoExpress will offer to create a new mosaic from
them.

To learnmore about mosaics, see Creating amosaic on page 98.

Working with jobs
Jobs are grouped in the Job List by kind: Raster Files and LiDAR Files. To expand or collapse a group of jobs,
click the triangle next to the group icon.

A mosaic job is shown as a sub-group within each group. To see the individual image tiles in amosaic, click the
triangle to the left of themosaic name.

Select a job in the Job List to view information about the job, set job options, or run the job.

To select all the jobs in the Job List, right-click anywhere in the Job List and choose Edit > Select All, or press
Ctrl+A.
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Removing a job
To remove a job from the Job List, right-click on the job name and choose Remove, or select the job and press
the Delete key.

When you remove amosaic job from the Job List, you also remove all the tiles associated with themosaic.

NOTE: You do not need to remove an image or mosaic from the Job List to keep it from being encoded. Only
the files that you select in the Job List are encoded when you click Run Job.

Specify the job output
Selecting an output format
When you compress an image or point cloud, the default output format is MrSID Generation 4. You can change the
output format in the Job Properties tab.

1. Select one or more jobs in the Job List.
2. Click the Job Properties tab to view job properties.

If you have selectedmore than one job, the Job Properties panel will show properties common to all the
selected images.

3. In the Output Settings section of the panel, select the output format for the selected jobs from the File
Type pop-upmenu.

NOTE: Some output formats may not be available depending on certain properties of your input image, such as
the data type and number of bands.

Selecting an output destination
By default, the output destination is the same directory where the input image is stored, and the output filename is
the same as the input filename.

To change the destination, click Browse under Output Settings, or type a path in the Save Output To field.

If you have only one image selected in the Job List, you can also specify a new name for the output file.

For more information about the output destination, see Destination options on page 65 and Selecting an Express
Server on page 66.
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Specify compression
The images and point clouds that you create with GeoExpress are compressed by default.

You can set compression options for each job in the Job Properties panel.

For raster images, you can specify a compression ratio or a target file size, use lossless compression, set per-
band compression ratios, or use quantization.

For LiDAR point clouds, you can specify a compression ratio or use lossless compression.

NOTES
n Lossless compression will compress the data as much as possible without changing the image or point

cloud. All other compressionmethods are “lossy” and could result in slight visual artifacts, but usually
give amuch higher compression ratio.

n Specifying a compression ratio for LiDAR jobs results in points being removed from the point cloud. The
number of points removed will be logged and displayed in the Job Progress panel.

l To use lossless compression for any type of job, select Lossless under Output Settings.
l To specify how much you want the output file to be reduced in size, enter a compression ratio.
For example, if you have a 100megabyte uncompressed image and you specify a compression ratio of
20:1, the file size of the output image will be 5megabytes.

l GeoExpress automatically uses the quantization compression when you compress a floating point image.
Learnmore.

l You can set other compression options in the Basic Options window. Learnmore

For more information on setting default compression preferences, see Preferences on page 106.

Perform image manipulations
For raster images andmosaics, you can use the tools in the Toolbar to perform the following imagemanipulation
operations:

l Edit metadata for an image. Learnmore
l Despeckle an image. Learnmore
l Crop an image. Learnmore
l Select an Area of Interest. Learnmore
l Set color balancing for an image. Learnmore
l Reproject an image. Learnmore
l Edit the coordinate reference system of LiDAR point clouds. Learnmore
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Set job options
To set basic job options, click Basic under Output Settings in the Job Properties panel, or chooseOptions >
Job options.

The options available depend on whether the job is for a raster file or a LiDAR file and the output format that you
select.

For raster images, you can:

l Change the output destination or publish to an Express Server;
l Change the output format and compression options;
l Set dimensions and resolution of the output file;
l Set tiling options for the output file.

You can also access the Advanced Job Options window, where you can set a color space, edit transparency
values.

For LiDAR point clouds, you can use job options to remove LAS variable length record (VLR)metadata, set
columnmapping options for text files, andmore.

See also:
l Raster job options on page 65
l Advanced job options on page 69
l LiDAR job options on page 67

Preview job output
You can preview a job to see the expected output of a compression or manipulation operation.

When you preview an image, you do not use data from the data cartridge.

1. Select the job in the Job List.
2. Click the Output Preview tab.
3. Optionally, for raster images, move the slider above the preview image to change the scale of the image or

click the Band Selector button tomanually select the bands that you want to view.

For more information on theOutput Preview tab and the Band Selector, seeOutput Preview panel on page 19.
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Create a test image
A test image is an output image with a visible watermark.

Use a test image to preview the results of an imagemanipulation or compression operation without using data
from the data cartridge.

You can create test images from raster images andmosaics, but not LiDAR point clouds.

1. Select one or more jobs in the Job List.
2. Click Advanced in the Job Properties panel, or chooseOptions > Advanced options.

This opens the Advanced Job Options dialog.
3. Click the Job Progress panel.
4. Select Encode As Test Image and click OK.
5. Click Run Job.

Here is an example of a test image:

Run a job
When you run a job, GeoExpress performs the compression andmanipulation operations that you selected.

To run one or more jobs, select jobs and click the Run Job button.

NOTE: The Run Job button will change depending on what you have selected.

l With one job selected, the button is labeled Run Job.
l Withmultiple jobs selected, the button is labeled Run # Selected Jobs, where # is the number of jobs.
l With no jobs selected, the button reads Run All Jobs; click it to process all the jobs in the Job List.
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Job Progress
When you run a job, GeoExpress displays the Job Progress panel where you canmonitor the progress of the
operation. In the Job Progress panel you can:

l Pause, resume, or cancel any running job, or all jobs;
l Rearrange jobs in the queue to determine the order jobs will be run;
l Review the log for current jobs.

If you click away from the Job Progress tab, GeoExpress continues running the jobs in the background.

For details about monitoring jobs, see Job Progress panel on page 17.

TIP: GeoExpress adds information about each job that you run to the GeoExpress log file. For more information
on logs, see Viewing and using log information on page 116.

Other options
Export job settings
Export job settings when you want to save information about a particular job. The job settings are saved to a text
file and include the following information:

l GeoExpress version number.
l Job properties from the Job Properties panel.
l Job encode settings.

To export job settings, right-click on the name of a job in the Job List and choose Export Job Settings from the
shortcut menu.

Project files
A GeoExpress project file is an XML file that saves each job in the Job List and all options that you have applied to
each job.

The project file includes the file path of each image, mosaic tile, and LiDAR point cloud in the Job List. If you
move any files to another directory, you can edit the project file in a text editor.

l To open an existing project, choose File > Open project.

NOTE: GeoExpress 10 can only open project files saved from GeoExpress 9.5.3 and newer.

l To create a new project, choose File > New project.
When you create a new project, you clear the Job List. If there are items in the Job List that have not been
saved, GeoExpress prompts you to save the jobs in a project file.

l To save a project, choose File > Save project.
Saving an edited project overwrites the original.
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Chapter 5: Features in Depth
Compression
Compression basics
Compress your images and point clouds to decrease the size of the files. GeoExpress compresses your images
and point clouds by default.

When you compress raster images with GeoExpress, you can specify a compression ratio, specify a target file
size, use lossless compression, or use quantization for floating point images. If you decide to specify a
compression ratio for a raster image, you can specify a separate compression ratio for each band in an image.
When you compress LiDAR point clouds with GeoExpress, you can specify a compression ratio or use lossless
compression.

If you specify a compression ratio or a target file size, GeoExpress uses lossy compression. When you use lossy
compression, you compress an image to amuch smaller file size by discarding some image data or removing
points from a point cloud.

When you compress a floating point image, GeoExpress uses a lossy compressionmethod called quantization to
compress the image.

When you use lossless compression, you compress an image as much as possible without discarding any image
data.

Specifying a compression ratio
Set a compression ratio for an image to specify how much smaller you want the output image to be compared to
the input image. For example, if you have a 100megabyte image and you specify a compression ratio of 20:1, the
file size of the output image is 5megabytes.

NOTE: For previously-compressed data, the compression ratio is relative to the number of pixels in the
rendered image, not the size of the input file. Specifying a 10:1 compression ratio for a file that was already
compressed 20:1 will likely yield amuch larger file.

1. Select an image in the Job List, then click the Job Properties tab.
2. Enter the compression ratio that you want to use into the Ratio field.

As a rule of thumb, you can compress raster images to a ratio of 20:1 without introducing noticeable compression
artifacts. Compression artifacts include blurring and speckling. By default, the compression ratio for RGB images
is 20:1 and the compression ratio for grayscale images is 10:1.

For multispectral images and LiDAR point clouds, GeoExpress uses lossless compression by default.

NOTE: Specifying a compression ratio for LiDAR jobs results in points being removed from the point cloud. The
number of points removed will be logged and displayed in the Job Progress panel.
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Using lossless compression
Use lossless compression when you need the compressed file to be identical to the original file. GeoExpress will
compress the image or point cloud as much as possible without discarding any data.

You can use lossless compression to createMrSID Generation 4, MrSID Generation 3, JPEG 2000, LAS, LAZ,
and BPF images.

Lossless compression typically yields a 2:1 compression ratio which results in a 50% reduction in the output file
size.

1. Select an image or point cloud in the Job List, then click the Job Properties tab.
2. Select the Lossless compression option.

NOTE: If you compress an image that has already been compressed, you can select Lossless to ensure that
GeoExpress does not discard any additional data.

Specifying per-band compression ratios
You can set individual compression ratios for each band in amultispectral image or mosaic. Use per-band
compression when you want to compress certain bands in an imagemore than others. For example, if you want to
preserve the visual quality of amultispectral image, you can compress the RGB bands of the image less than the
other bands.

NOTE: You can only set per-band compression ratios for MrSID Generation 4 output images.

1. Select an image in the Job List, then click the Job Properties tab.
2. Make sure the File Type is MrSID Generation 4.
3. Open the Basic Options dialog.
4. In the Compression area of the Basic Options dialog, select the Per-Band option.
5. Click Select Bands.
6. Select one or more bands from the list and enter a compression ratio (or select Lossless).
7. Click Apply to Selected to set the compression ratio for the selected bands, then click OK.

Specifying a target file size
Specify a target file size for a raster image to create an output image whose file size equals the target file size.
You can specify a target file size for MrSID Generation 3 andGeneration 4 images.

1. Select an image in the Job List.
2. Open the Basic Options dialog.
3. Select the Target File Size option.
4. Enter the target file size in the text field.

Choose the units (e.g., KB, MB, GB) from the drop-downmenu next to the file size field.

The RGB color transform
Formultispectral images, GeoExpress enables the RGB Color Transform option by default. With this option
enabled, GeoExpress will optimize the compression of the first three bands of the image rather than compressing
each band individually.

If the first three bands of the image are not the RGB bands, change the order of the bands before you apply the
RGB color transform.

If you select the Lossless option, GeoExpress does not optimize the compression ratio of the RGB bands.

By default, GeoExpress matches the color space of the output image to the color space of the input image. When
you change the compressionmethod of an image to per-band compression, GeoExpress does not apply the
RGB color transform by default.
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Using quantization for floating point images
GeoExpress uses quantization to compress a floating point image. You can create 32-bit floating point images in
theMrSID Generation 4 format.

Quantization is a lossy compressionmethod that reduces the number of pixel values in the image. Quantization is
necessary for floating point images for two reasons:

l Performing arithmetic on floating point values results in rounding discrepancies.
l Compressing floating point values results in unnecessarily large images. This is because some of the digits
in each pixel value contain data that is not significant and cannot be compressed.

As a result, GeoExpress uses a lossy compressionmethod for floating point images, but guarantees the accuracy
of the image data to an optimized precision value.

To compress a floating point image with the quantization compressionmethod:

1. Select a floating-point image in the Job List.
A floating-point image has the data type FLOAT32, displayed in the Input File section of the Job
Properties panel.

2. Open the Basic Options dialog.
3. In the Format and Compression section, set Format to MrSID Generation 4.

GeoExpress automatically sets the Compression option to Quantization.
4. Click Set Quantization to configure precision and other quantization options.

For more information, seeQuantization options on page 79.

Metadata
Viewing metadata
For raster images you can view existingmetadata.

1. Select a job in the Job List.
2. Click the Edit Metadata button in the toolbar.

TheMetadata Manager appears.
3. Click the Viewer tab.

The imagemetadata appears.
4. If an image has geographic markup language (GML) embedded in themetadata, select the GML option to

view theGML.
5. Click OK.
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Editing metadata
Use the Edit Metadata tool to edit themetadata of images and LiDAR point clouds.

For raster images, you can edit user, image, and NITF metadata. For LiDAR point clouds, you can only edit
coordinate reference systemmetadata.

Raster metadata

NOTE: The types of metadata that you can edit depend on the output format that you select for an image.

1. Select one or more jobs in the Job List.
2. Click the Edit Metadata button in the toolbar.

TheMetadata Manager appears.
3. To edit user metadata, click the User tab of theMetadata Manager.

n To add a new tag, click Add User Tag, then enter a name and value for the tag.
n To edit the value of an existing tag, select it from the drop-down and enter another value.

NOTE: Tag names cannot contain spaces, and tag values cannot be empty. Existing tags can be
deleted but cannot be renamed.

4. To edit imagemetadata, click the Image tab of theMetadata Manager.

n To specify the image’s coordinate reference system, click Select a Coordinate Reference System
or enter a custom well known text (WKT) string in the WKT text field. Learnmore

n Edit the image origin, image resolution, and dynamic range.

NOTE: Selecting a coordinate reference system in theMetadata Manager does not reproject the
image.

5. To edit NITF metadata, click the NITF Options tab of theMetadata Manager.

n Edit the file header and file security fields in the File Header subtab. Learnmore
n Edit the image subheader, image comments, and image security fields in the Image Subheader

subtab.
6. Click OK.

NOTE: Some existing JPEG 2000 images are encoded in such a way that certain decoders may fail to display
them if you edit their metadata. To accommodate these images, GeoExpress handles several JPEG 2000
parameters in a special way. If you are editing themetadata of existing images and wish to change parameters
for tile lengthmarkers, packet lengthmarkers, or tile parts, youmust change them on the JPEG 2000 tab of the
Preferences dialog. (For more information see JPEG 2000 preferences on page 113 and Advanced JPEG
2000 options on page 88.)

LiDAR metadata
For LiDAR point clouds, you can edit the coordinate reference system (CRS) stored in the file metadata.

1. Select one or more jobs in the Job List.
2. Click the Edit Metadata button in the toolbar.

This opens the Set Projection dialog.
3. Use the Projection Source pop-upmenu to choose a list of standard projections.
4. Choose a projection, then click Set Projection. Learnmore
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Image metadata
LizardTech imagemetadata is information about the pixel values that tells viewing software how to interpret or
treat each pixel. There aremany imagemetadata tags, and a small subset of these are available for editing.

Editing the image tags does not affect the pixel values themselves. For example, changingWKT metadata does
not reproject an image from one CRS to another. However, changingmetadatamay affect how an image is
displayed in a viewer.

Coordinate reference system and WKT
You can assign aWKT to the image that identifies its coordinate reference system. This is useful when you know
the CRS of an image but that data isn’t captured anywhere in the file. It’s also useful if theWKT is incorrect and
you need to correct it.

IMPORTANT: Setting theWKT in themetadata of an image does NOT reproject the image. It only identifies
where the image already is. To reproject an image to a new CRS, use the reprojection tools. Additionally,
carelessly changing theWKT of an imagemay make the image inaccurate or unusable in any GIS applications
that rely on this information.

Image Origin
These X and Y fields can be used to set the x, y location of the image.

Image Resolution
These X and Y fields can be used to set the x and y resolutions of the image.
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Dynamic Range
To improve the appearance of MrSID images in other GIS programs, you can useGeoExpress to write dynamic
rangemetadata for images.

NOTE: If you select MrSID Generation 4 as the image output format, dynamic range values are calculated
automatically for all images except for 8-bit images. If you want to enter the dynamic range values manually for
those images, change themethod for generating the dynamic range to None in the Format-Specific tab of the
Advanced Job Options dialog. For more information on calculating the dynamic range, see Dynamic Range
Metadata Generation on page 83.

The dynamic rangemetadata is particularly useful for images that only use a small portion of their datatype
bandwidth.

For example, 11-bit images are often stored as 16-bit images, where the upper five bits are left empty. The only
bits that aremeaningful are the first eleven. The full dynamic range of pixel values in an unsigned 16-bit image runs
from 0 to 65535. The first eleven bits fall between 0 and 2047, which is only 3% of the full range! When you look at
the histogram of this image (for information on histograms see The Color Balance tool on page 58), all of the
values will be gathered into the far left side, causing the image to appear black when it’s scaled to display on a
computer monitor. For an 11-bit image, theminimum value would be 0 and themaximum value would be 2047 (211
- 1).

An alternate way to think of dynamic range is “window and level.” The window is the width of data that’s important
and the level is where themidpoint of the window lies within the entire range. For our 11-bit image, the window, or
width, is 2048 (211), and the level, or midpoint, is 1023.5 ((211 - 1 ) / 2). The window and level are displayed next to
theMin andMax fields to aid you in setting the dynamic range.

To set the dynamic range of the image, type theminimum pixel value in theMin field and themaximum pixel value
in theMax field.

IMPORTANT: Setting the dynamic range does not change the pixel data of the image. It only gives clues as to
how the image should be displayed. Some applications may honor this value and somemay ignore it,
depending on how the pixels need to be represented for a given workflow. Additionally, setting the dynamic
range is not the same as color balancing. Color balancing changes the actual pixel values, which changes the
nature of the image. (For more information see Performing color balancing for amosaic on page 101.)

Viewable image metadata
In addition to the imagemetadata that you can edit, GeoExpress embeds encodedMrSID and JPEG 2000 images
with a header to preservemetadata from source images. This header is able to carry information on image
location, projection, date produced, and RGB color lookup tables (CLUT) for indexed color images. Each tag is
accompanied by a short description of themethod used to write out the data, either ASCII, signed or unsigned 8-
bit, signed or unsigned 16- or 32-bit integers, or single or double-precision floating point.

Certain input image types such as NITF, GeoTIFF, ERDAS IMAGINE and USGS DOQmay have additional
metadata tags. Such tags are carried over from the source image as-is to the output file in addition to the standard
LizardTechmetadata tags. If the image being encoded is amosaic, GeoExpress preserves themetadata values
from the first image in themosaic. If no information is available for a specific tag, the tag is left out of the header.
Some tags apply to any MrSID or JPEG 2000 image, with or without georeferencing information; other tags apply
specifically to georeferenced images.

NOTE: When encoding GeoTIFF imagery, all the native GeoTIFF metadata tags are prepended with the string
GEOTIFF_CHAR::.
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In addition there are special tags that contain statistical information about the pixel intensities in an encoded
image. These tags contain theminimum, maximum, mean, and standard deviation of the pixel values in the
image. For a grayscale image, single values are output. For an RGB image, values are output in an array where
the first value represents the red band, the second band represents the green band, and the third band represents
the blue band.

The mrsidgeoinfo command line tool can display metadata tags. It is included in the GeoExpress installation.
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General tags
The tags written into MrSID and JPEG 2000metadata are listed in the following table. If an image or mosaic is
cropped while being encoded, the values apply to the cropped output image unless noted otherwise. There is no
predetermined order for the tags.

TAG DESCRIPTION NOTES

IMAGE::BITS_PER_SAMPLE Number of bits per
sample (unit16)

IMAGE::COLOR_SCHEME Color space of the
image (unit32)

Possible values: 0 for RGB, 2 for CMYK, 3 for
grayscale, or 10 for multispectral

IMAGE::DATA_TYPE Datatype of samples in
image (unit32)

Possible values: 0 for unsigned 8-bit int, 1 for 32-bit
float, or 2 for unsigned 16-bit int

IMAGE::DEFAULT_DATA_VALUE Sample values for
background pixel

Stored as an array of values, one for each band, in
order. The values are stored in the datatype of the
samples. Note: With older images containing unit8
data, the tag IMAGE::NO_DATA_VALUE may be used

IMAGE::DYNAMIC_RANGE_
WINDOW

Custom contrast setting
(double)

Represents the size of the range of the data

IMAGE::DYNAMIC_RANGE_
LEVEL

Custom brightness
setting (double)

represents the midpoint of the range of the data

IMAGE::EOM End of metadata

IMAGE::HEIGHT Height of the image in
pixels (unit32)

IMAGE::INPUT_FILE_SIZE Size of the input image
or mosaic, in bytes
(double)

IMAGE::INPUT_FORMAT Name of the input
image type (string)

IMAGE::INPUT_LUT Color lookup table Stored as an array of 758 values (3 × 256), one value
for each band (R, G, B) for each of the 256 entries in
the table.

IMAGE::INPUT_NAME Filename of the input
image (string)

IMAGE::NO_DATA_VALUE Sample values for
background pixel

Used only for older MrSID images; see
IMAGE::DEFAULT_DATA_VALUE.

IMAGE::SOM Start of metadata

IMAGE::TRANSPARENT_DATA_
VALUE

sample values for the
nodata pixel

Stored as an array of values, one for each band, in
order. Values are stored in the datatype of the
samples.

IMAGE::WIDTH Width of the image, in
pixels (unit32)

IMAGE::X_RESOLUTION Georeferencing pixel
resolution in the x-
direction (double)
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TAG DESCRIPTION NOTES

IMAGE::XY_ORIGIN Georeferencing
location (x, y) for the
center of the top left
pixel.

Stored as an array of two doubles.

IMAGE::Y_RESOLUTION Georeferencing pixel
resolution in the y-
direction (double)

Area of Interest (AOI) tags
The tags in the table below apply only to images encoded with an Area of Interest.

TAG DESCRIPTION NOTES

IMAGE::AOI::N::REGION::VECTOROVERLAY Name of the vector overlay file, if
any (string)

IMAGE::AOI::N::REGION::VECTOROVERLAY_
LAYER

Layer number from the vector
overlay file, if one is used
(integer)

IMAGE::AOI::N::REGION::X Upper left x position of the region
(integer)

IMAGE::AOI::N::REGION::Y Upper left y position of the region
(integer)

IMAGE::AOI::N::METHOD The Area of Interest method used
(string)

Possible values: shift
inner, shift outer, or
weight.

IMAGE::AOI::N::WEIGHT Weight value used (double)

IMAGE::AOI::N::MAGNIFICATION Magnification at which the AOI
was applied (double)

IMAGE::AOI::N::NAME Optional name of the AOI region
(string)

IMAGE::AOI::N::COMMENT Optional comment for the AOI
region (string)

IMAGE::AOI::N::URL Optional URL referring to the AOI
region (string)
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MG2-spaceific tags
The tags in the table below apply to MG2 images only:

TAG DESCRIPTION NOTES

IMAGE::COMPRESSION_BLOCK_
SIZE

Block size used in MrSID
encoding (unit32)

IMAGE::COMPRESSION_GAMMA G-weight value used in MrSID
encoding (float)

IMAGE::COMPRESSION_VERSION Version of the encoder used
(array of 3 sint32 values)

IMAGE::COMPRESSION_WEIGHT Weight value used in MrSID
encoding (float)

IMAGE::CREATION_DATE Date and time of image
encoding (string)

IMAGE::COMPRESSION_NLEV Number of zoom (resolution)
levels in the image (unit32)

IMAGE::STATISTICS:MAXIMUM Maximum sample values for
each band in the input image
(array of values)

The number and datatype of the values
correspond to the number of bands and
sample type of the image.

IMAGE::STATISTICS:MINIMUM Minimum sample values for
each band in the input image
(array of values)

The number and datatype of the values
correspond to the number of bands and
sample type of the image.

IMAGE::STATISTICS:MEAN Average value of all samples
for each band (array of
doubles)

IMAGE::STATISTICS:STANDARD_
DEVIATION

Standard deviation of all
samples for each band

IMAGE::TARGET_COMPRESSION_
RATIO

compression ratio used for
encoding (float)

For MrSID Generation 2 (MG2), this value
only approximates the actual compression
ratio achieved.

MG4-specific tags
The tags in the table below apply to MG4 images only:

TAG DESCRIPTION NOTES

IMAGE::QUANTIZATION_
SCALE

Precision values
used for
quantization

For floating point images, GeoExpress uses the quantization
compression method. For more information on the precision value,
see Quantization precision on page 80.

Other metadata tags
When using GeoTIFF input images, the GeoTIFF metadata tags are copied directly into theMrSID or JPEG 2000
file. When using ERDAS IMAGINE and USGS DOQmetadata, certain other custommetadata tags are inserted
as well.
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NITF metadata
You can edit the followingmetadata for images with the NITF output format:

l File header
l File security fields
l Image subheader
l Image security fields
l Image comments

For more information on NITF metadata, see the NITF 2.1 specification at
http://www.gwg.nga.mil/ntb/baseline/docs/2500c/2500C.pdf.

Viewable NITF Metadata
In addition to the NITF metadata that you can edit, GeoExpress embeds metadata from NITF input files to
preserve the sourcemetadata. When reading a NITF file, GeoExpress stores many NITF fields as metadata, for
example as tag/value pairs in MrSID imagery.

NOTE: The following discussion assumes familiarity with the NITF specification.

In general, the tag name is of the form
NITF::xxnnn::field
where xx is a two letter code representing the NITF segment (IM for image, FH for file header) and nnn is the
NITF segment number. TRE fields contain the prefix TRE_. Specifically, GeoExpress stores input fields in
metadata tags as described in the following tables.
File Header Fields
GeoExpress stores file header fields in the following tags:

NITF FIELD GEOEXPRESS TAG

FHDR NITF::FH000::FHDR

FVER NITF::FH000::FVER

STYPE NITF::FH000::STYPE

OSTAID NITF::FH000::OSTAID

FDT NITF::FH000::FDT

FTITLE NITF::FH000::FTITLE

ONAME NITF::FH000::ONAME

OPHONE NITF::FH000::OPHONE

NUMI NITF::FH000::NUMI

NUMS NITF::FH000::NUMS

NUML NITF::FH000::NUML

NUMT NITF::FH000::NUMT

NUMDES NITF::FH000::NUMDES

NUMRES NITF::FH000::NUMRES

UsingGeoExpress, you can set the values for OSTAID, FDT, FTITLE, ONAME, andOPHONE when encoding
NITF images.

http://www.gwg.nga.mil/ntb/baseline/docs/2500c/2500C.pdf
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Security-Related Fields
GeoExpress stores security-related fields from the file header (unless they are blanks) in the following tags:

NITF FIELD GEOEXPRESS TAG

SCLAS NITF::FH000::SCLAS

SCLSY NITF::FH000::SCLSY

SCODE NITF::FH000::SCODE

SCTLH NITF::FH000::SCTLH

SREL NITF::FH000::SREL

SDCTP NITF::FH000::SDCTP

SDCDT NITF::FH000::SDCDT

SDCXM NITF::FH000::SDCXM

SDG NITF::FH000::SDG

SDGDT NITF::FH000::SDGDT

SCLTX NITF::FH000::SCLTX

SCATP NITF::FH000::SCATP

SCAUT NITF::FH000::SCAUT

SCRSN NITF::FH000::SCRSN

SSRDT NITF::FH000::SSRDT

SCTLN NITF::FH000::SCTLN

GeoExpress allows you to specify values for any of these fields.
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Image Segment Fields
GeoExpress stores image segment fields in the following tags:

NITF FIELD GEOEXPRESS TAG

IID1 NITF::IM001::IID1

IDATIM NITF::IM001::IDATIM

TGTID NITF::IM001::TGTID

IID2 NITF::IM001::IID2

ISORCE NITF::IM001::ISORCE

ICORDS NITF::IM001::ICORDS

IGEOLO NITF::IM001::IGEOLO

NICOM NITF::IM001::NICOM

ICOM1 NITF::IM001::ICOM1

ICOM2 NITF::IM001::ICOM2

ICOM3 NITF::IM001::ICOM3

ICOM4 NITF::IM001::ICOM4

ICOM5 NITF::IM001::ICOM5

ICOM6 NITF::IM001::ICOM6

ICOM7 NITF::IM001::ICOM7

ICOM8 NITF::IM001::ICOM8

ICOM9 NITF::IM001::ICOM9

With GeoExpress, you can enter custom data for these image segment fields: IID1, IDATIM, TGTID, IID2,
ISORCE, NICOM, ICOM1 through ICOM9.

Additional Notes
In addition, GeoExpress does the following:

l Handles the security fields in the Image Segment as they are handled in the file header;
l Stores all detected TREs inmetadata as binary data. For example, USE00A data would be stored as an
array of bytes using the tag NITF::IM001::TRE_USE00A;

l Explicitly recognizes the following TREs when reading in a NITF file:
J2KLRA, USE00A, STDIDC, PIAIMC, and RPC00A/B.

For these TREs, additional metadata entries are created corresponding to each of their constituent fields.
For example, PIAIMC data is represented as follows:

NITF::IM001::TRE_PIAIMC_CLOUDCVR
NITF::IM001::TRE_PIAIMC_SRP
NITF::IM001::TRE_PIAIMC_SENSMODE
NITF::IM001::TRE_PIAIMC_SENSNAME
…

User metadata
LizardTech user metadata is merely descriptive and has nothing to do with the image pixel data. There are 12
default user metadata tags. They can be thought of as addenda or footnotes and include such data as geographic
location, company name, and scan info. You can include data for any or all or none of the tags, and you can add
your own custom user metadata tags for other information you would like to include. All of LizardTech’s user
metadata tags can be edited.
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Metadata templates
To assist in editing the user metadata of multiple images, theMetadata Manager allows metadata templates to
be saved and applied to one or more images. A metadata template contains all of the tags and values that you
wish to apply to a given image or images.

Metadata templates are created, edited, saved, retrieved and applied in theMetadata Template Editor.
Accessing theMetadata Template Editor
1. Select one or more jobs in the Job List.
2. Choose Tools > Metadata.

This opens theMetadata Manager dialog.
3. Click Metadata Templates to open theMetadata Template Editor.

Select or deselect a value or set of values to enable or disable a given tag.

The image tags are the same as those in theMetadata Manager except that you can choose to save any or all of
these in the template.
Creating a tag in the Template Editor
1. Click in the Name field of the row that starts with an asterisk (*).
2. Type a name for the tag.
3. Click the Value field and enter a value.

Tag names cannot contain spaces and tag values cannot be empty.
Deleting a tag in the Template Editor
1. Select the entire tag by clicking the gray cell at the far left of the row.
2. Press the Delete key.

Saving a template
1. Click the Save Template button.
2. Enter a name for the template and click OK.

Loading a template
1. Click the Load Template button.
2. Choose a template from the drop-down list and click OK.

Deleting a template
1. Choose the template in the Load Metadata Template or Save Metadata Template dialog.
2. Right-click the template name and choose Delete this template.

Applying a template
1. Create a template or load a template in theMetadata Template Editor.
2. Click Apply Template.
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Despeckling
If you need tomake images with higher compression ratios, use the Despeckle tool to minimize compression
artifacts.

A side effect of lossy encoding schemes is that subtle compression artifacts are introduced which alter the pixel
values of the source image. While these changes are usually invisible to the human eye, they can damage the
integrity of any collar regions in the image, whichmakes it difficult to seamlessly mosaic images together. The
best way to avoid this “speckling” in the collar areas is to compress toMrSID Generation 4 (MG4), or to losslessly
encode source images toMrSID Generation 3 or JPEG 2000.

IMPORTANT: Despeckling is a computationally expensive operation that increases the time it takes to encode
an image. Also, despeckled JPEG 2000 files employ an alpha band tomask the transparent region; most, but
not all, applications can view JPEG 2000 files with alpha bands.

Despeckling is only supported for MG3, MG4, and JPEG 2000 output. If you select JPEG 2000 as the format of
your despeckled output, that output will be aGMLJP2 file and thus a JPEG 2000 Part II file, even if your input was
a JPEG 2000 Part I file. Source images with alpha bands cannot be despeckled when outputting to JPEG 2000.
Also, the area of valid image datamust be contained within a single polygon (for example, an image of a series of
islands cannot be despeckled).

By default, images are not despeckled upon encoding. Further, despeckling is not recommended for images
without a collar. To despeckle images by default for theMrSID or JPEG 2000 formats, set the despeckling option
in the preferences. For more information on preferences, see Preferences on page 106.

NOTE: Some existing JPEG 2000 images are encoded in such a way that certain decoders may fail to display
them when despeckled with GeoExpress’ default settings. To accommodate these images, GeoExpress
handles several JPEG 2000 parameters in a special way. If you are despeckling images using the
Despeckling dialog and wish to change parameters for tile lengthmarkers, packet lengthmarkers, or tile parts,
youmust change them on the JPEG 2000 tab of the Preferences dialog. (For more information see JPEG
2000 preferences on page 113 and Advanced JPEG 2000 options on page 88.)

Despeckling an image
When you select a single job for despeckling, the image is displayed in the preview area of the dialog. If you select
multiple jobs, the preview pane and navigation buttons are not displayed. You can despeckle images with the
MrSID Generation 4, MrSID Generation 3, or JPEG 2000 output format.

1. Add a source image or mosaic to the Job List.
2. Click the Despeckle button on the toolbar.

This opens the Despeckle Options dialog.
3. Select Despeckle Output.
4. Optionally, enter threshold and point spacing values by typing them in the edit fields or using the slider

controls (see below for information about these values). Note: The sliders only move within the
recommended range (1–127 for threshold and 6–12 for point spacing), but youmay enter any integer greater
than zero in the fields.

5. To preview the effects of the threshold at different settings select the View Threshold option and then
move the Threshold slider. Black areas are pixels whose values fall below the threshold and will be used to
determine the despeckling collar of the image.

6. Click OK.
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Despeckling threshold
All pixel values below the despeckling threshold will be used in the despeckling process. For example, with a
threshold value of 10, GeoExpress treats any border pixels with a value less than 10 as no-data pixels.

By default, the threshold value is 8.

Point spacing
In order to despeckle an image, GeoExpress must determine themask or “outline” of the valid image data. This
outline is created as a polygon of connected points, similar to a “connect the dots” drawing. Image data that fall
outside the outline are treated as invalid and subject to despeckling.

Whether image pixels are incorporated into themask or abandoned as “islands” of data is largely a function of the
point spacing value, which determines the distance between the points that make up the outline. The less
distance there is between points in the outline, themore points it takes to create the entire outline.

Therefore, decreasing the point spacing value raises the number of points, which is generally desirable and is
particularly useful when the outline is complex, such as that of a coastline. However, higher numbers of points
may slow performance or cause the job to fail. Conversely, increasing the point spacing value reduces the total
number of points, whichmakes for better performance. When the outline is simple, such as a rectangle, the point
spacing value can safely be increased.

For any given dataset, some trial and adjustment may be required to arrive at the best balance between amore
accuratemask (lower point spacing value) and better encode performance (higher point spacing value).

Generally, even values between 6 and 12 work best. By default, the point spacing value is 6.
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Cropping an image
Use the Image Crop tool to crop a region from any image in the Job List.

You can crop a raster image, a LiDAR point cloud, or amosaic.

NOTE: When you open the Crop window, the image will start to preview automatically. If the preview is taking
too long, you can cancel the preview and proceed to enter cropping coordinates manually. To restart the
preview, close and re-open the Crop window.

A. Home: Center and scale the preview to fit the window
B. Pan: Click and drag the image within the window
C. Zoom In: Click within the image to zoom in on a point
D. ZoomOut: Click within the image to zoom out from a point
E. Crop: Drag a new crop region on the preview image
F. Select features: Click polygons to include in the output image when cropping using a vector file
G. Crop method: Choose a croppingmethod from the pop-upmenu
H. Resize handles: Drag an edge handle in or out to size the crop area
I. Move handle: Drag the center area to reposition the crop area
J. Crop edit: Depending on the croppingmethod, you can edit specifics about the crop in this space

Cropping method
There are three ways to crop an image:

l Rectangle - Corner Points
l Rectangle - Center Point
l Vector file (only available for raster images)
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Rectangular cropping

For cropping by rectangle, you can use the Crop tool to drag a rectangle on the preview image, then resize
the crop, or you can enter precise coordinates for cropping.

For Corner Point cropping, you specify the coordinates of the top left and bottom right corners of the cropping
rectangle.

For Center Point cropping, you specify the horizontal and vertical (X and Y) coordinates of the center of the
cropping rectangle, and its height and width.

For raster images, you can enter geospatial or pixel coordinates. LiDAR images have no pixel data, so you can
only crop using geospatial coordinates.
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LiDAR cropping
When you crop a LiDAR point cloud, you also have the option to crop elevation values.

This can be useful if trying to remove unwanted imagery (birds, for example), or if you are trying to extract only
points within a certain elevation range.

Check the box labeled Crop elevation values, then set the elevation range (Z min and Z max) for the output
image.

Although the range selection is not shown in the preview image in the Crop dialog, it will be reflected in the Output
Preview panel.
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Vector file cropping
For raster images where you also have access to a vector file describing one or more regions of the image, you
can use this file for cropping to include only specific regions.

NOTE: Cropping by vector file is not supported when the output format is JPEG 2000 and the input image has
multiple bands.

Click Browse to select a vector file (.shp or .kml) to load.

The list at the left of the Crop window shows shape regions within the vector file; the header of the second column
includes a pop-upmenu where you can select information from the vector file to display.

The preview shows the defined shapes outlined in red; selected regions are filled with green.

Select one or more regions in the list, or click the Select features tool and select multiple regions within the
preview image.

(To select more than one region in the list or in the preview, hold down the Ctrl key while you select areas. You can
also click and drag within the preview image to select all regions within an area.)
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Crop output options
You can specify whether the cropped output file includes only data within the selected shape regions, or includes
all data within the rectangle that encompasses all selected shape regions.

If you select multiple shape regions, you can also choose whether the output is comprised of one file with all
selected regions, or multiple files, each containing the cropped content from one shape region.

If you choose themultiple image option, images are saved using the naming convention <output file
name>_<column label>_<polygon ID>.

For example, if you select KingCounty as the output file name, and the shapefile polygons have a column for
CityName, one of the output files would have the name KingCounty_MercerIsland_37.sid.

NOTE: If you crop existingMrSID and JPEG 2000 images but do not compress the images again, you do not
use data from the data cartridge.
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Area of Interest
What is an Area of Interest?
The Area of Interest (AOI) encoding feature enables image customization through the preservation or obscuring of
detail. AOI enables you to define one or more areas within an image or mosaic and encode these areas at a higher
or lower compression ratio than the remainder of the image. Using AOI thus creates a visual contrast between the
area(s) of interest and the surrounding image, rendering either “sharper” (lower compression) areas or “blurred”
(higher compression) areas. In the image below we’ve drawn a rectangle around an area that has been defined as
an Area of Interest and compressed at a lower ratio than the rest of the image. Note that more detail is preserved
within that area.

GeoExpress offers threemethods of encoding an Area of Interest: the weight, shift andmask methods.
GeoExpress enables you to encode an Area of Interest in MG3, MG4, or JPEG 2000 format. When the output
format selected is JPEG 2000, any method can be used. MrSID encoding requires the weight or mask method.

For more information about using thesemethods, seeMG3 andMG4Area of Interest encoding on page 55 and
JPEG 2000 Area of Interest encoding on page 55.

Although Area of Interest is a simple concept, there aremany factors that come into play when generating both the
preview and the final encoded image in an Area of Interest operation. Some of these factors are:

l the relative size of the selected area in relation to the entire image
l the difference between the two compression ratios applied (inside and outside the selected area)
l the presence or addition of a crop operation in conjunction with an Area of Interest encode
l the desired output format (MG3, MG4, or JPEG 2000)
l the complexity of the imagery beingmanipulated

Some of the effects that a user may experience as a result of these factors are:
l slight bleeding of the AOI resolution into the surrounding image
l “outside” area seems less compressed than expected given the specified compression ratios
l Area of Interest specified as lossless is not always numerically lossless for some encode scenarios (this
variation is greater in JPEG 2000 encoding than inMrSID encoding).
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Defining an Area of Interest
Youmay define an Area of Interest in GeoExpress by vector overlay or by drawing a single rectangle. GeoExpress
allows you to define an Area of Interest in MG3, MG4, and JPEG 2000 encoding.

Vector overlay support enables you to includemultiple Areas of Interest within a single image.

1. Select a job in the Job List
2. Click the Area of Interest button on the toolbar.

This opens the Area of Interest dialog.
3. To view the image while setting Area of Interest parameters, click the Show Image button.

Drawing a single rectangular Area of Interest
A single rectangle can be used to express an Area of Interest either as the foreground or background (see Inner
andOuter Areas on the facing page).

You can define a single rectangle either by entering values for offsets or by drawing a rectangle across the image
with the Draw Area tool.

NOTE: The Draw Area tool will only be available if you display the image preview.

To enter numerical values to define a single rectangular Area of Interest:
1. Access the Area of Interest dialog as described above.
2. Select the User Defined Rectangle option.
3. Enter values for the Top, Right, Bottom, and Left offsets.
4. Select other desired parameters and click OK.

To use the Draw Area tool to define a single rectangular Area of Interest:
1. Access the Area of Interest dialog as described above and click Show Image.
2. Select the User Defined Rectangle option.
3. Click the Draw Area icon above the image window.
4. Click and drag on the image to define a rectangle.
5. Adjust the shape and size of the rectangle by clicking and dragging the “handles” at the sides and corners;

adjust its position using themiddle handle. Offset or other positioning values are automatically filled in.
6. Select other desired parameters and click OK.

Using vector overlays to define Areas of Interest
GeoExpress supports vector overlays of Esri Shapefile (*.shp), MapInfo TAB (*.tab), andGML version 2
(*.gml) formats. Vector overlays must be in the same coordinate system as the input image file andmust contain
closed polygons in order to be valid. GeoExpress uses all valid shapes within the active layer as the combined
Area of Interest; individual shapes within the active layer cannot be turned on or off.

NOTE: The use of GML-formatted vector overlays can result in the creation of files with a .gfs extension in
the directory on your computer where the GML files are stored. These are not used again andmay be ignored or
deleted.

Area of interest options set by the user apply to all shapes in the active layer.

Vector overlays are not editable within GeoExpress.
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To use a vector overlay to define an Area of Interest:
1. Access the Area of Interest dialog as described above.
2. Select Vector Overlay File.

A panel of vector overlay options appears in themiddle of the dialog.
3. Enter a file path in the Vector Overlay File field or click Browse.
4. Select an active layer from the drop-down list if necessary. GeoExpress supports only a single layer of a

given vector overlay. By default the first layer is selected.
5. Select any other desired parameters and click OK.

To remove a currently listed vector overlay, click Remove Vector Overlay File.

If you use a vector overlay to define an Area of Interest and select the Show Image option, the shapes will be
drawn on top of the input image in the image window. Filling in the shapes may give you a better idea of the areas
they define by displaying the shapes as solid polygons.

To fill in the Areas of Interest, select the Fill Shapes option below the image window.

To customize the outline color for the drawn shapes, click the Outline Color button. Set the line width for the
drawn shapes on the Appearance tab of the Preferences dialog.

Changing the outline color and line width has no affect on the resulting encoded image, and is only used for
previewing purposes.

Inner and Outer Areas
All regions inside specified Areas of Interest are called “foreground”. All surrounding regions are called
“background”. The Inner andOuter options correspond respectively to foreground and background and enable
you to choose which part of an image the AOI processing will affect.

In MrSID encoding, “inner” and “outer” are not specifically referred to except when using themask method, as
noted below. Either the foreground or background is given preference by the difference in weight between them as
specified by the compression ratio of the foreground and that of the area(s) of interest.

In JP2 encoding using the weight and shift methods, selecting either theWeight Inner or the Shift Inner option
preserves the quality of the foreground at the expense of the surrounding regions. Similarly, selectingWeight
Outer or Shift Outer preserves the quality of the background at the expense of the foreground.

Themask method renders either the foreground (by selecting theMask Inner option) or background (by selecting
theMask Outer option) as a solid color. Click Mask Color to select themask color for either of these options.
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Cropping with an Area of Interest
GeoExpress is designed to accommodate a workflow that demands a number of image customizations at a single
encode. Accordingly, it is possible to crop an image and encode an Area of Interest at the same time. A useful
workflow would be to first define a crop region in an image and then define an Area of Interest.

To specify your Area of Interest in relation to an existing crop region:
1. Select an image on which you have already defined a crop region (see Cropping an image on page 46).
2. Choose Tools > Area of Interest.
3. Click Show Image.

The region you defined appears marked out in lines and labeled as the crop region.
4. Define your Area of Interest and encode.

You can specify an Area of Interest anywhere in the image, regardless of whether or not it is in the crop region.
Areas of Interest defined outside a crop region will not appear in the results for the cropped version of the image,
but this may be a desired effect since a project can be used for multiple operations.

In this illustration, an Area of Interest is being drawnwithin an existing crop region.
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MG3 and MG4 Area of Interest encoding
GeoExpress offers twomethods, the weight andmask methods, for encoding an Area of Interest with MG3 or
MG4 as the output format.

TIP: Area of Interest encoding of MG3 andMG4 images can be donemore quickly if the images were originally
encoded as optimizable. For more information, seeOptimizable on page 83.

NOTE: Area of Interest encoding inMG3 format automatically uses the 2-Pass optimizer, even if it has not
been selected on the Format-Specific tab of the Advanced Job Options dialog. For more information, see 1-
Pass or 2-Pass Optimizer on page 86.

The weight method
The weight method is the default for encoding Areas of Interest with GeoExpress. (This is not to be confused with
theWeight parameter in the Advanced Job Options.) The parameters for using the weight method differ
depending on the output format. MG3 andMG4 require the user to enter a compression ratio for the Area of
Interest.

GeoExpress calculates the resultant image filesize as part of the encoding process, taking into account the user-
defined compression ratios for inside and outside the Area of Interest. Selecting theWeight option enables you to
specify an encode ratio for the Area of Interest or select Lossless. The outside area will be encoded at the
compression ratio specified in the Job Options dialog. These ratios are used in a calculation of the overall image
compression.

The calculated filesize appears on the Job Properties panel for the image once you close the Area of Interest
dialog.

The mask method
Themask method renders either the foreground or the background as a solid color, completely removing the
underlying image data.

Themask method only applies to encode jobs and is not available for optimizations.

Tomask an area inside the AOI polygon (foreground), select Mask Inner.

Tomask a region outside the AOI polygon, select Mask Outer.
Mask color
To specify or change themask color, select either Mask Inner or Mask Outer, then click Mask Color. This
opens the AOI Mask Color dialog.

By default themask color is black. Black drives all pixel values to theminimum supported value (usually zero),
while white drives all pixel values to themaximum supported value (e.g. 255 for an 8-bit image). You can also
specify a custom 8-bit RGB color value.

To specify a custom 8-bit RGB color value, select the Custom option and fill in the red, green and blue values.
Reading the log file
The compression ratios for the inside and outside of the Area of Interest are reported in the GeoExpress log file
after you run the Area of Interest job. For more information on log files, see Viewing and using log information on
page 116.

JPEG 2000 Area of Interest encoding
GeoExpress offers threemethods, the weight, shift andmask methods, for encoding an Area of Interest (AOI)
with JPEG 2000 (JP2) as the output format. Also, the weight and shift methods can favor the “inner” or “outer” area
(for more information see Inner andOuter Areas on page 53).
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The weight method
In JPEG 2000 encoding the weight value controls the image quality of the foreground relative to the background or
vice versa: larger values will result in a higher quality foreground and a lower quality background, and smaller
values will result in less of amarked difference. (Note: a value of 1.0 will have essentially no AOI weighting
effect.)
Using the weight method
1. Click the Area of Interest button on the toolbar (or select Area of Interest from the Tools menu) to open

the Area of Interest dialog.
2. Define an Area of Interest by one of the followingmethods (for more information see Defining an Area of

Interest on page 52):

n using a vector overlay
n drawing or entering values for a single rectangle

3. Select Weight Inner orWeight Outer.
The Value field appears with the default value of 100.

4. Change the default value if desired.
5. If desired, choose a number of resolution levels to be included in the AOI process from the drop-down list.

The default is all levels, but youmay choose any number equal to or less than the number of resolution
levels the image includes (see Zoom options on page 75). For example, if the image is being encoded to
have five resolution levels, then youmay choose five or less and the default would be all five levels.

6. Click OK.

When using theWeight method, the actual boundaries of the region are defined by the extents of the codeblocks
within each resolution level. Because the spatial extent of the codeblocks varies by level, the actual encoded
regionmay appear larger than the selected region, and a step-like fall-off in quality may be noticeable.

The shift method
The shift method is an alternative way to express the encoding of an Area of Interest when you select JP2 as the
output format. Rather than affecting the amount of quality in a codeblock at encode time, the shift mode adjusts
the “importance” of individual pixels by the specified shift amount. In other words, this function promotes the
importance (or sharpness) of the data inside or outside the Area of Interest (see Inner andOuter Areas on
page 53). The shift value to be specified is the number of bit positions to “promote” the foreground region over and
above the background. For 8-bit samples, an appropriate scaling factor would be 12. Images to be encoded with
large bit-depths and/or a large number of levels may, under certain conditions, require a higher value.
Using the shift method
1. Click the Area of Interest button on the toolbar (or select Area of Interest from the Tools menu) to open

the Area of Interest dialog.
2. Define an Area of Interest by one of the followingmethods (for more information see Defining an Area of

Interest on page 52):

n using a vector overlay
n drawing or entering values for a single rectangle

3. Select Shift Inner or Shift Outer.
The Value field appears.

4. Enter a shift value.
5. If desired, choose a number of resolution levels to be included in the AOI process from the drop-down list.

The default is all levels, but youmay choose any number equal to or less than the number of resolution
levels the image includes (see Zoom options on page 75). For example, if the image is being encoded to
have five resolution levels, then youmay choose five or less and the default would be all five levels.

6. Click OK.
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The differences between the twomethods are subtle and technical; we recommend that the weight method be
used unless large quality differences are desired. While the shift method does not suffer the stepping effects of the
weight method, it affords less granularity of control between foreground and background. The weight method is
enabled by default.

Although with practice and experimentation the shift mode can be used to completely mask out a desired region,
its purpose is “obscuring” areas of an image rather thanmasking them out. It is recommended that you use the
Mask method if you wish to achieve amasking effect (for more information see Themask method on page 55).

The mask method
Themask method in JPEG 2000 is the same as inMrSID Area of Interest encoding. See Themask method on
page 55.

Number of AOI levels
This parameter controls the number of resolutions levels subject to the Area of Interest encoder process in the
shift and weight methods; this can be used to alleviate the “stepping” effect mentioned above. When “Number of
AOI Levels” is set to less than the total number of levels in the image, the lower-resolution levels will not undergo
AOI processing; in this way, only the N highest resolutions are affected, so the icon image (and potentially other
lower-resolutions) will appear as if no AOI had been selected.

For information on viewing the results of encoded Areas of Interest, see Reading the log file on page 55.
Notes on AOI encoding and JPEG2000
When using theWeight method for Area of Interest encoding with JPEG 2000, it is recommended that you use a
smaller codeblock size, such as width = 32, height = 32. This parameter can be set on the Format-Specific tab of
the Advanced Job Options dialog (see Advanced JPEG 2000 options on page 88).

The overall compression ratio chosen for the encode job can be as important to the appearance of the region as the
actual weight or shift values chosen. The image quality at a given compression ratio may diverge dramatically
from expected results when AOI encoding is enabled. Getting the desired effect in JPEG 2000 Area of Interest
encodingmay require a trial and revision process.

Area of Interest scenarios
Increased visual quality in Area of Interest
A city government has an area that will be under construction with a new housing development. The contractor
needs access to high-quality imagery in the construction zone. The contractor will need the remainder of the
imagery at a lower quality in order to overlay existing roads, etc. The city has an existing composite MrSID
Generation 3 (MG3)mosaic of MrSID imagery created from 100 smaller MG3 images compressed at a ratio of
20:1. The city will import a vector overlay that outlines the area of construction and would like to specify a lossless
compression ratio in this area (i.e. no additional loss after original 20:1 compression) and an additional 20:1
compression for the remainder of the image in order to reduce the file size of the deliverable and still meet the
contractor’s needs.

Decreased visual quality in Area of Interest
The United States Department of Defense (DoD), as ameasure against terrorism, requires that imagery over the
nation’s Capitol building andWhite House inWashington, DC, not be delivered in high resolution. In the past data
providers have downsampled those areas of the images andmosaicked them back together, which can be time
consuming. A data provider would like to load themosaic of original TIFF files into GeoExpress, select a region,
apply a 100:1 compression ratio over the selected region and 20:1 compression for the remainder of themosaic.
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Areas of Interest defined for faster viewing
A Paris city employee working in the field with low bandwidth wants to view an extremely large image of Paris
online through a viewing application. She is only interested in the portion of the image that shows the Eiffel Tower.
If that portion of the image has been defined as an Area of Interest, it can be given display priority so that area
appears sooner, becoming crisp and clear before the rest of the image.

Color balancing
The Color Balance tool
UseGeoExpress to perform color balancing operations for raster images when you select MG3, MG4, or JPEG
2000 as the output format. You can color balance 8-bit and 16-bit unsigned grayscale and RGB images. You can
also color balancemosaics andmultiple images at a time. There are three types of corrections that you can
apply: uniform corrections, non-uniform corrections, and automatic corrections.

For information about color balancing andmosaics, see Performing color balancing for amosaic on page 101.

For information about color balancingmany images at a time, see Batch color balancing on page 60.

Uniform corrections
Uniform corrections affect the brightness and contrast of all pixels in the sameway, so light spots will still be light
and dark spots will still be dark regardless of the corrections that you apply.

In the Uniform Corrections tab, select the bands for which you want to perform corrections and use the sliders to
adjust gamma, brightness, and contrast values.

You can apply uniform corrections to single images andmosaics.

Non-uniform corrections
You can only apply non-uniform corrections tomosaics.

Non-uniform corrections adjust the color values of specific portions of eachmosaic tile.

When you combinemultiple images with similar imperfections, the flaws become very noticeable.

To correct these patterns across amosaic, use non-uniform corrections.

There are three types of non-uniform corrections:
l Vignette correction. Corrects color inconsistencies caused by a camera lens. Use vignette correction
when your images display a lower light intensity around their edges. The correction automatically
normalizes the highlights and dark spots across tiles to create amosaic that appears more unified. Vignette
correction affects all the tiles in themosaic.

l Tilt correction. Corrects bidirectional reflectance. Bidirectional reflectance describes the effect of the angle
of the sun on an image. Use tilt correction when the images in amosaic were all taken under similar lighting
conditions. For example, your images may be darker on one side than the other. When you apply tilt
correction to all the tiles in amosaic, GeoExpress matches the color levels of each tile in themosaic. Tilt
correction affects all the selected tiles in amosaic.

l Seam line correction. Corrects discrepancies in the edges of tiles in amosaic. Use seam line correction to
smooth the transitions between tiles. Depending on the geometry of a givenmosaic, sometimes seam lines
cannot be generated. In that case, the Apply Seam Lines option is unavailable. Seam line correction
affects all the tiles in amosaic.

NOTE: Tilt correction is computationally intensive. If there aremany tiles in themosaic, both the preview and
themosaic jobmay takemore time to process.

Automatic corrections
Automatic corrections adjust the color values of multiple images or mosaic tiles to match another image.
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You can apply automatic corrections to single images andmosaics. If the corrections are going to be applied to
multiple images, all the images must have the same number of output bands and the same data type. If you select
Duplicate job parameters, this also applies to the image whose color corrections you want to match.

The following list describes the automatic correctionmethods that you can use:
l Match tiles to each other. Mosaics only. Sets the intensity of each tile in amosaic to match the average of
all tiles.

l Match to a selected tile. Mosaics only. Sets the intensity of the tiles that you select to match the color
levels of a source tile that you specify. To specify a source tile, select a tile in the tile list and click Set
Selected Tile As Source Tile in the Automatic Corrections panel. Then, select the tiles in the tile list to
which you want to apply the corrections and click Apply Corrections.

l Duplicate job parameters. Matches the color balancing corrections applied to another image in the Job
List. If you have not applied color balancing corrections to another job yet, GeoExpress displays a blank
pane. Use this option to quickly apply color balancing corrections tomany images at a time.

l Match to histogram. Matches the histogram values of another image that you select. GeoExpress
calculates histogram values for the image that you select, including brightness, contrast, gamma, and
more, thenGeoExpress attempts to apply those values to the current image.

Color balancing an image
1. Select a single job from the Job List.
2. Click the Color Balance button on the toolbar.

This opens the Color Balance Manager.

3. From the Band drop-down list select a band or Intensity.
For grayscale images, only one band is available. Select an individual band tomodify it individually or select
intensity to modify all bands.

4. Make changes to histogram values by entering new values into theMin, Max andGamma fields, or click
and drag the slider controls below the histogram.

5. Click OK.
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Batch color balancing
To perform color balancing for many images at a time, youmust first set the color balancing corrections that you
want to apply to a single image. Then, you can apply those corrections to all the remaining images.

1. Add all the images that you want to color balance to the Job List.
2. Select one of the images from the Job List.
3. Click the Color Balance button on the toolbar.

The Color Balance Manager appears.
4. From the Band drop-down list select a band or Intensity.

For grayscale images, only one band is available. Select an individual band tomodify that band, or select
Intensity to modify all bands.

5. Make changes to histogram values by entering new values into theMin, Max andGamma fields, or click
and drag the slider controls below the histogram.

6. Click OK.
7. Select the remaining images that you want to color balance from the Job List.

Hold the Shift key to select a range of images.
8. In the Automatic Corrections panel, select Duplicate job parameters from the drop-down.

The first image to which you applied color balancing corrections appears in a list below the drop-down.

NOTE: The list only displays images to which you have applied color balancing corrections, and which
have the same number of bands and the same data type as the images that you selected in the Job List.
Additionally, the list does not display mosaics to which you have applied corrections, only single images.

9. Click the first image to which you applied color balancing corrections.
10. Click Apply Corrections.
11. Click OK.
12. Click a blank section in the Job List to ensure that no jobs are selected.
13. Click Run All Jobs.

Histogram values
GeoExpress displays the histogram for an image on the left side of the Color Balance Manager. The histogram
control enables you to adjust theminimum, maximum, and gamma values for each band in the image.

The black slider represents theminimum pixel value, the white slider represents themaximum pixel value, and the
gray slider represents the gamma value. The range of values for theminimum andmaximum controls is based on
the data type of the image. For example, for 8-bit images, the range of values is 0 through 255. Themaximum
value cannot be less than or equal to theminimum value.

The gamma slider is restricted to a fractional position in between theminimum andmaximum sliders. The range of
gamma values is 0.102–9.99. The default value of 1.0.

The histogram controls adjust dynamically as the brightness and contrast values are changed.

To revert back to an image’s original state, removing all color corrections, click Reset All Corrections.

Brightness and contrast
Below the histogram control are two slider controls for modifying the brightness and contrast of the active band of
the image. They accept integer values from -100 to 100.

The histogram controls adjust dynamically as the brightness and contrast are changed.

Live updating
The Enable Live Updating option controls how the preview image is updated. If Enable Live Updating is
enabled, the image will update in real time as youmanipulate the slider controls. If the update performance starts
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to slow down, as it may for very largemosaics, you can disable the live updating feature so that the image only
updates after a dragging operation is complete (i.e. when themouse button is released).

Mapping RGB bands
The Band Selector button allows you to rearrange the red, green, and blue bands for viewing in the Color
Balance Manager. You can select one band to represent the grayscale band.

1. In the Color Balance Manager, click Band Selector.
This opens the Band Selector dialog.

2. Select RGB to select RGB bands or select Grayscale to select a grayscale band.
3. Click OK.

NOTE: Selecting bands in the Band Selector dialog has no effect on the order of output bands.

Reprojection
What is reprojection?
Reprojection is changing the projection of an image from one coordinate reference system (CRS, sometimes also
called spatial reference systems or SRS) to another.

A coordinate reference system defines the location of a point on a planar or spherical surface. An example familiar
to many people is a graph with x and y axes. A geographic coordinate system is a three-dimensional reference
system that locates points on the Earth’s surface based on projections. Projections are themethod used to
display a spherical surface onto a flat surface. In this manner, Cartesian coordinate systems can be overlaid.

Coordinate reference systems are prearranged projections used in specific countries either in modern times or in
historical maps. However, many states and counties within a country may employ a different coordinate reference
system. These reference systems differ in order to maintain the highest accuracy in a smaller defined region.
Because they are only approximations of the shape of the Earth—which is irregularly shaped—the larger an area a
given coordinate system covers, the less accurate it will be.

An agency working on a broad area of coverage, such as statewide, will typically work in the UTM (Universal
TransverseMercator) system, since it can be used over larger geographic areas. Organizations whose Area of
Interest covers a smaller geography, such as county or city level management, will typically work in a State Plane
coordinate system. This presents problems when trying to employ data from different sources for use in a single
project.

The reprojection tools in GeoExpress enable you to take images that are georeferenced in one or more coordinate
reference systems, and reproject these images to a different coordinate reference system either individually or as
amosaic. CRSs are identified by regions of use, subregions and system names as defined by the European
Petroleum Survey Group (EPSG). You can also use well-known text strings (WKTs).

You can repurpose and combine diverse data sets by using the GeoExpress reprojection tools when you create a
new image or by reprojecting your existing images. With support for over 2,500WKT (well-known text) coordinate
systems such as State Plane Coordinate Systems and UTM—as well as hundreds of specific regional
projections—GeoExpress enables geospatial professionals to share imagery across boundaries previously
imposed by disparate coordinate reference systems.
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As an example, say you have a shapefile using a coordinate reference system of Latitude/Longitude, WGS84,
while the raw imagery you purchased from an image data provider is created in UTM, NAD83, Zone 18N. Using
the reprojection feature in GeoExpress, you are able to reproject the raw imagery to the Lat-Long coordinate
reference system while converting it to MG3, MG4 or JP2 format within your normal encoding workflow.

NOTE: Reprojection necessarily involves encoding since pixel data cannot be altered in compressed wavelet
space.

Reprojecting an image
To reproject an image, youmust set a coordinate reference system (CRS) for the source image and for the output
image. You can reproject images to theMrSID Generation 4 (MG4), MrSID Generation 3 (MG3), JPEG 2000, and
NITF 2.1 output formats.

1. Click the Reproject button on the toolbar.
This opens the Reprojection Manager dialog.

2. If the Source File has a knownCRS, then that CRS is displayed.
If you need to set or change the CRS, select one using the Projection pop-upmenu.
Initially, themenu lists recently-used projections. Use the search field at the top of the listing to narrow
down a long list.
If you need to use a different projection:

a. Click Full Search to open the Set Projection window.
b. Use the Projection Source pop-upmenu to choose a list of standard projections.
c. Choose a projection, then click Set Projection. Learnmore

3. To set the projection for the Output File, choose one from the Projection pop-upmenu.
4. Click Advanced to set additional reprojection options.
5. Click OK.

NOTE: When you reproject an image, you affect the image’s pixel data. As a result, you should always
reproject an image before you perform other imagemanipulation operations, especially cropping or defining an
Area of Interest.

IMPORTANT: Since a coordinate reference system works in two dimensions (X and Y), GeoExpress does not
alter the vertical (Z) coordinates of LiDAR point clouds during reprojection. This generally won’t be a problem,
since the vertical location of a point should not change during reprojection.
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Selecting a coordinate reference system
You can set a coordinate reference system for an image or mosaic by reprojecting the image or by editing its
metadata.

You can select an existing projection or create or import a customWell Known Text (WKT).

To select a projection:

1. Select a subset of available projections from the Projection Source pop-upmenu.
2. To filter the list of available projections, type one or more substrings from the projection name into the

search field, separated by spaces. For instance, type pola na to quickly display the “WGS 84 / EPSG
Canada Polar Stereographic (5937)” projection.

3. Click Set Projection.

To import aWKT:

1. Choose Custom from the Projection Source pop-upmenu.
2. Click Import, choose the .wkt or .prj file, then click Open.
3. GeoExpress will display the imported file and report if it is not valid.

If theWKT is not valid, you can edit it, delete it, or cancel the Set Projection operation.
4. To change the name of theWKT as displayed within GeoExpress, click once in its name in the list on the

left and type a new name.
5. Click Set Projection to accept and select the importedWKT.

To save the importedWKT without setting it, click Save, then click Cancel in the Set Projection dialog.

To create a customWKT:

1. Choose Custom from the Projection Source pop-upmenu.
2. Click New.
3. Enter the text for theWKT. GeoExpress will validate the text as you type and display its validity.

If you do not want to keep theWKT you have created, you can delete it or cancel the Set Projection
operation.

4. To change the name of theWKT as displayed within GeoExpress, click once in its name in the list on the
left and type a new name.

5. Click Set Projection to accept and select the new WKT.
To save the customWKT without setting it, click Save, then click Cancel in the Set Projection dialog.

NOTE: For information on how to create aWKT, see the OpenGeospatial Consortium (OGC) spec # 01-009 at
http://www.geoapi.org/3.0/javadoc/org/opengis/referencing/doc-files/WKT.html. For a listing of common
WKT strings, see http://www.spatialreference.org/.

To delete a custom or importedWKT:

1. Open the Set Projection dialog.
2. Select Custom from the Projection Source pop-upmenu.
3. Select aWKT in the list on the left.
4. Click Delete. In the confirmation dialog, click Yes.
5. Click Cancel in the Set Projection dialog, then click Cancel in theMetadata Manager or Reprojection

Manager window.
This way, you do not inadvertently change the projection for the selected job.

http://www.geoapi.org/3.0/javadoc/org/opengis/referencing/doc-files/WKT.html
http://www.spatialreference.org/
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Advanced reprojection options
Resolution
To specify the output resolution of the reprojected image, select Set output resolution and enter the x and y
values in the edit fields. If this option is disabled, GeoExpress calculates the output resolution when it performs
the reprojection.

WARNING
n This parameter has beenmade configurable in the event that experienced users require adjustments.

However, adjusting the output resolution can have far-reaching effects and it is recommended that you
allow GeoExpress to calculate it for you.

n If you set the resolutionmanually and notice that the image is offset, select Align pixels with output
resolution. This option aligns the output image to an integer multiple of the output resolution.

Error fraction
The error fraction is a value from 0.0 to 1.0 that indicates the level of accuracy of the reprojection. A value of 0.0 is
the highest level of accuracy—essentially a “lossless” reprojection. An error fraction of 0.125means that each
reprojected pixel could be off by an eighth of a pixel, while a value of 0.25 indicates a quarter-pixel inaccuracy.

Block value
Block values tell the encoder to reproject the pixels in blocks of dimensions the user may specify.

NOTE: These blocks are different from both theMG2 and theMG3/MG4 encoding blocks.

Using block values improves disk access andmemory usage and can improve performance. Smaller block values
use less memory but may be slower. Block values do not affect the output image.

By default the block value is 2048.

Resample Method
The Resample Method drop-down list shows the available resamplingmethods for the reprojection operation.
Nearest Neighbor is the fastest method, while Bicubic gives more accurate results. Bilinear is a compromise—
faster than Bicubic andmore accurate than Nearest Neighbor.

Use Temp Files
If you enable the Use Temp Files option, the encoder caches the reprojection processing blocks to disk in the
form of a temp file instead of keeping them in RAM.

This option is enabled by default.

Image reprojection scenarios
NOTE: The process of rendering previews for very large images or mosaics can be time consuming, especially
when reprojectingmosaicked images in different resolutions and coordinate systems. Previewing does not
decrement the data cartridge.

Single image reprojection workflows
Reprojection of single TIFF images
A user has a set of 500 images in TIFF format with TIFF world files and wants to put each single image into a new
coordinate system and encode toMrSID at the same time. The user adds the images into the Job list.
GeoExpress knows where they are located (due to the world files) but knows nothing about the coordinate
reference system (CRS). The user assigns a coordinate system to the source images to be used as a source
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CRS. The user can select multiple files and apply the CRS once to all of the source data. Then the user selects
the destination CRS that will apply to all images in the current selection. The user specifies other compression
parameters independent of the reprojection option, then encodes the images normally.
Reprojection of singleMG2 images
Same as “Reprojection of Single TIFF Images” above, except that the user has MrSID Generation 2 images with
sdw files.
Reprojection of MrSID imageswith embeddedGeoTIFF
Same as “Reprojection of Single TIFF Images” above, except that the user has MrSID files with embedded
GeoTIFF tags. GeoExpress automatically reads thoseGeoTIFF tags to determine the source coordinate system.
Reprojection of GeoTIFF images
Same as “Reprojection of Single TIFF Images” above, except that the user has GeoTIFF files. GeoExpress
automatically reads the CRS and assigns it as a source CRS.

Mosaic Reprojection Workflows
Mosaicking single imageswith the sameCRS and reprojection to new CRS
The user is a provider who has many GeoTIFF images in the sameCRS (UTM). The user wants tomosaic these
together and reproject them to the State Plane system. In this instanceGeoExpress reads the CRS from the
images andmosaic prior to reprojection to ensure a seamless mosaic.
Reprojection of UTM, State Plane and Lat-Long together in a singlemosaic
A city government has received images in UTM from the NAIP program, has existing imagery in state plane
coordinate system and has purchased satellite imagery in lat-long. The imagery from NAIP is a one-foot-pixel, the
city’s imagery is a half-foot pixel and the satellite imagery is a five-meter pixel. The NAIP imagery is in MrSID
format, the city’s data is in GeoTIFF and the satellite imagery is in TIFF with TIFF world files. This user can create
a single MrSID mosaic in State Plane coordinates from all three sources of imagery in one single encode
operation.

Raster job options
The following list describes some of the options that you can set for raster images andmosaics:

l Select an output destination.
l Select an output format and compressionmethod.
l Select custom dimensions and resolution.
l Select tiling options.

NOTE: For raster images, you can also click Advanced on the Job Properties panel to set additional options.
For example, you can use the advanced options to select a color space, edit transparency values, andmore.
For more information on advanced job options, see Advanced job options on page 69.

Destination options
Use the Destination tab to save output files to a file on your computer or to an Express Server. You can only save
MrSID and JPEG 2000 images to Express Server.

To select an output destination:
1. Select one or more jobs in the Job List.
2. Click Job Properties.
3. Enter a file path in the output destination field, or click Options: Basic and select Publish to Express

Server.
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Selecting an output file
By default, the output directory is the same as the input directory.

To change the default output directory, see Preferences on page 106.

Selecting an Express Server
GeoExpress 10 supports Express Server version 6.0 and later. You can save images in the following output
formats to an Express Server:

l MrSID Generation 4
l MrSID Generation 3
l MrSID Generation 2
l JPEG 2000 (Part I)
l JPEG 2000 (GMLJP2)

If you select Publish to Express Server on the Job Options dialog, youmust still specify a file path on the
Destination tab. GeoExpress uses the directory that you specify as a temporary directory where it saves the
output file before publishing to Express Server.

When you select Express Server as the output destination, the Express Server Browser opens.

1. In the Express Server Browser, enter the URL of the Express Server where you want to save files. You
can also click the drop-down box to view the list of Express Servers to which you have recently connected.

2. Click Connect.

NOTE: The server is queried for a list of catalogs on the server. Catalogs that have a spatial index

appear with the world map icon and the EPSG code of the spatial index. If there are no catalogs on the
Express Server, contact the server administrator.

3. If the Express Server requires authentication, it will prompt you to enter your user name and password.
Enter them, then click OK.

4. Select the catalog to which you want to save your files.

NOTE: The output images that you createmust use the same spatial reference system as the target
catalog.

5. Optionally, select Replace existing files to overwrite files in the catalog that have the same name.
If files with the same name exist and this option is not selected, the upload fails and reports that the file
exists.

6. Click OK.

Format and compression options
Use the Format and Compression tab to select an output format and compressionmethod.

For more information about output formats, see Supported output file formats on page 123. For more information
about compression, see Features in Depth on page 30.
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Dimensions and resolution options
Use the Dimensions and Resolution tab to change the dimensions of an image or select a custom resolution.

You can select from the following dimensions:
l Full resolution. Use the native resolution of the input image. This option is the default.
l Print. Scale the image so that the resolutionmatches that of a typical printer.
l Medium. Scale the image to either 2048 pixels wide or 2048 pixels high depending on the orientation.
l Web. Scale the image to either 512 pixels wide or 512 pixels high depending on the orientation.
l Custom. Enter a custom width and height, or enter a custom resolution.

Tiling options
Use the Tiling tab to break the output image intomultiple tiles.

The following list describes the tiling options that you can select:
l No tiling. Create a single output image. This option is the default.
l Number of tiles. Break an image into a number of columns and rows that you specify. For example, if you
select four columns and three rows, the job creates 12 images.

l Tile by units. Break an image into tiles based on the geospatial units of the image. For example, if the
image is in a UTM projection, the unit is meters and you can create tiles 1000meters wide by 1000meters
high.

l Tile by pixel area. Break an image into tiles such that each tile has the width and height that you specify.
For example, youmay want to create square tiles that are 2048 by 2048 pixels.

LiDAR job options
Some of the options that you can set for LiDAR images andmosaics include:

l Enter a custom block size.
l Omit LAS variable length record (VLR)metadata.
l Columnmapping options for text files.

LiDAR compression options
Use the Compression tab to change the block size and remove variable length record (VLR) metadata from
LAS files.

The block size is the number of points that GeoExpress processes and stores at one time. Enter a large block size
to increase compression speed. Enter a small block size to decreasememory usage. Valid values are from 2048
to 16384. The default value is 4096.

If you select the Omit Custom LAS VLR metadata option, GeoExpress removes VLR metadata from LAS files.
VLR metadata can include vendor-specific data, user-specified data, andmore.

LiDAR text parsing options
Use the Text Parsing tab of the Job Options dialog tomap text file columns to standard or custom fields and to
load the whole text file. GeoExpress prompts you to set these options automatically when you add a LiDAR text
file. At aminimum, youmust map the X, Y, and Z columns of a file.

Header Lines
LAS files often contain header lines with the names of the columns and additional information. Enter the number of
header lines are in the file so that GeoExpress does not attempt to read those lines as valid values.

Column Mapping
Use the drop-down boxes for each column tomap values to standard fields like X, Y, Z, Intensity, andmore.
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Custom Fields
Create, edit, and delete custom fields that you want to map to columns. For example, youmay want to create
fields for a custom GPS time format or for sensor information.

Precision Factors
When a job is run, each number in the data columns is represented by an offset and the default precision factor of
0.001. The Precision factor fields enable you to change the factor by which the data in any or all three axis
columns will be represented to account for the number of significant decimal places in those columns.

Reading the Whole File
If you select this option, GeoExpress reads the whole text file to determine image properties like the extents. You
must select this option if you want to preview the LiDAR point cloud.

Column Mapping Prompt
Select the Prompt me to map columns every time option to display these text parsing options every time that a
text file is added.
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Advanced job options
Advanced job options overview
For raster images, you can click Advanced on the Job Properties tab to select additional job options.

The following table describes some of the tasks that you can perform in each tab of the Advanced Job Options
dialog.

TAB TASKS

Input l Change the name of the selected job
l Use world files and aux.xml files to override the georeferencing information in the selected
image

l Apply image rotation from the image metadata
l Apply NITF RPC from the metadata

Output l Create a test output image
l Convert images to 8-bit
l Set a custom watermark for the selected image
l Create a shapefile representing the tiles used in a raster mosaic
l Crop a DOQ image with corner cross points
l Flatten a composite mosaic
l Enable multiresolution mosaics
l Enable mosaics with multiple coordinate reference systems
l Enable multiple image segments for NITF images

Bands l Select a color space for the image
l Select and map bands for the image

Zoom l Set the number of zoom levels in the output image
l Specify a target thumbnail size
l Resample the image

Alpha l Specify transparency values for MrSID Generation 4 (MG4) files
l Create or regenerate an alpha band

Transparency l Specify transparency values for JPEG 2000, MrSID Generation 2 (MG2), and MrSID
Generation 3 (MG3) files

Quanitization l Enter quantization options for floating point images
Quantization is the compression method for floating point images.

Security l Set password protection for MG2 and MG3 images

Format-Specific l Configure image encoding performance by changing the block size or strip height
l Configure the display of an image by changing the weight values and sharpness
l Generate dynamic range metadata
l Select and edit JPEG 2000 profiles

NOTE: The options available in the Advanced Job Options dialog depend on the output format that you
select.
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Input options

Enter a new Job Name to change the name displayed in the Job List.

Use the Override Georeferencing section to override a file’s native georeferencing information with information
from another file. The other file can be a world file or an aux.xml file included in the same directory as the image.
When georeferencing information for an image or mosaic tile is given in the form of a world file or aux.xml file,
GeoExpress can use that information to override the file’s native georeferencing. For more information on world
files, seeWorld files on page 118.

Use the Apply Metadata to Image section to change the output image based on information in the image
metadata. There are two types of metadata that you can apply: NITF RPC metadata and image rotationmetadata.
NITF RPC metadatamaps pixel data to location data for orthorectification. Image rotationmetadata describes
how to rotate the output image.

The Input Image section identifies whether the input image is a single image, amosaic, or a color composite
image, and lists the input file or files. Note that the job name can be different from the input file name and the
output file name. Also the job name is different from the project name that is displayed in the blue bar at the top of
the screen in the work area.

Output options
Set options for the output image in the Job Progress panel. The options that you see depend on the job type and
the output format.

Test image
You can create a test image from a single raster image or raster mosaic. This allows you to test an operation
without using data from the data cartridge.

Test images are output images that have a visible watermark.

NOTE: You cannot create test images from LiDAR point clouds.
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8-bit data
Convert unsigned 16-bit data to unsigned 8-bit data during encoding.

Watermark
You can add custom watermarks to your images. GeoExpress supports black and white watermark images in
BMP, PNG, and JPEG formats.

Click the Browse button to select the image that you want to use as a watermark. The following figure shows an
example of a watermarked image:

NOTE: In versions of GeoExpress before v9.5.3, watermark images were limited to 128 × 128 pixels in size.
Watermarks must be no wider and no taller than the output image.

Seamlines shapefile
You can choose to generate a shapefile that shows the tiles that make up a raster mosaic output.

If you create a raster mosaic, select this option to include a shapefile in the output. When viewed with the
appropriate program (such as GeoViewer), the shapefile will overlay the output image to indicate where each tile in
the image is located.

USGS DOQ Cropping
If the job contains DOQ images, the USGS DOQ Cropping panel will be available. Cropping is either by corner
cross or disabled.

Flatten
To flatten a composite mosaic, select the Create Flattened Mosaic option. When you flatten amosaic that
contains overlapping tiles, you discard the data from tiles that are not visible. For more information on composite
mosaics, seeMosaic output formats on page 98.

When you flatten amosaic, the Flatten Tile Size field is available. GeoExpress divides mosaics that are to be
flattened into tiles for encoding. Acceptable values are integers between 1024 and 4096, and powers of two (1024,
2048 and 4096) are recommended though not required. The default tile size is 2048.

NOTE: Youmay encounter irregularities in the progress meter when flatteningmosaics.
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Band options
Use the Bands tab to select a color space for the output image and to select andmap bands.

NOTE: For MG3 andMG4 files, the output color space is only supported for encoding single images and flat
imagemosaics.

Output color space
The options available in this group depend on which color space you choose from the drop-downmenu. For
grayscale or RGB output, another drop-downmenu enables you to select a single band or three bands,
respectively. For multispectral output, the Select Bands button appears enabling you to access a dialog where
you can select bands from your input image and order them for your output image. The default color space is
Same as source. For more information on selecting bands, see Selecting and mapping bands on the facing page.

TheMrSID Generation 4 (MG4) format supports multispectral color spaces, but to output amultispectral image to
MG2 orMG3 format, you need to select an output color space of grayscale, RGB, or CMYK, andmap bands to the
selected space.

For multispectral images, select Apply RGB Color Transform to First Three Bands if the first three bands in
your output list are Red, Green, and Blue in that order. (This option is enabled by default.)

If the first three bands are not Red, Green, and Blue, click the Select Bands button to re-order the bands. For
more information on the RGB color transform, see The RGB color transform on page 31.
Supported color spaces
The following table shows supported output MrSID color spaces for various input and output formats:

COLOR SPACE OF SOURCE
IMAGE SUPPORTED MRSID OUTPUT

SUPPORTED JPEG 2000
OUTPUT

Grayscale Grayscale Grayscale

RGB RGB, Grayscale RGB, Grayscale

CMYK CMYK, Grayscale —

Multispectral RGB, Grayscale, CMYK,
Multispectral

RGB, Grayscale, Multispectral
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Formultibanded output to MG4 and JPEG 2000, additional options on the Color Space drop-down are available,
most notably that amultispectral input image can use Same as source for the output color space.

NOTE: GeoExpress does not support the CMYK color space for JPEG 2000 images, either as input or output.
For source images that are CMYK, the only supported output color space for JPEG 2000 encoding is grayscale.
The preview input image color space controls remain the same.

With multispectral image support, it becomes necessary to provide color space control over the input and output
images so that they can be viewed by human eyes. TheOutput Color Space control shows a list of supported
output color spaces for the currently selected output format. The supported output color spaces for MrSID
Generation 3 (MG3) are grayscale, RGB, and CMYK. If the input image is already in one of the supported color
spaces, Same as source will also be an available option. By selecting an output color space other than Same as
source, a group of band selectors will become visible, allowing the user to choose which input bands map to the
output color space. If you chose RGB as your output color space, three controls would appear for choosing the
red, green, and blue component bands of the output image. Then you could choose which bands of the source
image weremost interesting or important to you, for example bands 1, 3, and 5.

If you want to encode a six-banded image toMrSID format, you should select MG4 as your output format.

Selecting and mapping bands
For raster multispectral images, you can select andmap image bands from a source image to aMrSID or
JPEG 2000 output image. Not all workflows are available for all output formats.

The following table shows which workflows each format supports.

SUPPORTED BY OUTPUT
FORMAT

WORKFLOW MG2 MG3 MG4
JPEG
2000

Choose one band from an RGB or multispectral source to represent the single
output (grayscale) band

Map any 3 bands from an RGB or multispectral source to the Red, Green, and
Blue output bands

Choose to carry over all source bands to your output image in their original
order

Map an arbitrary subset of bands (more than 3) from a multispectral image to
your output image, in any order

By default, GeoExpress retains all source bands in order.

The following procedures assume you have loaded one or more images into the Job List.

Selecting a grayscale band
You can select a single band for MrSID or JPEG 2000 output.

1. Select aMrSID or JPEG 2000 format from theOutput Format drop-downmenu.
2. Click Advanced in the Job Properties panel.
3. Click the Bands tab.
4. ChooseGrayscale from the Color Space drop-downmenu.

A drop-downmenu appears listing all the available bands in the source image.
5. Choose any single band from the drop-downmenu.
6. Set other options on this tab, then click OK.
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Selecting bands for RGB output
You can select andmap bands for RGB output in MG3, MG4, or JPEG 2000 format.

1. Select aMrSID or JPEG 2000 format from theOutput Format drop-downmenu.
2. Click Advanced in the Job Properties panel.
3. Click the Bands tab.
4. From the Color Space drop-downmenu choose RGB. Several drop-downmenus appear listing all the

available bands in the source image.
5. Choose any three bands from the drop-downmenus.
6. Click OK.

Retaining all source bands in order
You can carry over all source bands toMG4 or JPEG 2000 output formats in their original order.

1. Select MrSID Generation 4 or JPEG 2000 from theOutput Format drop-downmenu.
2. Click Advanced in the Job Properties panel.
3. Click the Bands tab.
4. From the Color Space drop-downmenu choose Same as source.
5. Set other options on this tab, then click OK.

Selecting and mapping bands for multispectral output
You can select andmapmore than three bands for MG4 output.

1. Select MrSID Generation 4 from theOutput Format drop-downmenu.
2. Click Advanced in the Job Properties panel.
3. Click the Bands tab.
4. From the Color Space drop-downmenu chooseMultispectral, then click Select Bands.

This opens the Select Bands dialog. By default, all bands are carried over from the input list to the output
list.

NOTE: The Alpha band is encoded losslessly and is not displayed in the list of bands. For more
information on Alpha bands inMrSID images, see Alpha band options on page 76. For more information
about Alpha bands in JPEG 2000 imagery, see Encoding with alpha bands in JPEG 2000 on page 94.

5. If the image contains red, green, and blue (RGB) bands, re-order the bands with the up and down arrows so
that these bands are at the top of the bands list, then select the option to Apply RGB Color Transform to
First Three Bands.

IMPORTANT: When you set the first three bands of the image as the RGB bands and apply the
RGB Color Transform, GeoExpress optimizes the image compression ratio of each one of the RGB
bands to create a smaller image without sacrificing visual quality.

For more information on the RGB color transform, see The RGB color transform on page 31.
This option is enabled by default for multispectral images.

6. Optionally, select the bands that you want to remove from the output image and click the left arrow to
remove them.

7. Click OK.

NOTE: For information on setting per-band compression ratios, see Specifying per-band compression ratios on
page 31.
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Zoom options
Use the Zoom tab to select the number of zoom levels that you want in the output image or to specify a target
thumbnail size. For anMG3 orMG4 file you can also resample the image.

The number of zoom levels in an encoded image can be specified directly or it can be dependent on the image size
in relation to a specified target thumbnail size. The larger the image, the greater the number of zoom levels it can
contain.

By default, GeoExpress does not specify the number of zoom levels but uses a thumbnail size of 32 pixels
instead. Youmay specify a higher value here, resulting in fewer zoom levels, or a lower value, resulting in more.
You can also specify a number of zoom levels or instruct the program to use themaximum number of zoom levels
the image can contain.

To specify the number of zoom levels, select Number of Zoom Levels and drag the slider or enter the number of
levels in the Zoom Level field.

Picture the encoded image as a pyramid, with each zoom level being sliced from the pyramid. The base of the
pyramid is level 0, themaximum resolution. Level 1 is half the size of level 0 with a preview image that has one
quarter the resolution of level 0. Level 2 is half the size of level 1, and so on to the final level, whose smallest
dimension is 2 pixels.

Zoom level can be set to any value greater than zero for MG3 andMG4 and from 3 through 9 levels for MG2.

NOTE: The full resolution (or base) image is called the zeroth level (0th level) and is not counted as one of the
zoom levels. For example, setting the zoom level at 3 will result in three additional resolutions besides the base
level. Setting the number of zoom levels to 0 will yield an output image with themaximum number of zoom
levels (the same as moving the Zoom Levels slider all the way to the right, or selecting the Use Maximum
Zoom Levels option.

To specify the target thumbnail size, select Target Thumbnail Size and enter a dimension in pixels.

To allow GeoExpress to automatically calculate and use themaximum number of zoom levels possible for an
image, select Use Maximum Zoom Levels for Image.

Resampling an image
Resample an image to reduce the number of zoom levels in anMG3 orMG4 image. Youmight resample an image
for placement in an online catalog where you know it will only be displayed at a certain maximum size.
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The resampling operation copies zoom levels from an existing image tomake a new image. As a result, you can
only resample images that meet the following criteria:

l The imagemust be in theMG3 orMG4 format.
l The output format for the imagemust be the same as the input format. For example, for anMG3 input
image, you can only create a resampledMG3 output image.

l The imagemust have been created as an optimizable image. By default, MG3 andMG4 images are
optimizable.

l The resampling operation cannot be combined with other imagemanipulation operations that require
decoding the image data. For example, you cannot perform reprojection or color balancing operations in the
same job as a resampling operation. Instead, resample the image, run the job, and then perform additional
operations on the new image.

To resample an image, complete the following steps:
1. Click Advanced in the Job Properties panel.
2. Click the Zoom tab.
3. Select the Resample image option and select the factor by which you want to reduce the level of detail.

Resampling by a factor of two removes one zoom level and halves the image’s width and height so that the result
has a fourth of the area of the original. Resampling by a factor of four removes two zoom levels and quarters the
image’s width and height so that the result has one sixteenth of the area of the original. The number of resampling
factors available in the drop-downmenu is determined by the size of the original image.

Alpha band options
When you select MG4 as the image output format, you can use the Alpha tab to create or regenerate alpha bands.
In MG4 images, the alpha band records which portions of your image do not contain image data.

For MG2, MG3, and JPEG 2000 files you can specify no-data values in the Transparency tab.

Alpha bands and MrSID
All images encoded toMrSID Generation 4 (MG4) have an alpha channel or alpha band. If one is present,
GeoExpress uses the alpha band in the input image. If no alpha band is present in the input image, then
GeoExpress creates one.

The alpha band is always encoded losslessly, even if the rest of the image undergoes lossy compression.

MG2 andMG3 do not support alpha channels, but the transparency information in the alpha band of your source
image is still preserved when encoding toMG2 andMG3. The alpha band will first be applied to the source image
and then discarded from the output file.



Chapter 5: Features in Depth

– 77 –

Examples
1:5@0,6:8@255
REMAINDER@0
1:255@0
1@127, REMAINDER@1

NOTE: For users of GeoExpress Standard Edition, the encoding of the alpha band does not additionally
decrement your data cartridge. Your encode job will bemetered the samewith or without alpha bands.

Creating an Alpha band
All images encoded toMrSID Generation 4 have an alpha band.

1. Click Advanced in the Job Properties panel.
2. Click the Alpha tab.
3. Select themethod that you want to use to create an alpha band.

n Opaque. TheOpaquemethod specifies that all pixels should be treated as valid image data.
n Transparency Value (metadata). Using this method, GeoExpress queries the imagemetadata for

the transparency values and treats all pixels with matching band color values as transparent. This is
the default.

n Specify Value. Youmay specify transparency values for each band. GeoExpress treats as
transparent all pixels whose band color values match the specified values. If you decide to specify a
value for each band, you can use the color picker.

If your source image already has an alpha band, you can select Regenerate Alpha Band to discard the existing
alpha band. By default, GeoExpress uses and preserves a source image’s alpha band. This optionmight be used
if your alpha band is corrupted or incorrect, in which caseGeoExpress creates a new one.

Despeckling output
Speckling is an artifact of lossy compression that causes pixels which should be transparent to display in the
output.

For example, youmay specify 0,0,0 as the alpha band values for an RGB image so that all of the black pixels are
made transparent. But in compression, the values of some pixels undergo slight changes in value. The difference
is not be visible to the eye, but a pixel whose RGB values are 0,1,0 or 0,0,1, while it may still look black, no longer
matches the specified transparency profile and so it will not be rendered transparent. Where this happens,
speckling can appear in the collar regions of an image such as a DOQQ. In this case, select Despeckle Output to
ensure that all of the pixels that should be transparent are treated correctly.

For more information and tomanually set despeckling options, see Despeckling on page 44.
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Transparency options
When you select MG2, MG3, or JPEG 2000 as the image output format, you can use the options on the
Transparency tab to define the color of transparency and background areas. One color must serve for both the
transparency and background values.

You can specify colors based on the color space (RGB/grayscale) and color depth (8-bit/16-bit) of the source
image.

Transparency and background color
The transparency and background color settingmust be within the range of pixel values that the image’s data type
supports (e.g. 0–255 for 8-bit images and 0–65,535 for 16-bit images). These values are derived from the native
metadata for an input image.

To select an alternate transparency and background color do one of the following:

l Enter RGB values for each band using the Edit Value field. Values can be assigned to single or multiple
bands.

l Select a color using the Color Picker.

The effects of the transparency options can be simulated in the Job Output panel.

NOTE: TheMG4 format stores transparency in an alpha band whereas MG3, MG2, and JPEG 2000 images
map transparency to a specific color. If your input image is in theMG4 format, and if the output format is MG3,
MG2, or JPEG 2000, transparency is mapped to the transparency color that you specify.

Color Picker
You can select an 8-bit RGB color value from the color palette or Color Picker if the source image is an 8-bit RGB.

1. Click Color Picker. The Color dialog displays 48 color options, including black and white. You can add
custom colors to the existing basic colors palette.

2. Select the proper color from the displayed palette.
3. Click OK.

GeoExpress uses the standardWindows color picker interface, which allows you to add custom colors. See your
Microsoft Windows or Microsoft Office documentation for more information about picking colors.

Specifying a transparency value in indexed color images
All images in theMrSID format are in either grayscale or RGB mode. Color images are RGB; black-and-white
images are grayscale. Any black-and-white image encoded by GeoExpress, if not already in grayscale mode, is
converted to grayscale; any color image, if not already RGB (for instance, an indexed color image), is converted to
RGB.
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To specify a transparency pixel value, determine the RGB value of the transparency area in the source image.
Most commonly, this will be black (0-0-0) or white (255-255-255). If desired, use a color-finder program to read the
transparency RGB values. Once the RGB values for the transparency area have been determined, they must be
enteredmanually.

The RGB color scale for an 8-bit image, with values of 0-255 for the colors red, green, and blue, is capable of
accurately displaying 16,777,216 colors. An indexed color image selects colors from a scale containing 256
colors. Each color in an indexed color image is specified using a value from 0 to 255.

Due to the wide variety of indexed-color valuing systems available, a specific color in one indexed color image can
be given one value, while the same color in another image is given a different value. For example, a color with a
single RGB valuemay be given an indexed color value of 120 by one imaging application and 142 by another.

For this reason, any time the input or output transparency options are used with indexed color images, the indexed
color values must be read in as RGB and enteredmanually.

If desired, use a color-finder program to read the transparency RGB values.

Quantization options
When you select MG4 as the output format for a floating point image, you can use the options on the
Quantization tab to define a quantization precision value and other quantization options.

NOTE: The No-Data value will be rounded to six decimal digits for display purposes, but calculations are
performed using the full precision value.

For more information on quantization, see Using quantization for floating point images on page 32.
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Quantization precision
When you compress a floating point image, GeoExpress automatically calculates the optimized precision value to
use for quantization. You can alsomanually specify a precision value.

The pixel values of the compressed output image are accurate to within half of the precision value. For example,
there is a pixel in your floating point image that has a value of 3000. If you specify a precision value of 0.5, then the
same pixel after quantization will have a value between 2999.75 and 3000.25.

As a rule of thumb, you can calculate the optimized precision value used by GeoExpress with the following
formula:

Precision = (Maximum value - Minimum value) / 216
Whether youmanually specify a precision value or allow GeoExpress to automatically calculate a precision value,
GeoExpress records the precision value used during quantization in the imagemetadata. The precision value for
each image band is stored in the IMAGE::QUANTIZATION_SCALEmetadata tag. The tag lists the precision
value used for each band of the image, including the alpha band. The last value in themetadata tag is for the alpha
band precision value.

TIP: Open the output image in GeoExpress to view the imagemetadata. For more information, seeMetadata on
page 32.

Setting a precision value
To set a precision value, enter a value in the Precision field of the Quantization tab. The precision value that you
enter depends on the range of values in the input image.

You can specify one quantization precision value for all the bands in an image, or you can specify individual
precision values for each band.

Quantization range
In addition to the quantization precision value, you can specify the range of values that you want GeoExpress to
keep during quantization.

If the input image contains minimum ormaximum values that are far removed from the rest of the pixel values,
then youmay want to manually specify minimum andmaximum values. For example, if the input image contains a
maximum value of 32,000, but does not contain any pixel values between 20,000 and 32,000, then youmay want
to specify amaximum value of 20,000. In this example, GeoExpress changes all pixel values greater than 20,000
to 20,000. If youmanually constrain the quantization range, you can improve the appearance of images that have
very little data near theminimum andmaximum values.

To specify a range of values for quantization, enter minimum andmaximum values on theQuantization tab. You
can specify oneminimum and onemaximum value for all the bands in an image, or you can specify individual
values for each band.

Quantization and No-Data
Many floating point images denote no-data values as an arbitrary minimum value. For example, an imagemay use
-9999 as the no-data value even though there aren’t any pixel values between -9999 and 0.

Such large gaps in pixel values create an artificially wide dynamic range that may cause output images to appear
dark. For more information on dynamic range, see Dynamic RangeMetadata Generation on page 83. To ensure
that output images display correctly, ensure that the no-data value is specified in themetadata before you
compress the image. If the no-data value is not in themetadata, you canmanually specify the no-data value in the
No-Data field of the Quantization tab.
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Security options
GeoExpress enables you to lock your encodedMG2 andMG3 files with a password. MG4 does not support
security options.

The Security tab provides the Protect encoded image with a password option. If you enable password
protection, you can then choose whether or not to show the password with the Hide typing option.

Notes
There is no way to access a password-protected file if you forget the password.

The password is kept in the project file and stays with the project. Although a useful data protection feature, this is
not a fully robust file security solution.

GeoExpress does not allow password-protected files to be used as input.

Only image data is encrypted; geocoordinates and other metadata are still accessible in password-protected files.

Format-specific options
Advanced MG4 options
You can use the options for theMG4 output format to configure the display of an image, configure performance,
and generate dynamic rangemetadata.

The following figure displays the options that you can select for theMG4 output format:

NOTE: SinceMrSID Generation 4 does not support CMYK content, the K-Weight option will not be enabled for
MG4 output.



GeoExpress 10 User Manual

– 82 –

Weight
TheWeight setting is treated the same for MG2, MG3, andMG4 outputs.

Weight affects the grayscale portion of a color image, which is the part of the image with no color information. A
higher weight setting increases the emphasis on this grayscale aspect of a color image, while decreasing
emphasis on color quality. A lower setting increases the consistency of color between theMrSID image and the
original data.

Images with high color contrast will benefit from a lower weight setting. Images with greater detail benefit from a
higher weight setting.

Acceptable values: 0.0–10.0

Default: 2

Frequency Balance
The Frequency Balance setting is the same for MG3 andMG4 output.

Determines the emphasis given to edges and flat areas in color and grayscale images. Images requiring precise
edge definition will benefit from a lower setting. If precise edges are not as important as consistency in flat color
areas, increase this setting. The practical range of values is 0.1 to 10 where 0.1 represents maximum edge
definition with less emphasis on flat areas, and 10 represents minimum edge definition with smoother areas of
relatively consistent color.

Acceptable values: 0.0–10.0

Default: 2

Sharpness
Sharpness is the same for MG3 andMG4 outputs.

Determines the sharpness of boundaries between different areas of an image. Images with large amounts of
textured area (where color or intensity changes are occurring throughout a region, rather than just at a boundary)
will benefit from a lower setting. Use a higher setting for images with little textured areas. The range of values is
0.0 to 1.0 where 0.0 represents minimum sharpness and 1.0 represents maximum sharpness.

Acceptable values: 0.0–1.0

Default: 0.0

Block Size
Block Size is the same for MG3 andMG4 outputs.

GeoExpress accesses image data in “blocks” of pixels.

IMPORTANT: Blocks in MG3 andMG4 encoding are different from blocks in MG2 encoding. The block size
parameter in MG3 controls how large the bitplane-encoded regions are. Lowering this parameter may lower the
memory usage of the encoder but may also decrease the lossless compression ratio. Raising this parameter
may increasememory usage, but may improve the lossless compression ratio. This parameter has little effect
on overall encode time. Typical values range from 32 to 64.

Acceptable values: 5–64

Default: 64
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Strip Height
Strip Height is the same for MG3 andMG4 outputs.

Strip height affects performance andmemory usage. The strip height parameter controls how many rows of the
input image are processed at one time. Lowering this parameter may reducememory usage, but may increase the
encoding time. Raising this parameter may increasememory usage, but may also decrease encoding time. Unlike
the block size, changing this parameter will not have any effect on the compression ratio of the output image.

Typical values range from 2 to 128. The encoder may perform more efficiently if the block size is amultiple of the
strip height.

Acceptable values: even integers between 2 and source image height

Default: 64

Optimizable
TheOptimizable option performs the same for MG3 andMG4 outputs.

Determines whether the output MrSID file contains optimization data. By default the Optimizable option is
enabled.

The option for optimizing images is specific to MG3 andMG4 files. When you optimize an image, youmake it
possible to perform some imagemanipulation operations on the image without re-encoding or recompressing the
image. Imagemanipulation operations that benefit from optimization include the following:

l Resampling
l Cropping
l Demosaicking
l Area of interest encoding

Creating an optimized image does not affect encoding time. However, saving optimization data for an image
modestly increases the size of an image by approximately one to five percent. If image size is critical and you do
not plan to perform further imagemanipulation operations, deselect the Optimizable option.

Dynamic Range Metadata Generation
To improve the appearance of MrSID images in other GIS programs, useGeoExpress to write dynamic range
metadata for images.

You can generate dynamic rangemetadata for all images with the exception of eight bit images. For an image
where the dynamic range is less than the full range of possible values for the image, you can use your
GIS program to stretch the pixel values across the full range. For example, if you have a 16-bit image and the
dynamic range is 11 bits, then youmay want to use dynamic range stretching to improve the appearance of the
image.
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Dynamic RangeGenerationmethods
To calculate the dynamic range of an image, select a dynamic range generationmethod.

RGB: Calculate theminimum andmaximum dynamic range values for an image with red, green, and blue bands.
Select the RGB method tominimize color shifting for RGB images. When you select the rgb method,
GeoExpress calculates the combined dynamic range of the red, green, and blue bands.

Merged: Calculate theminimum andmaximum dynamic range values for an image with multiple bands. Select
theMerged method to preserve the proportions of pixel values across bands. For example, if you want to
comparemultiple bands in amultispectral image, youmay want to select theMerged method. When you select
themerge method, GeoExpress calculates the combined dynamic range of all bands.

Per-Band: Calculate theminimum andmaximum dynamic range values for an image with one or more bands.
Select the Per-Band method to calculate the dynamic range of each band individually. For example, if you have a
multispectral image and you only want to view one band at a time, select the Per-Band method. When you select
the per-band method, GeoExpress calculates the dynamic range of each band separately.

None: Do not calculate the dynamic range of the image.

NOTE: To enter theminimum andmaximum dynamic range values manually, select None as the dynamic
range generationmethod and edit the imagemetadata. For more information on entering dynamic range
metadatamanually, see Imagemetadata on page 34.

Automatic and Strict dynamic range
For 16-bit images with unsigned integer data, you can select either Automatic Range or Strict Range. 16-bit
images with signed integer data and all 32-bit images use the Strict Range option. The following list describes the
two ranges that you can select:

l Automatic Range: Set themaximum value to the estimated bit-depth and set theminimum value to zero.
The estimated bit-depth is the next whole number of bits that contains the calculatedmaximum value in the
image. For example, if themaximum value in the image is 3950, GeoExpress estimates that the image was
taken with a 12-bit camera and sets themaximum value to 4095. BecauseGeoExpress sets a wider
dynamic range for the image, you canminimize color shifting when you display the image.

l Strict Range: Set themaximum andminimum values to the exact dynamic range values calculated by
GeoExpress.
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Advanced MG3 options
You can use the options for theMG3 output format to configure the display of an image, configure performance,
and set optimization options.

The following figure displays the options that you can select for theMG3 output format:

Weight
For details, seeWeight on page 82.

K-Weight
Determines the emphasis for the K band of a CMYK color image. CMYK imagery with high color contrast will
benefit from a lower setting. A CMYK image with a high density of detail will benefit from a higher setting. The
practical range of values is 0.0 to 10 where 0.0 represents minimum intensity (andmaximum color consistency
between theMrSID image and the original CMYK data) and 10 represents maximum intensity.

Acceptable values: 0.0–10.0

Default: 0.25

Frequency Balance
For details, see Frequency Balance on page 82.

Sharpness
For details, see Sharpness on page 82.

Block Size
For details, see Block Size on page 82.

Strip Height
For details, see Strip Height on page 83.
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1-Pass or 2-Pass Optimizer
This option is only available for MrSID Generation 3 (MG3) images. The 1-pass and 2-pass optimizer parameters
affect encoding performance andmemory usage. Although not as fast as the 1-pass optimizer, the 2-pass
optimizer requires much less memory because it splits the encoding operation into two passes. This is required for
very large files.

Note that the Estimated Memory Usage value is only displayed when the 2-pass optimizer is used.

By default the 2-Pass Optimizer is used for Area of Interest encoding even if this option has not been selected.

NOTE: Encoding with the 1-Pass Optimizer is faster but requires that the entire image be loaded intomemory.
If the computer does not have enoughmemory, the job does not succeed.

Optimizable
For details, seeOptimizable on page 83.

Advanced MG2 options
You can use the options for theMG2 output format to configure the display of an image, configure performance,
and generate image statistics.

Weight
The settings forWeight andG-weight affect the color quality and line definition of encodedMrSID files. These two
settings can be adjusted independently of one another. TheWeight setting does not affect grayscale images
whereas the G-weight setting affects both color and grayscale images.

For details, seeWeight on page 82.

G-Weight
TheG-weight parameter increases or decreases the definition of edges in anMG2 image. A lower setting for G-
weight creates more defined edges with less emphasis on flat areas. A higher setting creates softer edges while
smoothing the image in flatter areas with relatively consistent color.

In applications requiring precise edge definition, decrease the setting for G-Weight. If precise edges are not as
important as consistency in flat color areas, increase the setting for G-Weight.

Acceptable values: 0.0–10.0

Default: 2

Block Size for MG2
MrSID accesses image data in “blocks” of pixels. Blocks in MG2 encoding are different from blocks in MG3 and
MG4 encoding.
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Different block sizes affect system resources. While a smaller block size in MG2 encoding uses less RAM, the
opening and closing of multiple image blocks may impact a system in other ways, sometimes resulting in an
encoding failure. If sufficient RAM is available, a larger block size is recommended for encoding projects
approaching or exceeding a gigabyte in size.

By default, GeoExpress automatically selects a block size for MG2 encoding based on a calculatedmemory
usage curve that is dependent on the input image. The default block size corresponds to the lowest point in the
memory curve.

Block sizemay be set manually by selecting the Block Size option and entering a value in the field. When
compressing imagery in excess of a gigabyte in size, use a block size of 1024. For imagery equal to or greater
than three gigabytes, a block size of 2048 is recommended.

Changing the block size setting will not affect the rate of compression or the quality of the output image.

Minimum value: 32.

Image Enhancement
The Image Enhancement option improves the appearance of some images by adding information to the images.
This means that pixels of different colors are added to the areas of flat color to make the artifacts less visible to the
eye. The appearance of the resulting images may appear softer. This option is particularly useful for images that
have large areas of similar color or continuous tone, such as a large blue sky, or a single background color where
artifacts may become perceptible.

By default, image enhancement is enabled. LizardTech recommends that you experiment with a variety of images
to determine which images benefit from this option.

Image Statistics
The Image Statistics option collects basic numeric statistics about the image’s samples. Data collected includes
theminimum, maximum, mean, and standard deviation of the samples for each band. Themetadata tags that are
added to the output file are:

IMAGE::STATISTICS:MAX
IMAGE::STATISTICS:MEAN
IMAGE::STATISTICS:MIN
IMAGE::STATISTICS:STANDARD_DEVIATION

By default, image statistics is disabled.
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Advanced JPEG 2000 options
For JPEG 2000 images, you can select JPEG 2000 profiles and other options.

IMPORTANT: The information included below is provided with the assumption that the user is familiar with the
JPEG 2000 standard. Parameter choices accommodated by the JPEG 2000 specification are of such a broad
and varied range that it is possible for users to select settings that prove counterproductive to their goals. In
particular, some optimal settings can result in degraded decode performance. Considerable trial and error may
be required to achieve desired results when diverging from defaults and recommended settings.

NOTE: A JPEG 2000 image consists of one or more tiles, which are regions of the image that are compressed
independently. The order of the resulting “packets” is governed by two settings: Tile Parts and Progression
Order. These settings are especially useful to those who need to target specific JP2 workflows.

Profiles
This panel enables you to invoke a list of supported profiles comprised of preset encoding options for particular
workflows, and to save your own custom profiles. For more information see Using JPEG 2000 profiles on page 91.

Tile Size
If enabled, the tile sizemust be no larger than the dimensions of the source image. Smaller tiles reduce the
amount of memory required to encode the image, however the use of tiles may introduce edge artifacts.

Default: 4096 × 4096.

Tile Parts
Tiles may be written to the JPEG 2000 file sequentially or interleaved. When tiles are interleaved, Tile Parts
defines the group of packets that are written together. Tile parts can be grouped by Resolution, Layer, or
Component, depending on which Progression Order you use. If you don’t specify a grouping option, the file will
be written sequentially.

If an image consists of many tiles, then grouping first by Resolution allows a decoder to display a course
resolution of each tile first, and then finer resolutions as more of the file is received.

Some Progression Order options preclude grouping by one or more of the Tile Parts options. For example, the
factory default progression order of RPCL sets the Tile Parts option to Resolution, while making the Layout
option unavailable and the Component option available.
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Progression Order
Progression Order lets you specify the order in which packets will appear in a given file. This facilitates certain
workflows. Progression Order may have a significant impact on the time andmemory usage required to encode
and/or decode the image.

Default: RPCL

Flush Period
When codestream flushing is enabled, less memory may be required to encode the image. The flush period should
be on the order of the strip height being used. Using the flush period should not significantly affect output image
quality.

Default: 4096

Tile Length Markers
Determines whether or not Tile LengthMarkers (TLMs) are to be put into the JPEG 2000 codestream. Use of
TLMs may provide better decode performance.

Default: 255

Use Packet Length Markers
Enables or disables the use of packet lengthmarkers. Use of packet lengthmarkers may improve decoding
performance.

Default: Enabled

Use 9-7 Wavelet
Specifies that the floating point 9-7 wavelet be used for encoding, instead of the default integer 5-3 wavelet. The 9-
7 wavelet will not encode an image losslessly, however, it may result in a better looking image at higher
compression ratios. This option is disabled by default and is only available when the Encode Losslessly option is
not selected. By default, the NPJE and EPJE profiles use the 9-7 wavelet.

Codeblock Size
JPEG 2000 codeblock size is subject to the following restrictions:

l width and height must be powers of two
l width and height must be greater than 4
l width × height must be less than 4096
l width and height must be less than width and height of tile size
l width and height must be less than width and height of the image if tile size is not specified

The default codeblock value is 64 × 64.

Quality Layers
This value indicates the number of quality layers with which to encode the image. Among other things, quality
layers enable better “streaming” (progressive transmission and display) in some applications.

Default: 30

Strip Height (JP2)
Affects memory usage. Increasing this valuemay improve runtime performance, but at a cost of requiringmore
physical memory. This value should be decreased when encoding very large images. Changing the strip height
does not affect the quality of the output image.

Default: 12
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Bits of Precision
Enables you to choose how many significant bits are to be used from the samples of the source imagery. For
example, an imagemay consist of 16-bit data values, but only eleven of those bits may bemeaningful.

Default: Enabled

Default JP2 settings
The table below lists GeoExpress’s default JP2 settings.

To change these settings, see Preferences on page 106.

OPTION SETTING

Use Tile Size Enabled

Tile Size Width: 4096
Height: 4096

Tile Parts Group by resolution (R)

Code Block Size Width: 64
Height: 64

Use Precincts Enabled

Precinct Size Width: 256
Height: 256

Strip Height 12

Quality Layers 30

Flush Period Enabled; value: 4096

Tile Length Markers Enabled; count: 255

Use Packet Length Markers Enabled

Use 9-7 Wavelet (lossy) Disabled

Progression Order RPCL

Use GMLJP2 Metadata Enabled

Precincts
Using precincts may improve the performance of decode operations for certain image encodings such as those in
which tiles are not used. The Precinct Editor enables the user to enter precinct sizes for all of the zoom levels of
the image.

Default: GeoExpress uses precincts in which width and height values are both 256.

To access the Precincts Editor:
1. Select JPEG 2000 as the output format.
2. Click Precincts on the Format-Specific tab of the Advanced Job Options dialog.

This opens the Precincts Editor dialog.

To disable use of precincts, deselect the Use Precincts option.

To edit a precinct value:
1. Open the Precinct Editor as described above.
2. Select a precinct number in the precinct list and click Edit Precinct. A new editing dialog appears.
3. Change width and height values and click OK.

Precinct sizes must be powers of two, except for the last one in the list, which has the lowest resolution.
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GMLJP2 Metadata
Click the GMLJP2 Metadata button to write GML metadata to the JPEG 2000 image or to specify a GML data
file.

When you enable the GMLJP2 option, GMLmetadata is added to the output file according to the GMLJP2
Application Schema version 3.1.1., which can be found at http://schemas.opengis.net/gml/.

If you would rather use an external file that contains all the coverage and other GML data, youmay specify that file
by deselecting theWrite GMLJP2 metadata box option.

By default this option is enabled.

Evaluation order of metadata
If an external world file is present, its information trumps any metadata. Absent a world file, metadata are
evaluated in the following order of priority:
1. GMLJP2
2. GEOJP2/GEOTIFF
3. MrSID metadata
4. World file metadata

NOTE: If a world file is present, then no coordinate reference system is associated with the output file (a NULL
WKT is applied).

Using JPEG 2000 profiles
GeoExpress includes a selection of industry accepted profiles—groups of preset JPEG 2000 encoding options for
particular workflows—and an interface for managing them. The Profile Manager enables you to select and edit
profiles and create and save new ones.

Accessing the Profile Manager
1. Make sure you select JPEG 2000 as the output file format.
2. Click Advanced on the Job Properties panel.
3. Click the Format-Specific tab.
4. Click the Select A Profile button in the Profiles panel.

The Profile Manager appears.

Selecting a profile
In the Profile Manager, select a profile from the drop-downmenu and click OK. The selected profile is listed on
the Format-Specifc tab and the options are set to match the profile.

Preloaded profiles
GeoExpress provides profiles composed of preset encoding options for particular workflows. These are EPJE,
NPJE, Large Image, Large Image without TLMs, and Default. In the current implementation of GeoExpress, the
EPJE profile is identical to the NPJE profile except for progression order. The profile namedDefault is not the
same as the default GeoExpress encode settings.

When you select a profile from the drop-down list, it may display a user-defined description in the Description field
to help identify it. Click OK to apply the selected profile.

You can also choose to load a custom profile stored anywhere on your network.

NOTE: Selecting (None) from the profile list sets the JPEG 2000 options to the defaults set in the GeoExpress
preferences.

http://schemas.opengis.net/gml/
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EPJE
Stands for Exploitation Preferred JPEG 2000 Encoding. The EPJE profile sets the values to the encoding
parameters preferred by the National Geospatial-Information Agency (NGA) for image exploitation.

NPJE
Stands for NGA Preferred JPEG 2000 Encoding. The NPJE profile sets the values to the encoding parameters
preferred by the National Geospatial-Intelligence Agency (NGA) for archiving.

Large Image
This profile is optimized for encoding very large images.

Large Image w/o TLMs
This profile disables tile lengthmarkers for better rendering in viewers that don’t support them.

Default
This profile represents LizardTech’s general purpose JP2 encode settings, determined at the SDK level. These
are NOT the same as theGeoExpress factory default encode settings, which are recommended for large images.
See Default JP2 settings on page 90.

NOTE: The NPJE and EPJE standardization process is not yet complete. These profiles use settings that are
compliant with the NPJE and EPJE standards as the NGA currently defines them; however, if the
specifications for the standards change, files encoded using the current NPJE and EPJE profiles may not be
compliant with the finalized standards. As the standards evolve, LizardTech will make available updated
profiles (XML files) to reflect any changes to the standards. Contact your LizardTech sales representative to
learnmore.

Modifying a profile
After you select and apply a profile, the profile name appears in the Selected Profile field on the Advanced tab. If
any encode settings aremodified after applying a profile, the Selected Profile field indicates that the current
settings differ from the original profile settings, unless no profile was selected. For example, if you apply the EPJE
profile and change one or more options, the profile is now listed as EPJE (modified).

Saving custom profiles
You can save the current encode settings as a custom profile.

1. On the Format-Specific tab of the Advanced Job Options dialog, click Save Profile.
2. Enter an output file name and a name for the profile if desired.
3. Optionally, add a description.
4. Click OK.

You can only save a profile if all of the encode parameters are discrete and unambiguous values. The default
location for user profiles onWindows is C:\Documents and Settings\<user name>\My
Documents\LizardTech\GeoExpress\<version>\profiles. Any profiles in this directory will
automatically be available in the profile selector’s drop-down list. To save a profile, youmust enter a unique profile
name.

Loading custom profiles
1. Access the Profile Manager as described above.
2. Click Load Custom Profile and browse for the desired custom profile, then click Open.
3. Optionally, add a description and click OK.
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Notes on profiles
A profile is a collection of settings, not a singular entity. After a profile is applied to a job, only the particular
settings—not the profile—are saved in the job. The profile itself is stored on disk. If a profile is edited or deleted after
it is applied to a job, those changes are not retroactively applied toward any existing encode jobs.

Not all of the settings in the dialog are preserved in a profile—only the ones that affect how the output file is
encoded. Most notably, thumbnail size and strip height are not included in the profile system. Profiles are used to
store information about what JPEG 2000 options were used in choosing the organization of the file format
(algorithmic codec settings), not encoder implementation choices. Changing the strip height or thumbnail size
does not affect the layout of the file, since they are really encoding performance parameters.

JPEG 2000 images
JPEG 2000 overview
GeoExpress enables your applications to use JPEG 2000 compression on geospatial images with the same level
of efficiency, metadata, and large-image support already available with MrSID. JPEG 2000 image compression
offers many of the advantages implemented in theMrSID format, plus the added benefits of being an international
standard (ISO/IEC 15444).

All of the basic options and some of the advanced options that are available for MrSID encoding are also available
for the JPEG 2000 format. Certain advanced operations such as creating and updating composites and optimizing
images are not available for JPEG 2000 encoding.

JPEG 2000 output selections
GeoExpress supports encoding JPEG 2000 files in two different modes, GMLJP2 and Part I. By default
GeoExpress uses GMLJP2, which is the best option for most workflows. For applications that do not support
GMLJP2, the Part I mode generates files that do not use any Part II extensions. GMLJP2metadata is not
available in this mode. Other encoding features, such as the use of NPJE profiles and other metadata forms, are
still available. Use the Part I mode only when you are sure that the image user’s workflow entails applications that
cannot readGMLJP2 files.

The twomodes are included as options in the Output Format drop-down list. For convenience when creating
mosaics, this drop-down list also appears on the Create New Mosaic dialog.

JPEG 2000 encoding utilizes the same data cartridge deductionmechanism that MrSID encoding does (see
Frequently AskedQuestions on page 139 and Data cartridges on page 133). Operations involving only MrSID
and/or JPEG 2000 input files do not decrement the cartridge.
GML andGMLJP2
GeoExpress allows Geography Markup Language (GML)metadata to be added to JPEG 2000 (JP2) imagery to
comply with the OpenGeospatial Consortium (OGC)GMLJP2 standard.
What are GML andGMLJP2?
GML (Geography Markup Language) is an open, XML-based specification for representing geographic information
including geographic features, coverages, observations, topology, geometry, coordinate reference systems, units
of measure, time and other values. Because it is an XML grammar, it is both extensible and adaptable to any
application within the broad geospatial field.

As a wavelet-based image compression format, JPEG 2000 (JP2) is capable of handling images into the gigabyte
range and beyond. But until recently, JP2 was not particularly suited to the needs of the geospatial community
because it didn’t have a designated geospatial metadata standard. However, because the JPEG 2000 format
allows for the inclusion of XML data, GML has emerged as the ideal partner for JPEG 2000 imagery, bridging the
gap between JP2 andGIS.
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GMLJP2 is the specification that standardizes that partnership and opens the door for greater interoperability
between your imagery and the thousands of current and future geospatial applications that might use it. Containing
its own geographic metadata, your JP2 imagery becomes “spatially aware” and is thus of increased value in
geospatial applications. Prior to the adoption of GMLJP2, the lack of a geospatial metadata standardmeant that
applications and viewers may or may not have been able to read geospatial metadata in a JPEG 2000 file.
What kind of standard is GMLJP2?
TheGMLJP2 specification was officially adopted in February 2006 by the OpenGeospatial Consortium (OGC) as
an open standard for representing geographic information in JPEG 2000 imagery. LizardTech supports open
standards and is committed to the success of the GMLJP2 specification.

Jointly proposed and developed by LizardTech, Galdos Systems and a consortium of forward-looking aerospace
and technology companies, GMLJP2 represents themost advancedmeans of including geographic metadata
within compressed geospatial imagery andmaking that information useful in downstream applications now and in
the future.
GMLJP2 in GeoExpress
GeoExpress already offers themost complete and easy-to-use implementation of the open JPEG 2000 standard.
Now, your JP2 imagery encoded with GMLJP2metadata is secure for the future because, like JPEG 2000, the
GMLJP2 specification is an open, non-proprietary standard.

NOTE: Some applications that support JPEG 2000 do not support all of the features that are required to
implement the GMLJP2 standard. For more information, see JPEG 2000 output selections on the previous
page.

TheGML option is available among themetadata control settings of the advanced JPEG 2000 options (see
GMLJP2Metadata on page 91).
Links
Learnmore about the GML andGMLJP2 specifications at http://www.opengeospatial.org/specs/?page=specs.

TheGMLJP2 Application Schema version 3.1.1. can be found at http://schemas.opengis.net/gml/.

JPEG 2000 and color spaces
JPEG 2000 images can be created with an essentially unlimited number of bands, somultispectral output can be
created frommultispectral input without having to go through an output color space. For JPEG 2000 encoding, the
color compositor allows multibanded images to be created from files representing individual bands.

For more information see Creatingmultiband JPEG 2000 files on the facing page.

Encoding with alpha bands in JPEG 2000
JPEG 2000 supports the use of an alpha band or channel for masking out portions of an image. GeoExpress
supports creating alpha bands in JPEG 2000 files where the TIFF or JPEG 2000 source image has an alpha band.

When an image that has an alpha band is encoded to the JPEG 2000 format, GeoExpress encodes the alpha band
losslessly to preserve its integrity.

NOTE: For users of GeoExpress Standard Edition, the encoding of the alpha band does not additionally
decrement your data cartridge. Your encode job will bemetered the samewith or without alpha bands.

http://www.opengeospatial.org/specs?page=specs
http://schemas.opengis.net/gml
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Creating multiband JPEG 2000 files
GeoExpress allows the creation of multiband JPEG 2000 files from a collection of single-band grayscale image
files. The input files must all have the same dimensions, resolution, bit depth, and geographic positioning. Empty
bands are allowed, and treated as zero data.

1. Select Add color composite image to encode from the File menu.
This opens the Add Color Composite Image dialog.

2. Select a color space for the image from the drop-downmenu, either RGB orMultispectral. RGB populates
the list box with editable red, green, and blue bands. Multispectral populates the list box with bands that
range from 1 to n. You can change the number of bands in amultispectral image by clicking Edit number of
bands and typing in a new value.

3. To add an image file to a band, select the desired band and then click Edit file name. This opens the Edit
File Name dialog.

4. Type in a file name or click Browse to bring up a file browser. If you want to remove a file from a given band,
simply clear the text from the file name field. A color composite imagemust have at least one band
specified.

For information on NITF image segments in color composite images, see Using a NITF image segment as a
component band in a color composite image on page 97.

NITF images
This chapter offers information about how to create National Imagery Transmission Format (NITF) images with
GeoExpress.

The acronym NITFS sometimes seen refers to the NITF standard, which was created by the Department of
Defense as ameans of formatting digital imagery and imagery-related products and exchanging them among
members of the intelligence community, the Department of Defense (DOD), and other government departments
and agencies. NITF was created partly because government agencies needed a single common image
representation that supported certain metadata features and workflows. While it is called an image format, NITF is
perhaps more precisely described as a file format that wraps image files andmetadata about those files.

The NITF format requires information to be entered in numerous metadata fields on several forms. For NITF JPEG
2000 encoding, you can edit themetadata fields—as well as the LizardTechmetadata tags—in theMetadata
Manager.

For details about how GeoExpress saves NITF metadata, see NITF metadata on page 40.

NOTE: When you use a NITF file as an input image, sometimes the band order of the image does not match
the band order in themetadata. If this is the case, GeoExpress changes the order of bands in output images to
match themetadata band order.
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NITF compliance in GeoExpress
GeoExpress supports the following NITF standards:

l Version 2.1 of the NITF file format (MIL-STD-2500C, May 2006, plus change outlined in RFC NTB-038) for
writing

l Versions 2.1 and 2.0 of the NITF file format for reading
l Version 01.10 of the BIIF Profile for JPEG 2000 (BPJ2K01.10, April 2009) including the J2KLRA TRE
l Version 2.1 of the Commercial Dataset Requrements Document (NCDRD STDI-0006, February 2010)
l Version 1.0 of the Implementation Practices of NITF (STDI-0005 IPON v1.0, August 2007)
l Version 00.20 of the JPEG 2000 Test Plan (BPJ2K01.00 Test Plan Draft Version 00.20, March 2010)

NOTE: These NITF standards may change and future releases will track the evolution of these standards to
ensure interoperability.

NITF output options
Youmay select NITF 2.1 as an output format from theOutput Format drop-down list, which appears in two
places:

l The Job Properties tab for a selected job, and
l The Create New Mosaic dialog.

Two different types of NITF encoding are available: raw (uncompressed) and JPEG 2000.

Raw NITF
Because raw files are uncompressed, when you select NITF 2.1 (Raw) as the output format encode ratio, target
file size and other options are not available, and there is no Format-Specific tab in the Advanced Job Options
dialog. Metadata editing is not supported for raw NITF encoding.

JPEG 2000 NITF
When you select NITF 2.1 (JPEG 2000) as the output format, the source imagery is encoded to JPEG 2000 and all
of the JPEG 2000 encoding options become available. The options common toMrSID formats are displayed on
the Job Properties panel. These and all of the options specific to JPEG 2000 are available on the Format-
Specific tab of the Advanced Job Options dialog. For more information about these options, see Advanced
JPEG 2000 options on page 88.

Setting NITF as the default output format
Youmay specify NITF 2.1 as your default output format by selecting it from a drop-down list on the General tab of
the Preferences dialog. For more information, see Preferences on page 106.

Multisegment NITF images
Using multisegment NITF files as input
To be valid, the image segments comprising an incoming NITF file must bemosaickable. They must have
compatible resolutions, color spaces, and datatypes, andmust all fall on the same coordinate space.

To view the image segments in amultisegment NITF image, right-click on the job in the Job List and select
NITF Image Segments. You can remove segments from the output image by deselecting each image segment.

If no segments are selected, the input image is considered invalid.

When the image is encoded, the selected segments aremosaicked into a single flat image.

NITF mosaic tiles behave the sameway as other image tiles in the encoding process; the selected segments of
each tile aremosaicked together first, and then the tiles aremosaicked together for the final output.
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Using a NITF image segment as a component band in a color composite image
To use amultisegment NITF file as a component band in a color composite image:
1. Choose File > Add color composite image to encode.

This opens the Add Color Composite Image dialog.
2. Select RGB orMultispectral from the Color Space drop-down list at upper right.
3. Select a band and click Edit File Name.
4. Enter a file name or click Browse to locate the file, then click OK.

If the file you selected is amultiple image segment NITF file, the Image Segment Selector dialog opens.
5. Select which 1-banded image segment of the selected NITF file you wish to use as the “active segment” for

the selected band, then click OK.

Changing the active segment in a color composite Image
To change the active segment:
1. Choose File > Add color composite image to encode.
2. Click Select Image Segment.
3. Select a different 1-banded image segment from the drop-down list and click OK.

Creating multisegment NITF files
To create a NITF file with multiple image segments, the individual segments must bemosaickable. This is
because they must be placed on a common grid. All of themosaicking rules for other kinds of images apply to
multisegment NITF images. For more information onmosaics, Mosaics below.

To create amultisegment NITF file:
1. Click the Create New Mosaic button on the toolbar.

This opens the Create New Mosaic dialog.
2. Select NITF as the output format.
3. Select Create multiple image segments.

NOTE: Multisegment NITF encoding supports up to 999 image segments. If you attempt to encodemore than
999 tiles as amultisegment NITF file, an error message informs you that you have exceeded themaximum
number of image segments and asks whether or not you would like to flatten the input tiles first. Clicking Yes
will result in a single image segment NITF file. This is equivalent to deselecting the Create multiple image
segments option. Clicking No cancels the addition of that tile.

Mosaics
Mosaics overview
A mosaic is a group of images or point clouds that you want to view together. Each of the images or point clouds
that make up amosaic is called a tile.

You canmanage the tiles in amosaic to add tiles, remove tiles, or change the order of tiles. For raster images, you
can also crop tiles.

For raster mosaics, you can perform the samemanipulation operations that you perform for single images. For
example, you can crop or despeckle a raster mosaic.
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Creating a mosaic
NOTES
The process for creating amosaic has changed from previous versions of GeoExpress.

n In GeoExpress 10, you select files to include in themosaic, then specify themosaic properties.
n Options for multiple projections and resolutions are automatically set based on the selected files.
n The format of themosaic—raster or LiDAR—is determined automatically.
n By default, mosaics are sorted so that the highest-reolution image is at the top.

Use the Create New Mosaic button in the toolbar to create amosaic. Themosaic options that you can select
depend on themosaic format that you select.

1. Click Create New Mosaic or choose File > New Mosaic.
2. Select files to add to themosaic and click Open.

You can select multiple files in the dialog, but you can also addmore files later.
3. In the Create Mosaic dialog, you can fine-tune themosaic settings. You can change these at any time.

In the Input File Summary section, click Edit to addmore tiles, rearrange tiles, or crop or change the
projection of any tile. Learnmore
In the Output File Settings:

n Click Browse to change the name and location of the output file.
n Use the Format pop-upmenu to change the output file format.
n Use the Projection pop-upmenu to change the projection of the output file.

Initially, themenu lists recently-used projections. Use the search field at the top of the listing to
narrow down a long list.
If you need to use a different projection:

a. Click Full Search to open the Set Projection window.
b. Use the Projection Source pop-upmenu to choose a list of standard projections.
c. Choose a projection, then click Set Projection. Learnmore

4. Click OK to create themosaic.

In the Job Properties panel, you can:

l Click Mosaicked under Modifications from Original to edit themosaic. Learnmore
l Under Output Settings, you can change the output file type, location, and compression.
l Click Options: Basic under Output Settings to edit Basic Job Options. See: Raster job options on
page 65 or LiDAR job options on page 67

l Click Options: Advanced under Output Settings to edit Advanced Job Options. Learnmore

NOTE: Because images with different compression types and color lookup tables can be combined when
multiple images are joined together, color lookup table informationmay not be reported for imagemosaics.

Mosaic output formats
GeoExpress can create raster mosaics in MrSID Generation 2, 3, and 4 formats, and JPEG 2000, TIFF, and
NITF formats. GeoExpress can create LiDAR mosaics in theMrSID Generation 4, LAZ, LAS, and BPF formats.

If you create amosaic from existingMrSID images or JPEG 2000 images, GeoExpress does not deduct data from
the data cartridge. For more information on output formats, see Supported output file formats on page 123.

MrSID raster mosaics
Use theMrSID file format to create flat mosaics and composite mosaics. A flat mosaic is a single image that you
create frommultiple input images. A composite mosaic is a group of images that display as a single image.
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Flat mosaics
When you create a flat mosaic, GeoExpress creates a single image from the input tiles. Because a flat mosaic is a
single image, it displays more quickly than a composite mosaic. You can perform any imagemanipulation
operation on a flat mosaic that you can perform on a single image.
Composite mosaics
When you create a composite mosaic, GeoExpress creates aMrSID file that contains multiple input tiles. You can
only create composite mosaics out of input tiles in theMrSID format. To create a composite mosaic out of images
in other formats, first convert the input images to theMrSID format, then create amosaic out of theMrSID files.

Because a composite mosaic is a container for existing files, you can create a composite mosaic without running
an encoding operation. Use composite mosaics when you want to createmosaics quickly, for example, when you
want to createmosaics from large input tiles.

A composite mosaic in theMrSID Generation 4 (MG4) format can only contain MG4 input tiles. A composite
mosaic in theMrSID Generation 3 (MG3) format can contain MG3 andMG2 input tiles.

AnMG4 composite mosaic contains an overview image for viewing at low resolutions. As a result, MG4
composite mosaics display more quickly thanMG3 composite mosaics. However, MG4 composite mosaics may
take slightly longer to create.
Multiresolutionmosaics
A multiresolutionmosaic is a raster mosaic made up of input images with different resolutions. When you create a
multiresolutionmosaic in any format, the resultingmosaic is a single image; in other words, it is a flat mosaic. The
exception to this is theMrSID Generation 4 (MG4) format. You can create anMG4 composite mosaic out of
multiresolution images if all of the input tiles are also in theMG4 format.
Mosaics with multiple projection systems
GeoExpress can create raster mosaics out of images with multiple projection systems. However, because
images with different projection systems display discrepancies in their positioning, GeoExpress reprojects all of
the images to the same coordinate reference system (CRS). By default, GeoExpress reprojects images to the
WGS 84 projection system. To use a different projection system, see Reprojecting an image on page 62.

If one or more of the tiles in themosaic does not have a valid CRS, or if you are using world files, you can
manually assign a CRS to each tile by editing themosaic. Learnmore

JPEG 2000 raster mosaics
When you createmosaics in the JPEG 2000 format, GeoExpress runs an encoding operation that creates a single
image from the input tiles. JPEG 2000mosaics are equivalent to flat MrSID mosaics.

NITF raster mosaics
Use the NITF file format to createmosaics with single or multiple image segments. An image segment is an
image in a NITF file. When you create amosaic in the NITF file format, you can combine the input tiles into a
single image or you can add each image to the NITF file separately. If you add images to the NITF file separately,
themosaic is called amultiple image segment mosaic. If you combine the input images into a single image, the
mosaic is called a single image segment mosaic. A mosaic made up of a single image segment is equivalent to a
flat MrSID mosaic. A mosaic with multiple image segments is similar to a composite mosaic in that it preserves
the information from each input tile. However, multiple image segment mosaics require an encoding operation
unlike composite mosaics, therefore they take longer to create.



GeoExpress 10 User Manual

– 100 –

Editing a mosaic
While you can perform basic operations onmosaics in the Job List and the Job Properties pane, the Edit Mosaic
dialog allows you to:

l Add tiles.
l Remove tiles.
l Rearrange tiles.
If tiles in amosaic overlap, themosaic displays whichever tile you place higher in the tile list.

l Crop the tiles in a raster mosaic.
l Assign a coordinate reference system (CRS) to individual tiles of a raster mosaic.
All tiles must either have no CRS or someCRS assigned (even if they differ); you can’t mix tiles with a
CRS and tiles without a CRS.

l Change the output file destination, format, and projection.

To edit a mosaic, select themosaic in the job list and chooseOptions > Edit mosaic.

You can also right-click themosaic and choose Edit Mosaic from the shortcut menu, or click Mosaicked in the
Modifications from Original section of the Job Properties panel.

l Tomodify the tiles in themosaic, click Edit under Input File Summary.
l To change the destination location, click Browse under Output File Settings.
l To change the output format, choose a format from the Format pop-upmenu.
l To change the Coordinate Reference System of the output file, choose a projection from the Projection
pop-upmenu.
Initially, themenu lists recently-used projections. Use the search field at the top of the listing to narrow
down a long list.
If you need to use a different projection:

a. Click Full Search to open the Set Projection window.
b. Use the Projection Source pop-upmenu to choose a list of standard projections.
c. Choose a projection, then click Set Projection. Learnmore
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Modifying tiles

l To add a new tile to themosaic, click .

l To remove a tile, select the tile and click .

l To change a tile’s projection, select the tile and click . Learnmore
You can set the projection for multiple tiles at the same time.

l To crop a tile, select the tile and click . Learnmore
You can only crop tiles in a raster mosaic, not a LiDAR mosaic.

l To reorder the tiles, use the shortcut menu. Right-click a tile in the list, then choose one of themove
options:

n Move up
n Move down
n Send to top
n Send to bottom

You can select multiple tiles andmove them as a group.
l To resort tiles by the default sort, right-click a tile in the list and choose Sort by resolution and time.
The highest resolution tiles will be at the top of the list. Of those tiles with the same resolution, the newest
tile will be higher in the list.

Performing color balancing for a mosaic
Most raster imagemanipulation operations that you can perform are the same for mosaics and for single images.

However, when you perform color balancing for a raster mosaic you can also perform additional color corrections
tomatch the appearance of tiles to each other. You can perform color balancing for mosaics with the following
output formats:

l MrSID Generation 4
l MrSID Generation 3
l JPEG 2000
l NITF 

For theMrSID output formats, you can only perform color balancing for flat mosaics.

Applying corrections
When you perform color balancing for mosaics, you can perform uniform corrections, non-uniform corrections, and
automatic corrections. You can apply corrections to the RGB bands or the Grayscale band, and you can apply
multiple corrections to the samemosaic.

For more information on the types of corrections that you can apply, see Color balancing on page 58.



GeoExpress 10 User Manual

– 102 –

1. Select amosaic in the Job List.
2. Click the Color Balance button on the toolbar.

3. Select the color balancing corrections that you want to perform and select the tiles to which you want to
apply the corrections. Select tiles in the tile list or click the Tile Select button to select tiles in the preview
image.

n To perform uniform corrections, click the Uniform Corrections tab. Select one or more tiles that you
want to correct. If you do not select a tile, the corrections that you perform are applied to all the tiles.

n To perform non-uniform corrections, click the Non-Uniform Corrections tab and select one or more
options.

n To perform automatic corrections, select a Correction Method in the Automatic Corrections panel.
You can choose to apply the correction to each band (the default) or to the intensity pseudo-band.
Click Apply Correctionswhen you have specified your desired settings.

NOTE: In versions of GeoExpress prior to v9.5.3, automatic corrections were applied to the Intensity
pseudo-band. By applying the corrections to each color band, the colors of the resulting image aremore
uniform. This functionality is now the default behavior, but if you need to utilize corrections similar to
earlier versions of GeoExpress, choose intensity band from the Apply correction menu.

4. Click OK.

NOTE: Uniform corrections will bemore effective among image tiles composed of similar ground cover types
than, for example, an array of tiles showing dense urban development and vegetation or bodies of water, and
may require additional manual manipulation tomake the tiles match their neighbors. Automatic corrections
work on a tile by tile basis, so any boundaries, seams, or lens effects that occur inside of a tile will still be
visible regardless of uniform corrections.

Previewing a mosaic
Select a raster or LiDAR mosaic in the Job List and click the Output Preview tab to preview all the tiles in the
mosaic, or select one or more tiles in the Job List that you want to preview.
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For raster mosaics, when you select bands using the Band Selector button , your selections apply to all of the
tiles in themosaic, even if only one tile in themosaic is selected.

When you crop a raster mosaic, the preview image only displays the cropped area of the image. If you select a tile
in the Job List that is not included in the cropped area of the image, the preview image is blank.

For more information about previews, seeOutput Preview panel on page 19.

Updating a MrSID image
For raster mosaics, you can create a composite mosaic to update one part of an image with new imagery. This is
useful when, for instance, a particular region of an aerial photomosaic needs to be updated because of building
development or other geographic changes but an entire new image set is not needed. By updating just the affected
image tiles geospatial image users can keep pace with geographic changes without constantly acquiring new
image data for every region.

To update an image, create a new raster mosaic and select the composite mosaic option.

Mosaics with overlapping input
If two or more tiles in a raster mosaic overlap, the resultingmosaic displays whichever tile you place higher in the
Job List.

If you create amosaic out of overlapping tiles and the tiles are compressed images, despeckle the tiles to
minimize compression artifacts between image tiles. For more information, see Despeckling on page 44.

If the transparency borders of individual tiles obscure image data in neighboring tiles, set transparency values for
themosaic. For example, when images are geographically rectified to align accurately with a fixed point such as
magnetic North, the images appear tilted and contain borders of transparency along the edges. For more
information on setting transparency values, see Alpha band options on page 76 for MG4mosaics or Transparency
options on page 78 for other output formats.

The following figure shows an example of amosaic with overlapping transparency borders:

Mosaics with GeoTIFF images
If you create amosaic that contains GeoTIFF images, you can select the georeferencing information that you
want to use. A GeoTIFF image can store georeferencing information in a TIFF world file and in embedded
metadata. If the GeoTIFF image has georeferencing information stored both in a world file and in its metadata,
GeoExpress uses the embeddedmetadata by default. To use the georeferencing information in the world files,
select the Allow World Files to Override Native Georeferencing preference. For more information on setting
preferences, see Preferences on page 106.
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If you encode aGeoTIFF image using georeferencing information from a TIFF world file, other spatial referencing
information such as the coordinate reference system (CRS) found in the GeoTIFF metadata tags is saved in the
MrSID metadata. In amosaic composed of both TIFF andGeoTIFF images, GeoExpress saves metadata in the
mosaic if the first input tile is a GeoTIFF image with metadata.

Creating a mosaic with a mosaic list file
Rather than useGeoExpress to select images or point clouds that you want to mosaic, you can create a text
listing the images and point clouds that you want to mosaic. For raster mosaics, the text file must have a .mos
extension. For LiDAR images, the file must have a .list extension.

To add amosaic list file, complete the following steps:
1. Click the Create New Mosaic button on the toolbar.
2. Select amosaic list file: .mos for raster mosaics, or .list for LiDAR mosaics.

To filter only mosaic list files, type *.list;*.mos in the File Name field of the dialog.
3. Click Open.

This create themosaic and opens the Edit Mosaic window. Learnmore

Images with Georeferencing
For georeferenced images and point clouds, the text in themosaic list file contains the file paths of the images that
you want to mosaic. In the following example, amosaic is created from four TIFF files: image_nw.tif, image_
ne.tif, image_sw.tif, and image_se.tif.

Ensure that each image has an associated *.tfw file (the names of the corresponding files must match exactly,
differing only in the .tfw file extension). This *.tfw file must be in the same directory as the file to which it
refers. A sample file for this project is:

C:\maps\image_nw.tif
C:\maps\image_ne.tif
C:\maps\image_sw.tif
C:\maps\image_se.tif

When presented with a list of images, GeoExpress immediately looks for corresponding georeferencing
information. The “Input File Size” and “Target File Size” reflect both the on-disk size of the source data and the
estimated output file size of the full mosaic. When encoded, the images are combined in a seamless mosaic
based on the information given in the georeferencing files.

NOTE: GeoExpress does not recognizemosaic list files with spaces in either the listed file names or in the
listed paths. In addition, the first line in the file cannot be blank and the last line in the file must be followed by a
carriage return.

Images without Georeferencing
When creating a raster mosaic using images with no georeferencing information, the text file must list the file
names and the upper left corner pixel location for each image. Each imagemust be listed based on the following
format:

image_name x-pixel_location y-pixel_location

Only a single space is required between each of the three items in the list. Each image listedmust be on a
separate text line.

Base the upper left corner pixel location of each image on the location of the image relative to an x=0, y=0 pixel
location of the upper left corner of the entire set of images.
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Consider an example where a single image is being created from four separate scanned Sun Raster images, each
640 by 480 pixels in size.

The file requires the following four lines:
image_nw.ras 0 0
image_ne.ras 640 0
image_sw.ras 0 480
image_se.ras 640 480

The first line in the file must not be left blank.

The sample auxiliary file above joins the specified images as follows:

Tips for encoding large mosaics
Tips for using less memory

l Reduce the Strip height to lowermemory usage. (2 is the smallest).
l If that still uses toomuchmemory, reduce the Block size to 32.

Tips for making it run faster
l Wherever possible, work with local files rather than files on a network share.
l Encodingmosaics is very I/O intensive; fast disks on a fast bus will greatly improve encoding performance,
especially of largemosaics.

l File systems should use smaller block sizes. GeoExpress does lots of small reads of data so large file
system blocks add lots of overhead to the small data reads.

l If reprojecting, set the Strip height to 2048 (the reprojection block size default) if the system has enough
memory.
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Preferences
Setting preferences
Every time that you create a job by adding an image or mosaic to GeoExpress, the job uses a set of default
options.

To change default job options:

1. ChooseOptions > Preferences.
2. Click a tab to set preferences for that category.

Preferences pertaining tomost job types are in the General and Appearance tabs.
Preferences for raster jobs can be accessed through theMrSID and JPEG 2000 tabs.
Set preferences for LiDAR jobs in the LiDAR tab.

3. When you are finished, click OK.

NOTE: To restore the default preferences for GeoExpress, click Restore Program Defaults.

General and Appearance preferences
General preferences

Default directories
You can define default Temp, Output, Log File and Histogram directories by browsing or by entering a filepath.

Default Temp directory
WhenGeoExpress encodes aMrSID Generation 2 image, it creates a series of temporary files that are used in
constructing the final MrSID image. Collectively, the temp files are roughly equivalent in size to the createdMrSID
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image. These files are deleted immediately upon completion of an encoding project.

Encoding requires enough disk space to accommodate both the output image and the temporary files. (For more
information, System requirements on page 8.)

Normally GeoExpress will use the default Windows temp directory, typically C:\Temp, to store these temporary
files. To use a different directory enter its path in the Temp field. If you are unsure of the entire path, click Browse
to navigate to the preferred directory.

Default Output directory
GeoExpress will normally create an output image in the same directory as the source image (the source directory
of the first image file in amosaic).

To create new output images in a different directory, enter its path in the Output field.

Default Log directory
This option allows you to specify where GeoExpress will save log files.

Default Histograms directory
By default, histogram files are created in the same place as their source images, but if they cannot be created
there (for example if the source images are in a read-only directory), then they are created in the directory specified
in the Histograms field.
Output file generation
If you select the Create unique file name option when a new MrSID file is created in a directory where a file of
the same name exists, the new file name is appended with an underscore and a number. For instance, if two files
named image.sid are created in the same directory, GeoExpress names the second file image - copy
1.sid. Additional files created are appended with incremental numbers (such as image - copy 2.sid).

If you select the Prompt if output file exists option, you will receive a prompt whenGeoExpress finds an existing
file with the same name as the output file. A Save As dialog appears, prompting you to enter a new file name.

If you select the Always overwrite option, GeoExpress overwrites existing files.

WARNING: Many USGS DOQ files have the same file namewith a different extension. If you select Always
overwrite, MrSID files created frommultiple USGS DOQ files overwrite one another. LizardTech recommends
that you not use the Always overwrite feature when working with USGS DOQ images.

Default output file format
A drop-down list enables you to select the default file format to use for output files. Regular options areMrSID
Generation 4 (MG4), MrSID Generation 3 (MG3), MrSID Generation 2 (MG2) and JPEG 2000. Unless this default
is changedmanually, it is MrSID Generation 4.

You can override this behavior for MrSID and JPEG 2000 files; if you select Same as input, then the output file
format will be the same as the input file format if the input file is MG2, MG3, MG4, or JPEG 2000. For input files of
any other format, the default output format will be specified by the drop-downmenu option.
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Georeferencing

World files
Select the Use option (next toWorld Files) to haveGeoExpress use the georeferencing information in a world file
for an image or mosaic tile, rather than native georeferencing.

IMPORTANT: This option will override any coordinate reference system (CRS)metadata—including well-
known text strings (WKTs)—that may have been embedded in the file. You canmanually edit the CRS in the
imagemetadata with the Edit Metadata tool. For more information on selecting a CRS in themetadata, see
Editingmetadata on page 33.

Select Generate to automatically generate world files upon encoding.

For more information, seeWorld files on page 118.

Aux XML files
Select the Use option next to Aux XML Files to haveGeoExpress use georeferencing information in an Esri Aux
file, rather than embedded CRS metadata. Selecting this option overrides the Use World Files option if it is also
selected.

Select Generate to automatically generate Esri Aux files upon encoding. This enables you tomake sure the
georeferencingmetadata in your MrSID and JPEG 2000 imagery will be readable in Esri applications.
Error Checking
When several jobs are being encoded as a batch, errors may occur that could interrupt the encoding project. These
errors may be internal (for example, GeoExpress may encounter a corrupt or incompatible image or mosaic), or
they may be external (for example, aWindows or network error). To force GeoExpress to ignore any such error
messages and attempt to continue with the encoding project, select the Suppress Pop-Up Error Windows
During Encoding option. The error messages will be written to the log file.
ApplyMetadata to Image
If your images contain metadata for image rotation or rapid positioning capability (RPC), you canmanipulate the
output image so that it reflects the information in themetadata. You can select the following preferences for image
metadata:

NITF RPC
NITF RPC metadatamaps pixel data to location data for orthorectification. Select this option to apply the
orthorectification described in the NITF RPC to the image.

NOTE: To apply orthorectification, the NITF RPC metadatamust use theWGS 84 datum.
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Rotation
Image rotationmetadata describes the direction that an image should point. For example, an imagemight contain
metadata that rotates an image so that it points north. Select this option to create rotated images with empty
space in the corners. The empty space is compressed so that it does not add to the size of the image. This is the
default setting so that your images are displayed with the correct orientation even in viewers that do not support
metadata for image rotation.

The following figure shows a rotated image:

The black areas represent the parts of the image that do not contain data values. In MrSID Generation 4 images,
the no-data values are stored in the alpha band. For more information on alpha bands, see Alpha bands andMrSID
on page 76.
Seamlines
For raster mosaics, you can choose to generate a shapefile representing the tiles that make up the image. When
viewed in an appropriate application (such as GeoViewer), you can overlay the shapefile on the output image to
identify the original tile positions.

Select this option to have the default for raster mosaics include a seamlines shapefile in the output.
ConcurrencyControl
If you runGeoExpress on a system with multiple processor cores, GeoExpress creates multiple threads to
process jobs more quickly. You can set the following preferences for concurrency:

l Concurrent jobs. Themaximum number of jobs that GeoExpress can run at the same time. Each job uses
one or more threads. If the number of concurrent jobs exceeds the number of total threads, GeoExpress
does not run the full number of concurrent jobs.

l Total threads. The number of threads that GeoExpress uses. GeoExpress always uses the total number of
threads available regardless of the number of jobs.

Themaximum number of concurrent jobs and total threads that you can set equals the number of processor cores
in your system. For example, if your system has six cores, you can run amaximum of six concurrent jobs and six
threads. By default, the number of concurrent jobs and total threads equals themaximum.

If you reduce the number of total threads, GeoExpress uses fewer cores. Reduce the number of total threads
when you want to perform other processor-intensive tasks on the system that runs GeoExpress.

NOTE: Prior to GeoExpress 9.5.5, themaximum number of threads and concurrent jobs that could be run was
8. In version 9.5.5 and later, these are only limited by the number of processor cores on your system.
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Concurrency Example
You have 12 jobs that you want to run on a system with six cores. The following list describes how GeoExpress
runs the jobs for various preference combinations:

l If you set the number of concurrent jobs to six and the number of threads to six, GeoExpress runs six jobs at
a time and allocates one thread to each job. Use this combination for optimal performance.

l If you set the number of concurrent jobs to three and the number of threads to six, GeoExpress runs three
jobs at a time and allocates two threads to each job.

l If you set the number of concurrent jobs to six and the number of threads to three, GeoExpress runs three
jobs at a time and allocates one thread to each job. BecauseGeoExpress uses one thread for each job,
GeoExpress cannot run the full number of concurrent jobs.

GeoExpress continues running as many concurrent jobs as possible until it finishes all 12 jobs.
Appearance preferences
The Appearance tab of the Preferences dialog allows you to change the color and width of lines and highlights
that are applied in the Image Crop, Area of Interest, and Color Balance Tile Selector dialogs. Colored
rectangles display the color currently selected.

To change a color, click on the appropriate color swatch. Use theWindows color picker to choose a new color,
then click OK.

To change a line width, enter the desired value in the appropriate Line Width field.
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MrSID preferences
This page describes the preference options for MrSID Generation 4 (MG4), MrSID Generation 3 (MG3) andMrSID
Generation 2 (MG2).

You can set the following preferences for MG2, MG3, andMG4 files:
l Compression ratio preferences. For more information on compression ratios, see Features in Depth on
page 30.

l Zoom levels preferences. For more information on zoom levels, see Zoom options on page 75.
l Advanced preferences. For more information on advanced options such as weight and block size, see
Format-specific options on page 81, AdvancedMG3 options on page 85, and AdvancedMG2 options on
page 86.

TheMrSID Generation 3 (MG3) andMrSID Generation 4 (MG4) preferences mirror the settings found in theMG3
andMG4 format-specific options on the Advanced Job Options dialog, with the exception that a default
compression ratio can be specified for both color and grayscale images. When you add a new MG3 orMG4
encode job, the compression settings are initially set to the values declared on this tab. The effects of these
options can be simulated on the Job Output panel.
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The preference options for MG3 andMG4 are the samewith the following exceptions:
l Compression Ratio preferences for MG4 include a setting for Multispectral.
l ForMG4, the Compression Ratio can be set to default to Lossless for RGB, Grayscale, and
Multispectral.

l AdvancedMG4 preference options include the Apply RGB Color Transform to First Three Bands setting
that allows you to specify that multispectral files whose first three bands are R, G, and B (in that order)
should have this transform run on them. (This option is enabled by default.)

l AdvancedMG4 preference options include two Alpha Source options, one to specify that all pixels are
opaque and one to specify that the transparency or nodata value should be automatically detected from the
imagemetadata. Using the Transparency Value is enabled by default.

l AdvancedMG4 preference options include Dynamic RangeMetadata Generation options. For more
information on generating dynamic rangemetadata, see Dynamic RangeMetadata Generation on page 83.

l AdvancedMG3 preference options include selecting either the 1-pass or 2-pass optimizer.

TheMrSID Generation 2 preferences mirror the settings found in theMG2 format-specific options on the
Advanced Job Options dialog, with the exception that a default encode ratio can be specified for both color and
grayscale images. When you add a new MrSID Generation 2 encode job, the encode settings will initially be set to
the values declared in this tab.



Chapter 5: Features in Depth

– 113 –

JPEG 2000 preferences
If you want to use JPEG 2000 as your default file output, select either JPEG 2000 (GMLJP2) or JPEG 2000
(Part I) from the Default Output File Format drop-down list on the General tab of the Preferences dialog.

The JPEG 2000 tab of the Preferences dialog has a number of basic JPEG 2000 options, as shown below. These
are the same options as those available for MrSID encoding. For more information on compression, see Features
in Depth on page 30. For more information on zoom levels, see Zoom options on page 75.
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Click the Advanced Settings button for further options.

The parameters set on the tab and dialog shown above determine the default options that appear in the Advanced
Job Options dialog, which includes all of these. Changes made on the Advanced Job Options dialog only affect
the current job. To change the default settings, the parameters must be changed here.

For details about the advanced options see Advanced JPEG 2000 options on page 88.
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LiDAR preferences
Set default preferences for LiDAR data in the LiDAR tab of the Preferences dialog.

The LiDAR tab is divided into three panes:
l Compression
l Text Parsing
l Viewing

Compression
Set general compression preferences for LiDAR data.

Compression ratio
How much you want to compress the data. Depending on the compression ratio, the resulting file may have fewer
points than the original point cloud. You can also select Lossless to create a compressed point cloud identical to
the input point cloud.

Block size
The number of points to process and store at one time. Enter a large block size to increase the compression
speed. Enter a small block size to decreasememory usage. Valid values are from 2048 through 16384. The
default value is 4096.

Omit custom VLR metadata
Omit custom variable length record (VLR) metadata from LAS files. VLR metadata can include vendor-specific
data, user-specified data, andmore.
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Text Parsing
Set options for LiDAR point clouds stored as text files.

Map columns
If you select this option, GeoExpress displays a dialog that you can use to select columns from the input text file
andmap their values to standard fields like X, Y, Z, intensity, andmore.

Read the whole file
Select this option to haveGeoExpress read all of the data in the input text file to determine properties like the point
cloud extents and to enable previewing the file.

Manage Custom Fields
Click Manage custom fields to see the default fields available for LiDAR point clouds and to create custom
fields. For example, youmay want to create a custom field for a non-standard time format, for sensor information,
andmore.

Viewing
Set preferences for previewing LiDAR files.

Number of Points to Render
Enter the number of points to display when you preview the point cloud. Enter a large value to display more detail.
Enter a low value to display point clouds faster. Theminimum value is 50,000 and the default value is 500,000.

NOTE: While previewing a LiDAR file, you can changemany settings temporarily; seeOutput Preview panel
on page 19.

Viewing and using log information
You can access log information for GeoExpress encoding and publishing operations in the log folder or directly
from theGeoExpress graphical user interface (GUI).

Accessing text files in the log folder
By default, text files containing log records are located in My
Documents\LizardTech\GeoExpress\<version>\logs (where <version> is the version number of
GeoExpress). You can change the location of the log files in the Preferences dialog.

The log folder contains separate logs for completed encoding and completed publishing jobs.

Encoding jobs are recorded in the GeoExpress_log.txt and session_log.txt files. GeoExpress_
log.txt is a persistent log that is appended with each encoding operation the user runs, whereas session_
log.txt is a temporary log that lists only the images that were encoded in the current job. It is overwritten upon
each new encoding operation.

Publishing jobs are recorded in the GeoExpressPublish_log.txt and publish_session_log.txt files.
As with their encoding counterparts, GeoExpressPublish_log.txt is a persistent record of publishing
operations that grows over time, while publish_session_log.txt records only the last completed publishing
job.
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Accessing and using session records in the GUI
Viewing encoding results
A description of recently completed encoding projects can be viewed on the Job Progress panel for a selected
job.
1. Click the Job Progress tab.

The session log is displayed at the bottom of the panel.
2. Use the scroll bar to locate information about a specific image.

TIP: If you select a job in the Job List while you view the Job Progress tab, the session log only shows
information about the selected job.

Exporting the session log
Click the Export Log button to save the session log for a selected job. You can export the session log to a .csv
or .txt file.
Viewing results for a publishing operation
Upon completion of a publishing operation, the text window of the Publish Images dialog reports the results of the
publishing operation. This is the same information logged in the GeoExpressPublish_log.txt and
publish_session_log.txt files.
Copying text from log entry
Youmay wish to copy information from the log entry and paste it elsewhere. Use the standardWindows copy
(Ctrl+C) and paste (Ctrl+V) shortcuts on any text in the Session Log text box of the Job Progress tab.
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Chapter 6: Additional Operations
Publishing to Express Server
You can useGeoExpress to publish images directly to Express Server. Express Server supports MG4, MG3,
MG2, and JPEG 2000 images. Publishing is a one-time operation that does not use project files and does not alter
or delete the source images.

To publish existing images:
1. Choose Tools > Publish images.
2. Add images to the Source Images list: click Add Images To Publish, or drag files into the Publish

Images window.
3. When you finish adding images, click Publish to Express Server.

This opens the Express Server browser. For more information, see Selecting an Express Server on
page 66.

4. Click OK to begin the publishing process.
The Publish Image dialog changes to display two progress bars. The bottom barmonitors the publishing
progress of an individual image and the top bar monitors the aggregate progress of all the images in a job.

To cancel the operation, click either Cancel All or Cancel Current Image.

Viewing Results
The results of a publishing operation are displayed in the Publishing dialog.

You can also view the results by opening the log files stored at <User
directory>\Documents\LizardTech\GeoExpress\<version>\logs.

There are two log files related to publishing:
l GeoExpressPublish_log.txt is a running log of all publishing operations.
l publish_session_log.txt is a temporary log that only lists the images published in themost recent
publishing operation.

For more information see Viewing and using log information on page 116.

World files
A “world file” is a simple text file containing auxilliary georeferencing information for an image. It can be used to
georeference an image that has no georeferencing information within it, or to override existing georeferencing
information.

By convention, the filename for a world file is the same as the image it pertains to, with a different extension. The
three-letter extension is made up of the first and last characters of the image filename extension, followed by a w.
For example, the world file for a TIFF image named bainbridge.tif would be bainbridge.tfw; the world
file for aMrSID image named madison.sid would be named madison.sdw.

Generating world files
Select World Files: Generate on the General tab of the Preferences dialog to automatically generate world
files upon encoding.

Format
The world file format is six lines, each line containing a double precision value (represented in text). No additional
lines may be present. Leading and trailing white space are allowed.
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Themeanings of the six values are:
1. dimension of a pixel in map units in x direction
2. first rotation term
3. second rotation term
4. dimension of a pixel in map units in y direction
5. x-coordinate of the center of the upper-left pixel
6. y-coordinate of the center of the upper-left pixel

The y-dimension is, by convention, a negative value.

GeoExpress ignores the rotation term inmost cases.

Example
This is an example of a world file:

  0.20000000
  0.00000000
  0.00000000
 -0.20000000
780.10000000
219.90000000

This world file indicates the image resolution is (0.2, -0.2) and the upper-left is at (780.1, 219.9). The rotation terms
are zero, meaning no rotation is required.

Using world files
Once you have added imagery to the Job List, you should check its extents on the Job Properties tab tomake
sure it has the proper positioning. If it does not, check for the presence of world files in the source directory. If
there are world files, you can instruct GeoExpress to use them.

To specify that world files should be used:
1. Select an image in the Job List and click the Advanced button on the Job Properties tab.

This opens the Advanced Job Options dialog.
2. Select the Input tab.
3. Select Use World Files.
4. Click OK.

IMPORTANT: Use of world files removes the CRS or other georeferencing information from the image.

TIP: If no world file exists or if using world files does not result in correct positioning, you can change the image
extents by editing the imagemetadata. For more information see Raster metadata on page 33.
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Generating Esri AUX files
AUX files are used in older Esri products in the ArcGIS suite to specify coordinate reference system information.
They have the extension .aux. Youmay want to generate Esri AUX files if your imagery will be used in Esri
ArcGIS 9.1 or earlier.

To generate Esri AUX files:
1. ChooseOptions > Preferences.
2. Select Generate next to Aux XML Files in the Georeferencing group of options.
3. Click OK.

AUX files will now be generated upon encode and output to the same folder as the output images.

To stop generating Esri AUX files, deselect the Generate option.

By default Esri AUX files are not generated.
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Appendix A: File Formats
Supported input file formats
This table describes the file formats of the images that you can add to the Job List.

FILE FORMAT
FILE

EXTENSION
SUPPORTED
DATA TYPES

SUPPORTS
MULTISPECTRAL? NOTES

BIPF .bpf N/A Binary Point File, commonly
used for Geiger Mode LiDAR
images.

CADRG The most
common
extension is
.toc

8-bit unsigned No

DTED .dt0, .dt1,
.dt2

16-bit signed, 32-bit
floating point

No (limited to one
band)

ECW .ecw 8-bit unsigned Yes Earth Resoure Mapping’s
Enhanced Compression
Wavelet format.

ERDAS
IMAGINE

.img 8-bit and 16-bit
signed and
unsigned, 32-bit
floating point

Yes GeoExpress supports color
lookup tables (CLUTs) with 8-
bit per sample RGB color
values.

ERDAS LAN .lan 8-bit unsigned Yes In 4-band LAN images,
bands 2, 3, and 4 are
interpreted as Red, Green,
and Blue, respectively.

JPEG .jpg, .jpeg 8-bit unsigned No, limited to 3 bands Requires a world file for
georeferencing.

JPEG 2000 .jp2, .jpc 8-bit and 16-bit
signed and
unsigned

Yes Multiple bands supported or
all color spaces.

LAS .las N/A This is a binary,
uncompressed LiDAR point
cloud format. GeoExpress
supports LAS versions 1.0–
1.3, with experimental
support for LAS 1.4.

LAZ .laz N/A This is a binary, compressed
LiDAR point cloud format.

MrSID
Generation 2
(MG2)

.sid 8-bit and 16-bit
unsigned, 32-bit
floating point

No 4 bands are supported for
CMYK input only.

MrSID Gen 3
(MG3)

.sid 8-bit and 16-bit
unsigned

No 4 bands are supported for
CMYK input only.
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FILE FORMAT
FILE

EXTENSION
SUPPORTED
DATA TYPES

SUPPORTS
MULTISPECTRAL? NOTES

MrSID Gen 4
(MG4) LiDAR

.sid N/A This is a binary,
uncompressed LiDAR point
cloud format.

MrSID Gen 4
(MG4) Raster

.sid 8-bit and 16-bit
signed and
unsigned, 32-bit
floating point

Yes, up to 255 bands Multiple bands supported for
all color spaces.

NITF 2.0, 2.1. .ntf 8- and 16-bit signed
and unsigned

Yes Only supports
uncompressed, JPEG
compressed, and JP2
compressed data.

PCIDSK .pix 8-bit and 16-bit
signed and
unsigned, 32-bit
floating point

Yes Does not support mixed data
type, RPC segments, GCP
segments, or Color Lookup
Tables.

PNG .png 8-bit and 16-bit
unsigned

No Requires a world file for
georeferencing.

Raw
(uncompressed)
BBB files (BIL,
BIP, and BSQ)

.bil, .bip,
.bsq

8-bit and 16-bit
signed and
unsigned, 32-bit
floating point

Yes

Sun Raster .ras, .rast 8-bit unsigned No

Text The most
common
extension is
.txt.

N/A Also known as ASCII files.
These are plain-text files with
delimiters for point clouds.

TIFF/GeoTIFF .tif, .tiff,
.tfw

8-bit and 16-bit
signed and
unsigned, 32-bit
floating point

Yes For more information on
supported TIFF compression
formats, see Supported TIFF
compression types on
page 126.

USGS DOQ .nes, .ses,
.nws, .sws,
.doq

8-bit unsigned No Both the old and new USGS
DOQ formats are supported
and can be combined in
mosaics.

Windows BMP .bmp 8-bit unsigned No Requires a world file for
georeferencing. Only
supported on Windows.
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Supported output file formats
Many of the options available to you in GeoExpress vary depending on the output format that you select.
Additionally, the options available depend on whether the file is a raster file or a LiDAR point cloud file.

GeoExpress supports the following output formats:
l MrSID Generation 4 (MG4), MrSID Generation 3 (MG3), MrSID Generation 2 (MG2)
l JPEG 2000 (Part I), JPEG 2000 (GMLJP2)
l NITF 2.1 (Raw), NITF 2.1 (JPEG 2000)
l GeoTIFF
l LAS
l LAZ
l BPF

MrSID
TheMrSID format is a proprietary format developed by LizardTech that supports lossy and lossless compression.
There are several generations of theMrSID file format. Additionally, for the latest generation, MrSID Generation 4
(MG4), there is a version that supports raster and a version that supports LiDAR.

The raster version of MG4 supports multispectral data, per-band compression, custommetadata, and advanced
imagemanipulation features. The format is widely supported across GIS software packages. The LiDAR version
of MG4 stores compressed point clouds in an accessible format meant to address some of the problems with
storing and accessing large LiDAR point clouds.

For both raster and LiDAR data, if you’re not sure which file format to select, youmay want to select
MrSID Generation 4.

JPEG 2000
The JPEG 2000 format is an open standard that provides superior compression compared to the original
JPEG format.The JPEG 2000 (Part I) format uses the original JPEG 2000 specification which is more widely
supported. The JPEG 2000 (GMLJP2) format includes support for geographic markup language (GML). Use the
JPEG 2000 (GMLJP2) format when you need to create JPEG 2000 files that contain coordinate reference
systems (CRS), topology, and other geographic features.

For a comparison of MrSID and JPEG 2000 files, see Comparison of compressed output formats on page 125.

NITF
The NITF format is a container that can include an image, imagemetadata, and other graphics. GeoExpress
supports creating NITF files that contain raw or JPEG 2000 images.The NITF format is the standard for various
departments of the United States government. Use the NITF format when your organization requires
NITF metadata.

GeoTIFF
TheGeoTIFF format embeds georeferencingmetadata into TIFF images. In GeoExpress, you can only create
GeoTIFF files fromMrSID input files, and you can only create uncompressedGeoTIFF files. Use the
GeoTIFF format when youmight need to view your image in an image viewer that does not support GIS. Any
image viewer that can read TIFF files will display GeoTIFF images. If the viewer does not support the
georeferencingmetadata, themetadata is ignored. GeoTIFF is generally an uncompressed file format.

LAS
The LAS format is one of themost commonly used LiDAR file formats, and can be read in virtually any application
that support LiDAR point clouds. LAS is a public, uncompressed file format maintained by the American Society
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for Photogrammetry and Remote Sensing (ASPRS). GeoExpress can write LAS 1.0 through 1.4 files.

When you create a LAS file from another LAS file, GeoExpress uses the same version of LAS. For example, if the
input file is a LAS 1.1 file, GeoExpress creates another LAS 1.1 file. If you write a LAS file fromMrSID or from
another format, the version of LAS that GeoExpress uses depends on the contents of the file. If the file contains
features unique to a specific version of LAS, GeoExpress uses that particular version.

LAZ
The LAZ format is a compressed format for LiDAR point clouds. LAZ is an open-source file format developed by
Martin Isenberg at RapidLasso.

GeoExpress does not support LAZ output from a LAS 1.4 file that includes records 6–10.

BPF
Binary Point File (BPF) serves as a lightweight, quick, binary file format for the storage of unorganized point cloud
data. It is commonly used in Geiger Mode LiDAR imagery.

Lossy and lossless compression
Youmay compress your images “losslessly” (using lossless compression) or “lossily” (using lossy
compression). Lossless compression preserves all data. Lossy compression discards some data in order to
achieve smaller file sizes. For the purposes of real workflows, however, it is useful to think of GeoExpress as
offering three categories of image quality: lossless, visually lossless, and lossy.

Lossless
Lossless compression retains all source image data. No data is discarded. This level of compression typically
yields a 2:1 compression ratio, for a 50% reduction in the space required to store the image. Lossless
compression should be used when it is critical that all bits of the original image be preserved. This is the case for
archival storage, as well as for uncommonworkflows where no possible loss of precision is ever acceptable. You
may also wish to use lossless compression when you are generating a “master” image from which other derivative
images will bemade, as through theMrSID optimization process. From a lossless MrSID or JPEG 2000 file, the
original TIFF or other raw file can be reassembled identically, bit-for-bit.

NOTE: When you use the lossless option to recompress an image that has already been compressed lossily, it
means that no further loss of data will occur. It is helpful to remember that in lossless compression all image
data from the source image is retained.

Visually lossless
This is actually a form of lossy compression, and the name is not intended tomislead. Visually lossless
represents the limit of data that can be discarded before the human eye can detect any degradation in image
quality. This level of compression is typically 20:1 for RGB and 10:1 for grayscale imagery. This is themost
common level of compression quality used, as it preserves the appearance of the imagery for most workflows,
including use of your imagery as a background layer and for many forms of visual analysis and exploitation.

Lossy
Beyond 20:1, image degradation and artifacts can appear, although often not too significantly until ratios of 40:1 or
50:1. Such lossy quality may be acceptable when the imagery is used only as a background layer for appearance
or when the image quality is less important than the storage size or speed, such as for informal visual inspections.
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Comparison of compressed output formats
For raster images, GeoExpress can create compressed images in theMrSID and JPEG 2000 formats. Because
the NITF format can contain JPEG 2000 files, you can also create compressed NITF files. For LiDAR data,
GeoExpress can create compressed files in theMrSID and LAZ formats. For LiDAR data, LAZ files can only be
created using lossless compression. MrSID files are lossless by default, but you can also specify a compression
ratio to create lossy files.

TIP: Select an image in the job list to view the file format, output file size, andmore in the Job Properties
panel.

Compressed Raster Formats
The following table compares some of the features supported by the raster output formats:

OUTPUT FORMAT

FEATURE MG2 MG3 MG4
JPEG
2000

Lossy output with a maximum of 3 bands, cropping, no advanced encoding,
output file smaller than 2GB

Advanced encoding (such as reprojection, color balancing, despeckling, and
Area of Interest encoding)

Output file size larger than 2GB

Lossless output

Mosaic that uses MrSID files as input

Multispectral output

Arbitrary band mapping

Per-band compression

Compressed LiDAR Formats
The following table compares some of the features supported by the LiDAR output formats:

OUTPUT FORMAT
FEATURE LAZ LAS BPF MG4

Lossless compression

Using a specified compression ratio

Creating mosaics

Formore information on output formats, see Supported output file formats on page 123.
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Supported TIFF compression types
The Job Properties panel provides information about the input images used in a project. Information about any
TIFF compression technique used in the input images is also provided, even if the technique is not supported by
GeoExpress.

The following table lists TIFF compression types displayed by GeoExpress and whether the compression type is
supported by GeoExpress.

COMPRESSION SUPPORT

CCITT Group 3 fax No

CCITT Group 4 fax No 1

LZW (Limpel-Ziv-Welsh) Yes

Old JPEG No

Standard JPEG (including 12-bit) Yes

NeXT run-length encoding No

CCITT run-length encoding Yes 2

Pixar image format No

Desktop color separation No

Standard JBIG No

Pack-bits encoding Yes

ThunderScan No

Deflate method (PNG) No

1GeoExpress is able to process single-pageGroup 4 TIFF files, but encoding this format is not recommended.

2 There aremany different types of run-length encoding. Somemethods are supported; others are not.
GeoExpress works best with uncompressed images.
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Sample MrSID metadata
Following is the header metadata from a sampleMrSID image.

Record 0:
Tag: GEOTIFF_CHAR::GTModelTypeGeoKey
Type: ASCII[1]
Data:
[0]: ModelTypeProjected
Record 1:
Tag: GEOTIFF_CHAR::GTRasterTypeGeoKey
Type: ASCII[1]
Data:
[0]: RasterPixelIsArea
Record 2:
Tag: GEOTIFF_CHAR::GeogEllipsoidGeoKey
Type: ASCII[1]
Data:
[0]: Ellipse_GRS_1980
Record 3:
Tag: GEOTIFF_CHAR::GeogGeodeticDatumGeoKey
Type: ASCII[1]
Data:
[0]: Datum_North_American_Datum_1983
Record 4:
Tag: GEOTIFF_CHAR::ProjLinearUnitsGeoKey
Type: ASCII[1]
Data:
[0]: Linear_Meter
Record 5:
Tag: GEOTIFF_CHAR::ProjectedCSTypeGeoKey
Type: ASCII[1]
Data:
[0]: PCS_NAD83_UTM_zone_10N
Record 6:
Tag: GEOTIFF_NUM::1024::GTModelTypeGeoKey
Type: UINT16[1]
Data:
[0]: 1
Record 7:
Tag: GEOTIFF_NUM::1025::GTRasterTypeGeoKey
Type: UINT16[1]
Data:
[0]: 1
Record 8:
Tag: GEOTIFF_NUM::2050::GeogGeodeticDatumGeoKey
Type: UINT16[1]
Data:
[0]: 6269
Record 9:
Tag: GEOTIFF_NUM::2056::GeogEllipsoidGeoKey
Type: UINT16[1]
Data:
[0]: 7019
Record 10:
Tag: GEOTIFF_NUM::3072::ProjectedCSTypeGeoKey
Type: UINT16[1]
Data:
[0]: 26910
Record 11:
Tag: GEOTIFF_NUM::3073::PCSCitationGeoKey
Type: ASCII[1]
Data:
[0]: Universal Transverse Mercator; North American 1983; GRS80; Zone Number 10N
Record 12:
Tag: GEOTIFF_NUM::3076::ProjLinearUnitsGeoKey
Type: UINT16[1]
Data:
[0]: 9001
Record 13:
Tag: GEOTIFF_NUM::3080::ProjNatOriginLongGeoKey
Type: FLOAT64[1]
Data:
[0]: -123.000000
Record 14:
Tag: GEOTIFF_NUM::3081::ProjNatOriginLatGeoKey
Type: FLOAT64[1]
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Data:
[0]: 0.000000
Record 15:
Tag: GEOTIFF_NUM::3082::ProjFalseEastingGeoKey
Type: FLOAT64[1]
Data:
[0]: 500000.000000
Record 16:
Tag: GEOTIFF_NUM::3083::ProjFalseNorthingGeoKey
Type: FLOAT64[1]
Data:
[0]: 0.000000
Record 17:
Tag: GEOTIFF_NUM::3092::ProjScaleAtNatOriginGeoKey
Type: FLOAT64[1]
Data:
[0]: 0.999600
Record 18:
Tag: IMAGE::INPUT_FILE_SIZE
Type: FLOAT64[1]
Data:
[0]: 75121662.000000
Record 19:
Tag: IMAGE::INPUT_FORMAT
Type: ASCII[1]
Data:
[0]: GeoTIFF
Record 20:
Tag: IMAGE::INPUT_NAME
Type: ASCII[1]
Data:
[0]: H:\Seattle\10tet279287.tif
Record 21:
Tag: IMAGE::WIDTH
Type: UINT32[1]
Data:
[0]: 5000
Record 22:
Tag: IMAGE::HEIGHT
Type: UINT32[1]
Data:
[0]: 5000
Record 23:
Tag: IMAGE::COLOR_SCHEME
Type: UINT32[1]
Data:
[0]: 0
Record 24:
Tag: IMAGE::DATA_TYPE
Type: UINT32[1]
Data:
[0]: 0
Record 25:
Tag: IMAGE::NO_DATA_VALUE
Type: UINT8[3]
Data:
[0]: 0
[1]: 0
[2]: 0
Record 26:
Tag: IMAGE::TRANSPARENT_DATA_VALUE
Type: UINT8[3]
Data:
[0]: 0
[1]: 0
[2]: 0
Record 27:
Tag: IMAGE::XY_ORIGIN
Type: FLOAT64[2]
Data:
[0]: 527900.150000
[1]: 5230199.850000
Record 28:
Tag: IMAGE::X_RESOLUTION
Type: FLOAT64[1]
Data:
[0]: 0.300000
Record 29:



Appendix A: File Formats

– 129 –

Tag: IMAGE::Y_RESOLUTION
Type: FLOAT64[1]
Data:
[0]: 0.300000
Record 30:
Tag: IMAGE::WKT
Type: ASCII[1]
Data:
[0]: PROJCS["NAD83 / UTM zone 10N",GEOGCS["NAD83",DATUM["North_American_Datum_1983",

SPHEROID["GRS 1980",6378137,298.2572221010002,AUTHORITY["EPSG","7019"]],
AUTHORITY["EPSG","6269"]],PRIMEM["Greenwich",0],UNIT["degree
(supplier to define representation)",0.01745329251994328]
,AUTHORITY["EPSG","4269"]],PROJECTION["Transverse_Mercator"],
PARAMETER["latitude_of_origin",0],PARAMETER["central_meridian",-123],
PARAMETER["scale_factor",0.9996],PARAMETER["false_easting",
500000],PARAMETER["false_northing",0],UNIT["metre",1,
AUTHORITY["EPSG","9001"]],AUTHORITY["EPSG","26910"]]
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Appendix B: File Sizes and Memory Usage
Calculating memory usage
The amount of memory that GeoExpress uses to perform operations depends on the following factors:

l The imagemanipulation operations that you perform.
l The operating system.
l The image input format.
l The number of bands in the output image.
l The number of threads and concurrent jobs.
l The strip height and block size.

Of these factors, you can control the strip height and the block size that GeoExpress uses.

Memory usage is constant over the length of the encode operation.

Estimated memory usage display
The Estimated Memory Usage value is displayed on the Job Properties panel except when the output format is
other thanMrSID or the 1-pass optimizer is used. GeoExpress uses the 2-pass optimizer by default.

MG3 and MG4 memory usage
The following formula describes the approximate amount of memory used by GeoExpress to compress a single
image to theMrSID Generation 4 (MG4) or MrSID Generation 3 (MG3) format:

Memory = ((8 + 4 × BlockSize + MIN(StripHeight, BlockSize)) × 4 +
StripHeight) × NumBands × Width

The following list describes the variables used by the formula:
l Memory is the estimatedmemory usage in bytes.
l You set BlockSize on the Format-Specific tab of the Advanced Job Options dialog. For more
information on block size, see Block Size on page 82.

l MIN(StripHeight, BlockSize) evaluates the values for the strip height and block size and equals
whichever value is smaller.

l You set StripHeight on the Format-Specific tab of the Advanced Job Options dialog. For more
information on strip height, see Strip Height on page 83.

l NumBands is the number of bands in the image to be encoded—typically 1 or 3. (This value is noted in the
Job Properties panel.)

l Width is the width of the input image in pixels. (This value is noted in the Job Properties panel.)

MG2 memory usage
The following formula describes the approximate amount of memory used by GeoExpress to compress a single
image to theMrSID Generation 2 (MG2) format:

Memory = ((8 + 4 × BlockSize + 64) × NumBands × Width × 4) +
(0.005 × ExpectedOutputFileSize)

l Memory is the estimatedmemory usage in bytes.
l You set BlockSize on the Format-Specific tab of the Advanced Job Options dialog. For more
information on block size, see Block Size for MG2 on page 86.

l NumBands is the number of bands in the image to be encoded—typically 1 or 3. (This value is noted in the
Job Properties panel.)

l Width is the width of the input image in pixels. (This value is noted in the Job Properties panel.)
l ExpectedOutputFileSize is the target file size. (This value is noted in the Job Properties panel.)
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How mosaic sizes are calculated
The size of amosaic is calculated from the “nominal size” of the output mosaic, which is not the same as the file
size.

For raster images, the nominal size is the product of the output image width, the image height, the number of
bands, and the number of bytes per band. The nominal size assumes that all portions of the image include valid
data, whether or not this is the case. (No-Data areas, areas outside a cropped image, and gaps between tiles are
not considered part of the image, and areas of overlap are only counted once as part of the image.)

For LiDAR point clouds, the nominal size is ameasure of the number of points in the point cloud and the number of
fields for each point.

As a result, the size is not adjusted for the presence of transparency regions in themosaic, such as when:
l amosaic of non-contiguous images is created
l the output image for a contiguous mosaic does not conform to a rectangular shape

In these cases, the transparency regions in the output image are included in themosaic size. Also in these cases,
the estimated output file sizemay be considerably larger than the actual output file size.

NOTE: The cost charged to the data cartridge is not always equal to themosaic size. It is calculated from the
sum of the nominal sizes of the input tiles rather than from the nominal size of the resultingmosaic.

Calculating MrSID Area of Interest weight
GeoExpress calculates the resultant image filesize as part of the encoding process, taking into account the user-
defined compression ratios for inside and outside the Area of Interest. Selecting theWeight option allows you to
specify Lossless compression or to set a target Compression Ratio for the Area of Interest. (The outside area
will be encoded at the compression ratio specified in the job options.)

As an example, consider a 1-band (grayscale), 8-bit input imagemeasuring 1000 × 1000 pixels. The user specifies
compression for this image at 100:1. An Area of Interest measuring 100 × 100 pixels is then defined within the
image, and the compression ratio inside the Area of Interest is set at 10:1.

Based on these dimensions and specifications, GeoExpress makes the following calculations:
AOI compression ratio (CRAOI) = 10
Base compression ratio for the image (CRother) = 100
Area of the entire image (Areatotal) is 1000 × 1000 pixels = 1,000,000 pixels
Area of the AOI (AreaAOI) is 100 × 100 pixels = 10,000 pixels
Area of the portion of the image surrounding the AOI (Areaother) is 1,000,000 pixels - 10,000 pixels
= 990,000 pixels
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GeoExpress thenmakes the following filesize calculations:
Filesize of the AOI (FSAOI) = AreaAOI / CRAOI = 10,000 / 10 = 1000 bytes
Filesize of the “outside” (FSother) = Areaother / CRother = 990,000 / 100 = 9900 bytes
Total filesize (FStotal) = FSAOI + FSother = 1000 + 9900 = 10,900 bytes

GeoExpress then calculates the overall compression ratio:
Compression ratio = Areatotal / FStotal = 1,000,000 / 10,900 = 91.73

In order to calculate the overall target filesize for the encode process the compression ratio for the overall image is
set to 91.73. The target filesize thus becomes:

1,000,000 / 91.73 = 10,901 bytes

NOTE: This calculated filesize appears on the Job Properties panel for the image once you close the Area of
Interest dialog. The actual output is reported in the GeoExpress log file on the Job Progress panel (see
Viewing and using log information on page 116).
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Appendix C: Data Cartridges and Floating
Licenses
Data cartridges
If you have a copy of GeoExpress Standard Edition, youmay need to install a data cartridge before being able to
encode images.

To order a data cartridge, contact LizardTech at https://www.lizardtech.com/sales/purchase/.

The information below tells you how to access cartridge information and add a cartridge.

For more information see Installing data cartridges on page 9.

Data cartridge information
The License and Cartridge Management dialog displays cartridge information and lets you add a cartridge or
connect to an Express CartridgeManager Server as shown below.

To access License and Cartridge Management chooseOptions > Licensing.

Cartridges
The Cartridges section shows the Cartridge ID or, if a Data Cartridge Server is being used to share a data
cartridge, it shows the address of the Server. You can only use either a local cartridge or a cartridge server, not
both.

The bottom of the panel shows how much data remains on your cartridge.

To add a local data cartridge that you have received from LizardTech, click Import in the Cartridges panel, select
the .ltc file and click Open.

https://www.lizardtech.com/sales/purchase/
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Calculating usage
The number of megabytes deducted for a job is approximately equal to the “nominal size” of the image or point
cloud. For raster images, you can calculate the nominal size with the following equation:

width × height × number of bands × bytes per band
Note that the nominal size does not include areas of No-Data, so this equation yields amaximum nominal size.

For LiDAR point clouds, the nominal size is ameasure of the number of points in the point cloud and the number of
fields for each point.

For mosaics, the cost is calculated from the sum of the nominal sizes of the input tiles rather than from the
nominal size of the resultingmosaic. This means that in cases where amosaic of non-contiguous images is
created you are not charged for the areas without tiles. (You are only charged once for areas where tiles overlap.)

NOTE: Because the charge is based on the nominal size of the image rather than the physical input file size,
the encoding of compressed images such as JPEG deducts the cartridge by the same amount as the encoding
of input images that are not compressed.

Floating licenses
Floating licenses enable a user on a networked computer to lease or “check out” a GeoExpress license for the
period of time they are working. When the user exits the program, the license is returned to the License Server and
available for another user.

OnWindows, the LizardTech License Server runs as a service named LizardTech License Server.

Windows
Install the License Server
1. Download the LizardTech License Server from the LizardTech website.
2. Run setup.exe.
3. Follow the wizard steps to install the license server.

When installation is complete, the License Server Utility will start. You can request a license immediately,
or follow the steps below to add a license at anytime.

NOTE: For additional information on the setup and usage of LizardTech License Server, see the SentinelLM
System Administrator’s Online Guide installed with your License Server.

https://www.lizardtech.com/support/geoexpress/installers#toolkit
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Request a License
1. Click Start > LizardTech > Add Floating License.

This starts the License Server Utility.
2. Click Request a License.

This will open your web browser to the LizardTech Product Activation page.
3. Enter the requested information and click Submit.

n For LizardTech Product, select GeoExpress.
n Select New License.
n Paste your locking code.
n Use the Additional Information field to give any additional information about your license usage.

For example, if you have purchased 10 floating licenses but need to deploy them amongmultiple
locations, let us know how you will distribute these (“2 licenses for our Portland office, 3 for Seattle,
and 5 for London.”) This way we can send you the license files you need for each location.

Within about one business day you will receive an email from LizardTech Support that includes your license
file. Save this file on the system where you installed the License Server.

Add a License
1. Click Start > LizardTech > Add Floating License.
2. Click Import.
3. Navigate to and select the downloaded license file (*.lic), then click Open.

The License Server Utility will validate the license and display what type of license you imported.
4. Click Add License to add your new license to the license server.
5. Click Done to exit the License Server Utility.

Linux
Adding Floating Licenses under Linux
Once you have installed the License Server youmust acquire a license code from LizardTech. A license code is
required for each License Server you add to your network.

To add a license for a License Server on Linux:
1. Run the echoid file to display your locking code. On Linux this file is located by default in

/usr/local/LizardTech/LicenseServer/licenseserver/.
2. Record the value returned by echoid, then visit https://www.lizardtech.com/support/product-activation/.
3. Enter the requested information and click Submit.

n For LizardTech Product, select GeoExpress.
n Select New License.
n Paste your locking code.
n Use the Additional Information field to give any additional information about your license usage.

For example, if you have purchased 10 floating licenses but need to deploy them amongmultiple
locations, let us know how you will distribute these (“2 licenses for our Portland office, 3 for Seattle,
and 5 for London.”) This way we can send you the license files you need for each location.

You will receive a response from LizardTech within one business day.
4. When you receive your license code, run the lslic file in the same Tools directory:

Open a command line interface and enter lslic -A "license code" (where license code is the
code given to you by LizardTech; note that the quotes are required).

You canmanually add the locking code to the file
/usr/local/LizardTech/LicenseServer/licenseserver/lservrc.

Tomanually start the License Server, run the ./lserv utility.

http://www.lizardtech.com/support/product-activation/
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While using LizardTech License Server on a UNIX platform, youmust be logged in as root to:
l Start the License Server
l Change distribution criteria (for redundant servers)
l Shut down the License Server
l Turn license server logging on and off
l Turn token borrowing on and off
l Add or delete license servers from the redundant license server pool

Only the user who started the license server can stop the license server. It is strongly recommended that only the
root user administer the license server.

Select a license server
In most cases, you will not be aware of the floating license leasing process because it will occur invisibly and
automatically. If you need to, you can choose to connect to a specific license server.

To specify a preferred License Server:
1. ChooseOptions > Licensing.

This opens the License and Cartridge Management dialog.
2. Enter the IP address or network name of the license server.
3. Click OK.

Server Administration
Configuring floating and commuter licenses
As the license server administrator, youmay control the percentage of available floating license seats that can be
used as commuter licenses. That is, the number that can be checked out and used without a connection to the
network.

To configure licenses, set your LSERVOPTS system environment variable with the following:
-com <percentage>

where <percentage> is an integer between 0 and 100. Do not include a percent sign. This percentage value
determines the number of licenses that can be checked out as commuter licenses.

For example, specifying -com 0 ensures that no floating licenses can be checked out as commuter licenses,
while specifying -com 100 ensures that all floating licenses may be checked out as commuter licenses.

NOTE: The percentage value rounds down so that, for example, specifying -com 50 on a server that has 3
licenses allows only 1 license to be checked out as a commuter license.

WARNING: This environment variable affects all application licenses your license server is serving out,
whether for GeoExpress or other applications. This means users of other software applications whose licenses
you are administrating through your license server can be affected. For example, suppose you have 4 licenses
for GeoExpress and you want to make 2 of them available for commuting. Suppose also that you have 1 license
for Acme Supersoft. Specifying -com 50 will make half of your GeoExpress licenses available as you planned
but will have the additional side effect of restricting your Acme Supersoft license from being checked out (50%
rounded down of one license is 0).
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Utilities
Several utilities are available to help server administrators manage the LizardTech License Server on their
network. By default these tools and their documentation are installed from theGeoExpress DVD when you install
the License Server.

IMPORTANT: The License Server should be installed on the same subnet as any clients who wish to access
it. If your License Server is not installed on your local subnet, you will be prompted to specify the name of the
computer you wish to connect to for a floating license in the GeoExpress Licensing dialog.

Following are descriptions of other utilities included in GeoExpress that administrators are likely to need to access
and use. For more information on these utilities and on others not listed below, see the SentinelLM System
Administrator’s Online Guide installed with your License Server.

UTILITY PLATFORM DESCRIPTION

echoid All Generates a locking code.

lserv Linux Starts the server (requires administrator rights).

lservnt Windows NT Starts or stops the server (see the SentinelLM System Administrator’s Online Guide
for parameters).

loadls Windows NT Loads the License Service into NT Services.

WinAdmin.exe Windows Displays a list of servers and licenses.

lsrvdown All Stops the server (requires administration rights).

lslic All Adds a license to your license file.

lsmon All Monitors license server transactions.

lswhere All Displays a list of license servers.

Using floating licenses
Using floating licenses on a network
In most cases, you will not be aware of the license check-out process because it will occur invisibly and
automatically (see Select a license server on the previous page).

IMPORTANT: When using floating licenses a constant connection to the license server is required to perform
encodes. If network connectivity is lost, encodes will fail.
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Using commuter licenses
A commuter license is a floating license that has been disconnected from the network. If you are using a portable
(laptop) computer, as for traveling purposes, you can check out a license from a license server on your network
and then disconnect from the network. You can then useGeoExpress to encode images, nomatter where you go,
even out of the country.

NOTE: Youmust have purchased the Floating License option for GeoExpress in order to use commuter
licenses. For more information, contact your LizardTech representative
(https://www.lizardtech.com/sales#retail-sales).

To check out a commuter license, run the appropriate commuter utility as shown in the table below. These utilities
ship with GeoExpress. Instructions for using them are given below.

IMPORTANT: Youmust check in a commuter license when you are through using it (see instructions for each
utility below). If you leave a license checked out after you are finished using it, it remains unavailable for other
users.

ON THIS PLATFORM USE THIS UTILITY

Windows LizardTech’s Commuter Licensing utility or ltcommute.exe

Linux lcommute

LizardTech’s Commuter Licensing utility
Use the Commuter Licensing utility forWindows as an alternative to lcommute or ltcommute.

To check out a license using LizardTech’s Commuter Licensing utility:
1. Choose Start > Programs > LizardTech > GeoExpress > Commuter Licensing.

You can also run the executable wcommute.exe.
2. Click Single Server and specify a server name, then click OK.

You can also click Search Subnet to display available licenses.
3. Select a license and click Check Out. The license is now marked with a red check.

To check in a license using the Commuter Licensing utility:
1. Choose Start > Programs > LizardTech > GeoExpress > Commuter Licensing, or type

wcommute.exe at a command prompt.
2. Click Single Server and specify a server name, then click OK.

You can also click Search Subnet to display available licenses.
3. Select the license (it will bemarked with a red check when it is checked out) and click Check In. The

license becomes unmarked and is now available for another user.

ltcommute (or ltcommute.exe)
OnWindows, use the ltcommute utility.

To check out a license using ltcommute use the following command:
-co -s <server> -fn <feature name> -fv <feature version>

To check a license back in using ltcommute use the following command:
-ci -s <server> -fn <feature name> -fv <feature version>

https://www.lizardtech.com/sales#retail-sales
https://www.lizardtech.com/sales#retail-sales
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lcommute (or lcommute.exe)
Use the lcommute utility for Linux platforms.

The lcommute utility can be used either with parameters or interactively. To operate interactively, specify no
arguments at the command line (for more information see the System Administrator’s Online Help, distributed on
your GeoExpress DVD-ROM).

To check out a license using lcommute use the following command:
-c o -o n -s <server> -f <feature> -v <version> -d 0

IMPORTANT: Zero (0) must be used with the -d argument.

To check a license back in using lcommute use the following command:
-c i -0 n -s <server> -f <feature> -v <version>

Using Terminal Services
If you wish to useGeoExpress in a Terminal Services environment, youmust use a floating license.

Frequently Asked Questions
Questions about Data Cartridges
Formore information see Data cartridges on page 133, Licensing GeoExpress on page 10 and Installing data
cartridges on page 9.

What are data cartridges?
Data cartridges are small, binary encrypted files that enable you to encode images with GeoExpress. Cartridges
are a software-based replacement for the traditional physical dongle or hardware lock. They are generated by
LizardTech, based upon your system ID, and then emailed to you as an attached file.

How does a data cartridge work?
Data cartridges are installed through theGeoExpress user interface. The user interface displays the amount of
data in the installed cartridge and the amount of ‘encoding’ capacity remaining on the cartridge. The data cartridge
is decremented based on the amount of input data calculated by multiplying the number of pixels to be encoded
times the pixel depth.

What raster operations get charged against the cartridge?
For raster jobs, only the initial creation of MrSID and JPEG 2000 images charges the cartridge. Working with
images that are already in theMrSID or JPEG 2000 format does not decrement the data cartridge. For instance,
you can create a lossless MrSID or JPEG 2000 file, which decrements the cartridge, and then use that file to
create visually lossless compressedMrSID or JPEG 2000 files that do not charge against the cartridge.
Additionally, updatingmosaics and creatingmosaics of existingMrSID or JPEG 2000 files do not charge against
the cartridge.

What LiDAR operations get charged against the cartridge?
For LiDAR jobs, the following operations charge the data cartridge:

l Creating aMrSID image from any other file format. However, creating aMrSID image from another
MrSID image does not charge the data cartridge.

l Creating a LAZ image from a LAS image or a LiDAR text file. However, creating a LAZ image from another
LAZ image does not charge the data cartridge.

l Creating a LAS image from a LiDAR text file.

If you have an input MrSID image, you can decode the image to LAS or LAZ without charging the data cartridge.
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Can I share my data cartridge with other users in my organization?
Yes. GeoExpress has a server-based shared capacity cartridge. This is NOT a floating license (for floating license
information see below) but rather a “big bucket” of capacity that can be accessed by multiple licensed users on the
network.

Questions about Floating Licenses
Formore information see Licensing GeoExpress on page 10 and Floating licenses on page 134.

How do I specify a License Server?
Enter the License Server IP address or network name in the Licensing section of the License and Cartridge
Management window. To access this window, chooseOptions > Licensing.

Which license takes precedence when there are more than one available?
When you runGeoExpress after the temporary license has expired, the program first looks for a valid standalone
(local) license on your computer. If there is none, it looks for a valid floating license by trying to connect to a
license server on your local subnet. If it cannot find one you are prompted to either activate a permanent
standalone license or specify a license server on your local subnet or a broader network.
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Appendix D: Troubleshooting
Installation problems
Following are descriptions of several problems that could be encountered installing GeoExpress.

Invalid License Code Entered
The license code was entered incorrectly.Try re-entering it; chooseOptions > Licensing to open the License
and Cartridge Management dialog.

Themost reliable way to add the license is to import the license file. You should have received this file (with the
extension .lic) in an email from LizardTech. In the License and Cartridge Management dialog, click Import
next to the License field and select the .lic file.

If you still receive this error, you can edit the license file manually. The license code is stored in the
GeoExpress\bin directory in a file called lservrc. Open this file with a text editor and compare the 51-
character license code with the one you received from LizardTech. The code in the lservrc file can be corrected
manually, if necessary. The number sign (#) character at the end of the license code indicates the end of the code.
Although this character is not required for the license to be considered valid, it is useful for making sure that you
have copied the string completely, and we recommend that you leave it in.

License Suddenly Not Recognized
The permanent license that you received from LizardTech is keyed for a unique network card identification
number. If the network connection becomes unavailable or your network hardware configuration has changed, the
programmay not accept the license code. Restore the network connection or the original network hardware
configuration, or fill out the form at https://www.lizardtech.com/support/product-activation/ for a new permanent
license.

License Timed Out Early
If you have a temporary version of GeoExpress and the clock in your operating system has been altered—for
instance, if you have recently upgraded your system software—security features in the licensing softwaremay not
allow the program to run. Please contact technical support at https://www.lizardtech.com/support.

http://www.lizardtech.com/support/product-activation/
https://www.lizardtech.com/support
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Encoding problems
If you set a low weight value for an image with low color contrast, youmay notice the following pattern of light and
dark spots across your image:

The following factors contribute to the creation of this pattern:
l Low weight value
l High compression ratio
l Low color contrast
l MrSID Generation 2 output format
l Image enhancement

To reduce the appearance of this pattern, complete the following steps:
1. Select the image in the Job List.
2. Click Advanced in the Job Properties panel.
3. Click the Format-Specific tab.
4. Increase the value in theWeight field. For example, youmight change the value from 2 to 3.
5. Optionally, deselect the Image Enhancement option.
6. Click OK.
7. Click the Run Selected Jobs button to run the job.

Finding your version and build numbers
Youmay need to know your the version and build number of your GeoExpress software in order to communicate
with LizardTech Support. To find these numbers, choose Help > About GeoExpress.

Technical Support
Most technical issues can be resolved using the various resources you have available. In addition to the product
documentation and the “ReadMe” file, LizardTech offers a knowledge base and product updates on the
LizardTech website.

Knowledge Base
The LizardTech Knowledge Base contains articles about known technical and usage issues and is frequently
updated.

https://www.lizardtech.com/support/geoexpress/knowledge-base

Product updates
Updated versions of LizardTech viewer tools are available for download at no cost.

https://www.lizardtech.com/support/geoexpress/installers

https://www.lizardtech.com/support/geoexpress/knowledge-base
https://www.lizardtech.com/support/geoexpress/installers
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Support plans
Protect your investment in LizardTech software by participating in a LizardTech support plan. For more details,
please contact your regional LizardTech office.

https://www.lizardtech.com/sales#retail-sales

Contacting Technical Support
To contact LizardTech Technical Support, visit http://www.lizardtech.com/support.

The support page includes links to the LizardTech Knowledge Base and the Product Activation page. A Contact
Form is also provided for issues that require further assistance.

In an emergency, call 206-902-2845 between the hours of 8 AM and 5 PM Pacific Time.

Please have the following information available to assist in resolving your problem:
l The task you were working on when the problem occurred
l The command you typed prior to the problem, if applicable
l The exact error message, if applicable
l The type of file you are encoding and the file size
l Whether you have restarted the computer and attempted to reproduce the problem
l Which version of GeoExpress you are running (see Finding your version and build numbers on the previous
page).

l Other LizardTech products you have installed
l The operating system
l The amount of hard drive space available
l The amount of memory installed in your system
l Any other information you feel is relevant

https://www.lizardtech.com/sales#retail-sales
http://www.lizardtech.com/support
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Appendix E: Company and Product Information
About LizardTech
Since 1992, LizardTech has delivered state-of-the-art software products for managing and distributingmassive,
high-resolution geospatial data such as aerial and satellite imagery and LiDAR data. LizardTech pioneered the
MrSID® technology, a powerful wavelet-based image encoder, viewer, and file format. LizardTech has offices in
Seattle, Portland, and Tokyo and is a division of Celartem, Inc. For more information, visit
https://www.lizardtech.com.

Other LizardTech products
Thank you for using LizardTech® GeoExpress® software. Try the rest of our product line.

GeoViewer
Efficient Viewing and Exporting of MrSID and JPEG 2000 Layers
GeoViewer is LizardTech’s free, standalone application for viewing geospatial imagery, vector overlays and
LiDAR data. GeoViewer enables you to combine, view and export visual layers from varied sources, such as local
repositories, Express Server catalogs, andWMS and JPIP servers. GeoViewer supports a wide range of input
formats and exports to GeoTIFF, PNG and JPEG. It’s themost efficient means of viewingMrSID and JPEG 2000
images.

For more information about GeoViewer, visit https://www.lizardtech.com/geoviewer-pro/overview.

Express Server
Image Delivery Software for Geospatial Workflows
LizardTech Express Server software is the best solution for distributing imagery in MrSID or JPEG 2000 format.
With Express Server, users on any device access imagery faster, even over low-bandwidth connections. Express
Server is faster, more stable and easier to use than any other solution for delivering high-resolution raster imagery.

For more information about Express Server, visit https://www.lizardtech.com/express-server/overview.

MrSID Decode SDK
Integration of MrSID Support into Third-Party Applications
TheMrSID Decode SDK provides a framework for extracting raster or LiDAR data fromMrSID files, including
MrSID Generation 4 (MG4™). Used as the foundation for LizardTech’s Express Suite® line of geospatial
products—GeoExpress, Express Server and Spatial Express software—theMrSID Decode SDK is a robust toolkit
suitable for complex application development needs.

MrSID Decode SDK is available for free download: https://www.lizardtech.com/developer/overview.

https://www.lizardtech.com/
https://www.lizardtech.com/geoviewer-pro/overview
https://www.lizardtech.com/express-server/overview
https://www.lizardtech.com/developer/overview
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Appendix F: Summary of Menu Commands
File menu
The File menu includes commands for adding images and tiles to the Job List and for working with GeoExpress
project (.prj) files. A project consists of the current contents of the Job List and global settings.

MENU ITEM FUNCTION

Add image(s) Add image files to the Job List. File types are determined by file extension; if you attempt to
add a file with an unrecognized extension, you will be prompted to identify the file type.
For a list of supported file types, see Supported input file formats on page 121.

Create new mosaic of
images

Adds an empty mosaic to the Job List. You’ll be prompted to identify the mosaic type
(raster or LiDAR), output file and file type, and other details about the mosaic.

Add color composite
image to encode

Add an image job consisting of separate files representing the Red, Green, and Blue
bands of an image.

New project Clears the Job List, ready to add images to a new project. (If the current project has not
been saved or has been changed since last saved, you’ll be prompted to save it.)

Open project Opens a saved project file. Note: GeoExpress can not open project files saved by versions
earlier than version 9.5.3.

Save project Saves changes to the current project. If it has not been saved, you’ll be prompted for a
filename.

Save project as Prompts to save the project with a new filename.

Print session log Prints the log of all encoding jobs run since you launched GeoExpress. This is the same
information displayed in the Job Progress panel.

Recent projects Lists the last four project files that you accessed; select one to re-open it.

Recent files Lists the last four non-project files; select one to add it to the current project.

Exit Exit GeoExpress. You’ll be prompted to save an unsaved or modified project or cancel any
running jobs.

Jobs menu
The Jobs menu provides another means of executing jobs.

MENU ITEM FUNCTION

Run selected jobs
Optimize selected
images
Encode selected
mosaics

Run the jobs that are selected in the Job List.
The menu item may change depending on the nature of the job and the options selected
for it.

Run all jobs Runs all jobs in the Job List.
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Options menu
TheOptions menu provides access to basic encode parameters, preferences and licensing.

MENU ITEM FUNCTION

Job options Set format, compression, dimensions, resolution, and tiling options for the selected job.

Advanced options Set advanced input, output, and other options for the selected job.

Edit mosaic Add, remove, crop, change order, and set a coordinate reference system for tiles. This
option is only available if the selection consists of a mosaic job or files in a mosaic job.

NITF image segments Displays the image segments in the selected file and allows you to select the segments
that you want to include in the output file.

Preferences Set or restore default preferences for output files, including output directory, compression
ratio, and more.

Licensing Enter or import license information or a data cartridge license, connect to a License
Server, or utilize an NITF-enabled license if one is available.

Tools menu
The Tools menu offers options related tomore complex encoding functions.

MENU ITEM FUNCTION

Metadata You can enter or modify User or Image metadata, including company name, copyright
information, geographic location, and CRS, among others.

Despeckling Enable despeckling for an image or tile, and set despeckling options.

Image crop Specify cropping for the image, using either a simple rectangle or polygons defined in a
shapefile.

Area of interest Specify a region of the image to use increased or decreased visual quality compared to
the rest of the image. This can be used to emphasize an important areas, or to “blur out” a
sensitive region.

Color Balance Apply brightness, contrast, and color corrections to mosaic tiles.

Reproject Allows you to reproject images from one coordinate reference system (CRS) to another.

Publish images Publish existing images directly to an Express Server.

Help menu
The Help menu provides information about GeoExpress and access to additional resources.

MENU ITEM FUNCTION

Contents Opens online help

Anonymous Application
Usage

Provides a description of data that can be shared anonymously with LizardTech, with the
option to enable or disable data collection.

LizardTech online tech
support

Opens a browser window to LizardTech’s support website

Open log files folder Opens the folder containing session and job log files.

About GeoExpress Displays product and version information.
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Glossary
A
alpha band

An image band that tracks the portions of an image that you do not want to display. Alpha bands are included
inMrSID Generation 4 and are especially useful for aligning images seamlessly.

B
band

A band, or image band, is one set of samples corresponding to one spectral component of an image. For
example, a typical image has three bands, a red band, a green band, and a blue band.

BBB
The name of a file format for raw images, short for BIL, BIP, and BSQ.

BIL
A band-interleaved by line image. This format stores all bands of pixel values for each consecutive lline or row
of the image.

BIP
A band-interleaved by pixel image. This format stores all bands of pixel values for each consecutive pixel the
image.

BSQ
A band sequential image. This format stores all pixel values for each band consecutively.

byte order
The order in which bytes are stored in computer memory. There are two types, little-endian and big-endian.
Also known as “endianness”.

C
composite mosaic

A MrSID image that contains other MrSID images. Composite mosaics can be created quickly because they
do not need to be compressed again, but they may loadmore slowly than flat mosaics.

compression
The process of transforming information so that it can be stored or conveyed in less space than the original
information. See also lossless, lossy and visually lossless.

compression ratio
A ratio of an image’s nominal size and an image’s compressed size, where the nominal size is calculated from
the length, width, number of bands, and number of bits in the image. For example, a raw image compressed
from 10GB to 1GB has a compression ratio of 10:1.
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D
dynamic range

The ratio between the largest and smallest values in an image. Image viewers use dynamic range values to
improve the appearance of images. For an image where the dynamic range is less than the full range of
possible values for the image, youmay want to use your image viewer to stretch the pixel values across the
full range.

E
endianness

See byte order.

F
flat mosaic

A MrSID image created frommultiple input images. Flat mosaics do not preserve information about each input
image and require compressing all the input images again. However, they loadmore quickly than composite
mosaics.

frequency balance
A parameter used inMrSID to determine the emphasis given to edges and flat color areas when performing
compression. See also weight and sharpness.

G
gamma

A parameter used inMrSID to determine the emphasis given to edges and flat color areas when performing
compression. In MG3 andMG4 encoding, this parameter is called frequency balance. A lower value creates
more defined edges, while a higher value creates softer edges.

GML
Geography Markup Language. An open, XML-based specification for representing geographic information
including geographic features, coverages, observations, topology, geometry, coordinate reference systems,
units of measure, time and other values. Because it is an XML grammar, it is both extensible and adaptable to
any application within the broad geospatial field.

K
K-weight

A parameter used inMrSID to determine the emphasis given to the K (black) band of a CMYK image when
performing compression.
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L
level

See zoom level.

lossless
A compressed image that is identical to the input image across all pixel values. See also lossy and visually
lossless.

lossy
A compressed image that approximates the pixel values of the input image. Lossy images are generally
significantly smaller than lossless images. Depending on the compression ratio, a lossy imagemay display
compression artifacts or it may appear to the human eye to be identical to the input image. See also lossless
and visually lossless.

M
magnification

The scale at which an image is represented. Magnification is expressed as a positive floating point value. For
example, 1.0 represents the full image, 0.5 represents a half-scale version, and 2.0 represents a double-scale
version. Themagnification valuemust be a power of two. See also scale and zoom level.

metadata
The information stored in an image that is not pixel value information. For example, typical metadata includes
image properties like the width, height, and colorspace of the image. Alternatively, some images contain
additional metadata such as the name of the image creator, the organization name, the creation date, and
more.

MG2
MrSID Generation 2. A previous version of theMrSID image format. MG2 is limited to lossy encoding and
does not support optimization nor some of the advanced features available in MG4. See alsoMrSID andMG4.

MG3
MrSID Generation 3. A previous version of theMrSID image format. MG3 supports lossless encoding, image
optimization, composite images, andmore. See alsoMrSID andMG4.

MG4
MrSID Generation 4. The current version of theMrSID image format. MG4 supports all the features of MG3
and adds support for alpha bands andmultispectral images.

mosaic
An image created frommultiple input images, also called image tiles, to form another larger image. There are
two types of mosaics, flat mosaics and composite mosaics.

MrSID
Multiresolution Seamless Image Database - A wavelet-based image format designed for large, high-quality
geospatial imagery. The current version of theMrSID file format is MrSID Generation 4. See alsoMG4.
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N
nominal image size

The size of an image calculated from the width, height, number of bands, and number of bits in the image. The
nominal size is iindependent of the file format or of the compression used on the image. You can use the
nominal size of an image to compare the relative sizes of images in different formats and to calculate the
compression ratio for an image. See compression ratio.

O
optimization

The process of creating anMG3 image from a sourceMG3 image without decoding the image and
compressing it again. Common optimization operations include cropping and removal of resolution levels.

P
pixel

A pixel represents a value or set of values for a particular point in a raster image. For images with more than
one band, a pixel includes the values of all the bands at the given pixel position.

R
resolution

A measure of the detail in an image. Typically, this is measured in ground units per pixel.

S
scale

Themagnification at which an image is represented. Scale is represented as a signed integer, corresponding
to the negative of the log of themagnification. That is, magnifications of 1.0, 0.5 and 2.0 are equivalent to
scales of 0, 1 and -1 respectively. See alsomagnification and zoom level.

sharpness
A parameter used inMrSID to determine the sharpness of boundaries between different areas of an image
when performing compression. See also frequency balance and weight.

strip height
The number of rows of an image to be processed in each step of an image read operation. Use of smaller strip
heights may reducememory requirements, but at a possible performance loss.
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T
transparency color

Also called the no-data value. Pixels that match the transparency color are not displayed. The value can be
specificiedmanually or in themetadata. See also alpha bands.

V
visually lossless

An image that appears to the human eye to be identical to the input image. However, a visually lossless image
is actually a lossy image, and as such only approximates the pixel values of the input image.

W
wavelet

A mathematical representation of a pixel value that varies by frequency and duration. In wavelet space, the
importance of a pixel depends on the values of its neighboring pixels. Wavelet-based image formats are able
to present images at multiple zoom levels without creating image pyramids.

weight
A parameter used inMrSID to determine the emphasis given to the grayscale portion of a color image when
performing compression. See also frequency balance and sharpness.

world file
A text file that contains geospatial positioning information to augment or replace the geospatial metadata in an
image file.

Z
zoom level

The scale at which an image is represented. Levels are generally expressed with signed integer values. An
image at scale 1 has half the width and height of the original. See also scale andmagnification.
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— 1 —

1-Pass or 2-Pass Optimizer (MG3) 86

— A —

about LizardTech 144

activating licenses 10

adding images to the job list 24

advanced job options 69

advanced JPEG 2000 options 88

advancedMG2 options 86

block size 86

G-weight 86

image enhancement 87

image statistics 87

weight 82

advancedMG3 options 85

1-Pass or 2-Pass Optimizer 86

block size 82

frequency balance 82

K-weight 85

optimizable 83

sharpness 82

strip height 83

weight 82

advancedMG4 options 81

block size 82

dynamic range 83

frequency balanace 82

optimizable 83

sharpness 82

strip height 83

weight 82

alpha band 76

JPEG 2000 94

MG4 77

MrSID 76

appearance preferences 110

applyingmetadata templates 43

area of interest 51

crop 54

defining 52

inner and outer areas 53

JPEG 2000 encoding 55

levels 57

mask method 55

MG3 andMG4 55

sample workflow 57

shift method (JPEG 2000) 56

vector overlay (shapefile) 52

weight method (JPEG 2000) 56

weight method (MG3/MG4) 55

AUX files 120

— B —

band and compression options 72

band selection 73

bands

mapping bands of multiband image to RGB
bands 61

batch color balancing 60

block size encoding option (MG2) 86

block size encoding option (MG3, MG4) 82

— C —

calculatingMG3 andMG4memory usage 130

calculatingMG3 area of interest weight 131

calculatingmosaic size 131

canceling jobs 28

Color BalanceManager histogram 60

color balancing 58-59

batch 60

mosaics 101

Index
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non-uniform corrections 58

color composite images 95

color space 72

commuter license 138

composite mosaic 99

updating 103

compressed output formats 125

compressionmethod 26

compression options, LiDAR 67

compression ratio 30

compression ratios, per-band 31

compression, lossless 31

concurrency 109

connecting a license server 10

context menu 15

coordinate reference system

selecting 62

creating amosaic 98

creating a test image 28

creating anMG4 alpha band 77

creatingmultiband JPEG 2000 files 95

creatingmultisegment NITF images 97

cropping

with area of interest 54

— D —

data cartridge 133

ordering 9

Data CartridgeManager 133

default JPEG 2000 settings 90

default output format

JPEG 2000 113

NITF 96

defining an area of interest 52

despeckling 44

point spacing 45

threshold 45

destination (for file output) 65

dimensions and resolution options 67

dynamic range 83

— E —

editing LiDAR metadata 33

editingmetadata templates 43

editing raster metadata 33

encoding a test image 28

encodingmultiband JPEG 2000 files 95

encoding options

color space 72

input 70

output 70

quantization 79

transparency 78

Esri AUX files 120

evaluation order of metadata 91

executing jobs 28

exporting job settings 29

Express Server output 118

Express Server, selecting 66

— F —

file formats

AUX (output) 120

input 121

output 123

flat mosaics 99, 105

floating licenses 134

adding under Linux 135

using commuter licenses 138

using on a network 137

floating point images and quantization 32

frequency balance 82

Frequently AskedQuestions 139

— G —

G-weight 86

general preferences 106

Index
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generating world files 118

GeoExpress window 12

GeoTIFFs and TIFFs inmosaics 103

GML andGMLJP2 93

metadata control 91

grayscale band, selecting 73

— H —

histogram, Color BalanceManager 60

— I —

image enhancement option (MG2) 87

image reprojection 61-62

advanced options 64

sample workflow scenarios 64

image rotation 109

image statistics (MG2) 87

indexed color images 78

inner and outer regions in an area of interest 53

input encoding options 70

input file formats 121

installation 9

installation problems 141

installing a data cartridge 9

— J —

job list 14

adding images 24

removing images 25

running jobs 28

job options

advanced 69

Job Progress 17

job settings, exporting 29

JPEG 2000

advanced options 88

alpha bands 94

area of interest 55

creatingmultiband files 95

default settings 90

mosaic 99

output modes 93

precincts 90

profiles 91

setting preferences 113

— K —

K-weight 85

— L —

license

activating 10

commuter 138

floating 134

License Server

administration 136

installation, setup and options 134

NITF-enabled 136

options 136

specifying 10, 136

LiDAR compression options 67

LiDAR metadata, editing 33

LiDAR preferences 115

LiDAR text parsing options 67

LizardTech support 142

log file and area of interest 55

log information 116

lossless compression 31, 124

lossy compression 124

— M —

main window 12

properties 15

mapping bands 73

mask method for area of interest 55

memory usage, calculating for MG2 130
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memory usage, calculating for MG3 andMG4 130

menus 13

metadata 35

control (JPEG 2000) 91

editing LiDAR 33

editing raster 33

evaluation order 91

MrSID sample 127

NITF input 40

templates 43

viewing 32

MG2

advanced options 86

block size encoding option 86

image enhancement option 87

memory usage 130

preferences 111

MG3

advanced options 85

area of interest encoding 55

calculating area of interest weight 131

preferences 111

weight method for area of interest 55

MG3/MG4

calculatingmemory usage 130

MG4

advanced options 81

alpha options 76

area of interest encoding 55

band selection and ordering 74

preferences 111

weight method for area of interest 55

mosaic 109

calculating size 131

color balancing 101

composite 99

creating 98

creating with a list file 104

flat 99

JPEG 2000 99

large 105

list file 104

mosaicking GeoTIFFand TIFF images
together 103

MrSID 98

multiple projection systems 99

multiresolution 99

NITF 99

output formats 98

overlapping input 103

previewing 102

tile management 100

updating (MG3) 103

MrSID samplemetadata 127

multi-threading 109

multiband JPEG 2000 files 95

multiple-projectionmosaics 99

multiresolutionmosaics 99

multisegment NITF images

as input 96

creating 97

in color composite images 97

multispectral images

RGB color transform 31, 72

selecting andmapping bands for 74

— N —

NITF images 95

as default output format 96

compliance in GeoExpress 96

input metadata 40

JPEG 2000 96

mosaics 99

multisegement images 96

raw 96

RPC 108

using NITF image segment in color
composite image 97

Index
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— O —

optimizable (advancedMG3/MG4 encoding
option) 83

optimizing 75

ordering a data cartridge 9

other LizardTech products 144

output color space 72

output destination 65

output formats 123, 125

mosaic 98

selecting 25

output options 70

overlapping input in mosaics 103

— P —

parsing options, LiDAR 67

Part I JPEG 2000 93

password protection for MG2 andMG3 81

per-band compression 31

point spacing 45

precincts (JPEG 2000) 90

preferences 106

appearance 110

general 106

JPEG 2000 113

LiDAR 115

MG4, MG3, MG2 111

preview tab 19

previewing amosaic 102

previewing images 27

profiles (JPEG 2000) 91

progress 17

project files 29

properties 15

publishing

viewing results in the session log 117

publishing to Express Server 118

— Q —

quantization 79

and floating point images 32

precision 80

range 80

— R —

raster metadata, editing 33

raster mosaic 109

removing images from the jobs list 25

reprojection 61-62

advanced options 64

sample workflow scenarios 64

requirements 8

resampling 75

resolution and dimensions options 67

RGB color transform 31, 72

RGB output, selecting bands for 74

rotation 109

RPC (rapid positioning capability) 108

running jobs 28

— S —

seam line correction 58

seamlines 109

security for MG2 andMG3 81

selecting a coordinate reference system 63

selecting an Express Server 66

selecting bands 73

for grayscale output 73

for multispectral output 74

for RGB output 74

retaining all in order 74

session logs 117

shapefile

defining an area of interest 52

sharpness 82
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shift method (JPEG 2000 area of interest) 56

shortcut menu 15

specifying a compressionmethod 26

specifying a license server 10

specifying a target file size 31

specifying per-band compression ratios 31

specifying transparency in indexed color images 78

strip height 83

support 142

supported TIFF compression types 126

system requirements 8

— T —

target file size 31

target thumbnail size 75

technical support 142

Terminal Services 139

test image 28

text parsing options, LiDAR 67

threads 109

thumbnail size 75

TIFF compression types supported 126

TIFFs andGeoTIFFs inmosaics 103

tile management 100

tiles 109

tiling options 67

tilt correction 58

toolbar 14

transparency color 78

transparency in indexed color images 78

transparency options 78

— U —

updatingMrSID images 103

using lossless compression 31

— V —

vector overlay (shapefile)

defining an area of interest 52

version number 142

viewing logs 116

viewingmetadata 32

viewing results of a publish operation 117

vignette correction 58

visually lossless 124

— W —

watermark 71

weight (MrSID encoding option) 82

weight method (JPEG 2000 area of interest) 56

weight method (MG3/MG4 area of interest) 55

weight, calculating in MG3 area of interest 131

world files 118-119

— Y —

YIQ color transform 31

— Z —

zoom levels 75

Index
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